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Introduction

LVhat’s the definition of a reference book? Well, I like to think of this
book as a snapshot. Sure, it’s a very heavy photograph, weighing in
at over 700 pages — but nevertheless, it captures the current state of
today’s PCs, including hardware, the most popular applications, and of
course, the latest and greatest incarnation of the Windows operating system
that we all cherish (in this case, Windows XP Home and Professional).

That covers a lot of ground, especially when you consider how the PC has
branched out into all sorts of new directions in the last few years. What
used to be primarily a simple word processing platform in the early days of
DOS has now become a hub for digital video and CD-quality audio, an opti-
cal recording center, an Internet communications system, a digital dark-
room, a 3-D gaming console, an office productivity center . . . the list goes on
and on. Therefore, fitting the features and functionality of today’s PCs into a
single volume was a challenge for me — and it proved singularly rewarding
as well because PCs are both my career and my favorite hobby!

With that comprehensive approach in mind, this book still holds true to the
For Dummies format: step-by-step instructions on each major feature within
Windows XP, Microsoft Office, and other popular PC applications, with a
little personal opinion, my recommendations, and my attempts at humor
mixed in to add spice. I take the time to explain each topic for those who
have just entered the PC universe, but you'll uncover plenty of advanced
information as well. With this book in hand, you can set up a wireless net-
work, navigate an Excel spreadsheet, diagnose hardware problems, and
even work magic with your digital camera.

I sincerely hope that you enjoy this book and that it will help open up the
countless possibilities offered by your PC. Thanks to the efforts of all those
software developers, engineers, and hardware manufacturers, you and I get
to play!

What's Really Required

Here’s a short section for you — you need a PC, preferably running
Windows XP.

(I told you it was short.)
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What's Not Required

If you've read any of my earlier books, you already know the score. But just
in case you haven’t (hint, hint), here’s the list of what you won’t be needing:

4 A degree in computer science: Computers are supposed to be easy. |
like ’em that way, and I get very testy when faced with anyone who tries
to make a PC artificially complex. 'Nuff said.

4+ All sorts of expensive software: Because Microsoft Office is so doggone
popular, it’s included here — but virtually everything else is either
included in Windows XP or is cheap to get.

4 An Internet connection: Some folks should be reminded that PCs are
quite productive by themselves. Naturally, you need an Internet connec-
tion to use Internet Explorer and Outlook Express, but you don’t have
to be online to enjoy your computer.

About This Book

Each of the eight mini-books in this Desk Reference squarely addresses a spe-
cific topic, and there’s no need to read this whole book in a linear fashion. You
certainly can, if you like, but it’s not necessary. Instead, each mini-book (and
on a lower level, each individual chapter) has been designed to be self con-
tained. You can jump from chapter to chapter, pursuing information on what
you’re working on right now — and happy in the knowledge that when you do
decide to invest in a digital camera (or a scanner or a memory upgrade), it’s
covered!

Conventions Used in This Book

Like other For Dummies books, this volume uses a helpful set of conventions
to indicate what needs to be done or what you’ll see onscreen.

Stuff that you type

When I ask you to type something, like a command or an entry in a text box,
the text appears like this:

Type me

Press the Return key to process the entry.
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Menu commands

When I give you a specific set of menu commands to use, they appear in the
following format:

Edit=>Copy

In this example, you should click the Edit menu and then choose the Copy
menu item.

Display messages
If I mention a specific message that you see on your screen, it looks like this
on the page:

This is a message displayed by an application.

How This Book Is Organized

Time for a quick summary of what'’s included in those eight mini-books
(with cross references where appropriate, included at great expense).

Book 1: PC Hardware

It’s not a PC without the hardware. In this mini-book, I discuss both the
standard equipment (like your monitor, keyboard, and mouse) and optional
things that you can attach (like a scanner or a game controller). I also cover
the different ports on your PC and the proper methods of maintaining your
PC hardware.

Book 11: Windows XP

A mini-book for the XP generation — with everything that you need to know
about today’s most popular PC operating system, including the basics,
advanced customizing topics, the included applications, maintenance, and
(insert ominous chord here) . . . troubleshooting.

Book 11I: The Internet

The obligatory Internet stuff fills this mini-book. Discover how to navigate
the Web, block that infernal spam from your e-mail, fritter away countless
hours with instant messaging, and — most important — keep yourself
secure while you’re online.
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Icons Used in This Book

Book 1V: Microsoft Works

Most people call Works “the programs I got with my PC.” But as you dis-
cover in this mini-book, there’s no shortage of features or functionality
within Works (even though it’s usually overshadowed by the behemoth
that is Microsoft Office). You'll find out how to use each of the Works
applications and how to use them in tandem to accomplish tasks.

Book U: Office XP

Okay, so [ decided to cover the behemoth as well. Microsoft Office com-
prises Word, Excel, PowerPoint, Access, and Outlook — and the gang’s all
here, with each application covered in a separate chapter. If you use Office,
you'll treasure this mini-book — if not, you'll still enjoy it as a spellbinding
work of nonfiction. (Sure, Mark.)

Book VI: Fun with Movies, Music, and Photos

Your PC is now a digital, multimedia production center — and a great combi-
nation for watching video and listening to music, to boot. In this mini-book,

[ show you the latest cutting-edge fun that you can have with your DV cam-
corder, your MP3 player, and your digital camera . . . wait until you show
your home movies on DVD!

Book VII: Upgrading and Supercharging

The gloves come off in this mini-book: If you’re hankering to turn the corner
and become a PC power user, use these chapters to help you upgrade your
PC’s hardware, including your system RAM, your CPU and motherboard,
your graphics card, and even external connections like USB 2.0 and
FireWire. “To the Batcave!”

Book V1II: Home Networking

The final mini-book is devoted to one of the fastest-growing segments of

the PC population — those folks who are adding a home (or small office)
network. In these chapters, I demonstrate how to install your own wired net-
work as well as how to expand with the latest wireless technology. Then I
turn your attention to security so that you can use your network without
fear of intrusion.

Icons Used in This Book

In a book stuffed to the gills with icons, my editors have decided to use —
you guessed it — more icons. Luckily, however, the book’s icon set acts as
visual signposts for specific stuff that you don’t want to miss.
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A Tip icon points to a sentence or two that might save you time, trouble,
and quite possibly cash as well.

Consider these tidbits completely optional, but if you're captivated by
things technical — as [ am — you'll find trivia of interest here. (A good fea-
ture for those who enjoy cutaway drawings of the Titanic and those who
actually know what JPEG means.)

Your PC is usually a very safe harbor, but icebergs can appear from time to

& Speaking of the Titanic, always read the information next to this icon first!
time if you're not careful.

X\
& As you might expect from its name, this icon highlights stuff that you might
want to, well, remember.



7 PCs All-in-One Desk Reference For Dummies, 2nd Edition



Book |
PC Hardware

The 5“;an9 By Rich Tennant

':I think the cursor's not mg, Mr. Dunt,
because you've ot your hand on the chalk
board. eraser and. not. the mouge”



Contents at a Glance

Chapter 1: Starting with the Basics

Chapter 2: Additional Toys Your PC Will Enjoy

Chapter 3: Connectors, Ports, and Sundry Openings
Chapter 4: Maintaining Your Hardware

23
41
49



Chapter 1: Starting with the Basics

In This Chapter

v+ Defining hardware, software, and peripherals
v~ Identifying the common components of all PCs
v+ Comparing laptop and desktop PCs

+ Understanding RAM and your PC’s CPU

v+ Defining the operating system

If your name is Hemingway or Faulkner or King, the first chapter is always
the toughest to write. For me, however, this chapter will be fun to write
because it tackles the basic questions, such as what components make up
your PC and why you need an operating system. You’ll discover more about
the specific parts of your PC that determine how fast it is, and [ also discuss
the pros and cons of choosing a laptop over a desktop PC.

If you're a hardware technician or a PC power user, you might decide to
eschew these basic concepts and move on . . . and that’s okay. But if you're
new to the world of IBM personal computers or you're going to buy your
first PC, this chapter is a great place to start. In fact, you’d be amazed by
how many folks I talk to who have owned a PC for a year or two and still
don’t know some of the terms that you’ll read here!

Here’s the first Mark’s Maxim for this book:
It takes a solid foundation to build a power user.”

So read on!

Defining Basic Terms

My high school chemistry teacher, a learned man whom I have always
admired (even then), always told us, “Never jump into anything before defin-
ing your terms.” (Thanks, Mr. Owen. Because of you, I succeeded in not
blowing myself to pieces!)
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\\3

Figure 1-1:
Hardware
like this
video card
is, well,
hard.

Before you venture farther, commit these terms to memory, and you’ll have
taken a giant first step toward becoming a PC power user.

There’s no reason to walk around with this stuff tattooed on your arm; you
certainly don’t need to know these technicalities just to check your e-mail
or use Microsoft Word. However, when you grow more knowledgeable about
Windows and your PC, you'll find that these terms crop up in your computer
conversations more and more often.

Hardware

In the PC world, hardware is any piece of circuitry or any component of your
computer that has a physical structure. For example, your computer’s moni-
tor is a piece of hardware, as is your PC’s floppy disk drive. Even those com-
ponents that you normally can’t see or touch — the ones that are buried
inside your case — are considered hardware, too, like your PC’s mother-
board and power supply. (And yes, your computer’s case is technically a
piece of hardware as well, although it’s not electrical.)

Figure 1-1 illustrates a common piece of hardware — in this case, a video
card with an Accelerated Graphics Port (AGP) connector.
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Figure 1-2:
Listen to the
latest MP3s
with
software
from
Microsoft.
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Software

The other side of the PC coin is the software that you use. Software refers to
any program that you run, whether it resides on your hard drive, a floppy
disk, a CD-ROM, or somewhere on a network.

When you hear folks discussing a software upgrade, patch, or update, they're
talking about (you guessed it) yet another piece of software! However, the
upgrade/patch/update program isn’t designed to be run more than once;
rather, its job is to apply the latest features, bug fixes, and data files to a
piece of software that’s already installed and running on your PC, updating
it to a new version. (Virtually all software developers refer to successive ver-
sions of their software, such as Version 1.5 or Version 3; the later the version,
the more features that the software includes.)

Typically, think of software as an application that you buy or download,
such as Microsoft Works or Windows Media Player (see Figure 1-2).
However, the term soffware actually applies to any program, including
Windows itself and the driver programs that accompany the hardware that
you buy. Unfortunately, computer viruses are software as well.

Q Windows sedia Player
Fiie Vew Py Tooks el

B We're All Alone

By
Tureer

Copy to D
or Dewie

Provumnm
Services "
Shon
 heraver
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Defining Basic Terms

And software might be cheap!

You'll probably encounter two other types of
“ware": freeware and shareware. Freeware is
a program that’s either been released into the
public domain — in which case the author gen-
erally releases the programming code needed
to modify it or maintains the rights to it — but
you can still use it for free.

Shareware, on the other hand, is not free: You
get to try it before you buy it; if you like it, you
send your payment directly to the author.

Because there's no middleperson (you won't
catch me using a sexist term) and you're not
paying for an expensive box or advertising,
shareware is usually far cheaper than a similar
commercial program.

Before using freeware or shareware, check to
make sure that the author offers regular
updates. When you work for peanuts, you're not
going to be able to afford a Quality Assurance
Department or comprehensive beta testing!

$\(J\L S T(/‘k

From time to time, you might see the word firmware in a magazine or on a
hardware manufacturer’s Web site. This sounds like a strange beast, but I
can explain: Firmware is the software instructions that you find stored in
the internal memory or the internal brain of a piece of hardware, so it’s not

quite software, and it’s not quite hardware. For example, your CD or DVD
recorder has a firmware chip inside that controls the mundane tasks
required to burn a disc. Generally, you won’t have to fool with firmware,
but a manufacturer might release a firmware upgrade to fix bugs that have
cropped up with a piece of hardware (or even add new features). To upgrade
firmware, you run a software utility program supplied by the manufacturer.

Peripherals

Peripherals comprise things that reside outside your PC’s case, which can
include all sorts of optional hardware. Examples include

4 Printers

4+ External CD recorders (such as the model shown in Figure 1-3) and hard

drives
Web cams

Graphics tablets

+ 4+ 4

Scanners and digital cameras

Joysticks and other game controllers

Network hardware such as Internet-sharing devices
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Figure 1-3:
This
particular
CD
recording
peripheral
enjoys
sunshine
and clean
air.

The Common Components of a Desktop PC '3

I should point out that three pieces of external hardware that are found on
every PC — your monitor, keyboard, and your mouse (or trackball or touch-
pad) — are generally not considered peripherals because they’re required to
operate your PC. Call '’em hardware instead.

Peripherals connect to your computer via the ports that are built into the
back (and often the front) of your PC. I go into more detail on ports in
Chapter 3 of this mini-book; any PC power user worthy of the name will be
able to identify any common port on a computer on sight. (If you're a hard-
ware technician, you can identify them in the dark, like how a soldier knows
his weapon. Don’t ask me why — I'm not at liberty to discuss it.)

The Common Components of a Desktop PC

“Aw, crikey . . . look what we have here, mates! This little beaut is a PC —
step back now, mind ya, for if one of these digital guys goes bonkers, it’ll
spread itself all over yer bloomin’ desktop!”

Although a PC is hardly a crocodile, your system can grow like one — and it
can become just as unwieldy and tough to move. Turn your attention to the
components that you’ll find equipped on just about any PC that you buy (or
assemble) these days.

Book |
Chapter 1
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The computer

The computer itself is housed in a case, which protects all the internal parts
from damage. (Unfortunately, dust will still find its way inside, which is why
[ recommend that you remove the case at least once a year and blow all that
dust out by using a can of compressed air.)

Techs refer to your PC by any of the following names:

4+ Box.

4+ CPU. (You'll meet your PC’s actual CPU — which is a single integrated
chip — later in this chapter.)

4 Chassis.

+ $*Q(#*$*!1%. (Reserved for special occasions.)

Consider thy form factor

Not all PCs are created equal; several different form factors are available.
(Geez, yet another two-dollar word for a fifty-cent concept.) A form factor
determines the height and “spread” of your computer, depending on the
case. (In the original days of the IBM PC, all computer cases were designed
to straddle your desk, parallel to the floor; however, folks soon realized that
a PC takes up far less room if it stands vertically.)

Your desktop PC’s case can look like any of the following:

4 The standard tower machine: Because a tower case (see one in Figure
1-4) gives you the largest number of expansion bays and room for multi-
ple fans, they’re the case favored by PC power users and network
administrators. Tower cases are often placed on the floor because they
are sometimes too tall for your computer desk.

4 The mini-tower machine: The standard case offered with most PCs, the
mini-tower is simply a shorter version of a tower case. The mini-tower is
suitable for home and standard office workstation use.

4 The lunchbox and pizza box machines: These are the smallest PC
cases of all, built for those areas where space is at a premium (or you
know ahead of time that expansion won'’t be required in the future).
These machines are often used in larger corporate offices, hospitals,
banks, and the like. Figure 1-5 shows a pizza box case, which sits flat on
your desktop rather than standing upright.
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> 5 1/4-inch half-height bays
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3 1/5-inch floppy bays

—1
Figure 1-4:
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Earth can
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machine.

Custom colors are great (for a while, anyway )

You might be interested in buying a PC with a special color scheme.
Typically, these machines are black or brushed aluminum, but I've seen

Book |
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them in every color of the rainbow as well. (I particularly fancy the neon
green and Florida orange.)

Personally, I think these works of art are fun, but I will caution you up front:
Finding a neon green CD-ROM drive in any store — online or otherwise —
is more difficult than getting a teenage girl off the telephone. Therefore, you
might find it difficult to maintain that exotic color scheme when you start
upgrading your hardware because most of the civilized world uses PCs that
are off-white or beige. Black computers are the easiest to match because
black is the second-most popular color.

Of course, if you're a Macintosh owner, all bets are off . . . but that’s another
book entirely.

The monitor

Today’s monitors come in two different varieties:

4 The traditional CRT monitor: The cathode ray tube (CRT) monitor
is big, brassy, and less expensive to buy than a liquid crystal display
(LCD) monitor, but it uses more electricity, gets hot while you use it,
and emits all sorts of radiation. (Nothing harmful, mind you, but it’s
there all the same.) Because CRT monitors use older technology that’s
similar to a TV set, they’re bulky, but they’re also significantly cheaper
than an LCD monitor, especially at larger screen sizes such as 19" and
21". Most CRT monitors are flat-screen models; older designs with
curved screens tended to distort the image that you see.

4 The LCD monitor: LCD monitors — also called flat-panel monitors —
share the same technology as laptop computer screens, so they're very
thin and use much, much less electricity than a CRT monitor. (Many are
even designed to hang on the wall.) LCD screens emit neither heat nor
radiation. In fact, the only downside to an LCD monitor is the price.

Either type of monitor is fine for a home or office environment, but (natu-
rally) I recommend an LCD monitor if you can afford one. The larger the
monitor size, the easier it’s likely to be on your eyes, and the more windows
and documents that you can stuff on your desktop at once.

The keyboard and mouse

Keyboards are rather mundane. Virtually all today’s models have the
Windows-specific keys that will help any PC power user — but I still have a
suggestion or two:



Figure 1-6:
Ergonomic
keyboards
are user
friendly.
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4+ Consider an ergonomic keyboard. That cool, curved appearance that Book |

makes ergonomic keyboards such as the Microsoft Natural Keyboard Chapter 1
Elite stand out in a crowd isn’t just for looks. You'll find that you can

type longer, faster, and with less strain on your wrists if you use an 2

ergonomic keyboard, as shown in Figure 1-6. 1
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4 Keyboard tasks are easier with one-touch buttons. Many keyboards on
the market today — and most that ship with today’s systems — feature
one-touch keys that you press to automatically display your e-mail pro-
gram or Web browser, print a document, or mute your computer’s audio.
Even if you don’t use the standard functions for these keys, they can gen-
erally be reprogrammed to work with other applications. For example,
I've reprogrammed the Print key on my server’s keyboard (which isn’t
connected to a printer) to run my network management application
instead.

On the other side of the coin, most PC power users will eventually find
themselves looking for a different mouse or pointing device; the standard
equipment mouse rarely gets the job done unless you're buying a more
expensive system that comes with a premium mouse. Mouse-y features
to consider include the following:

4+ Cordless mice: These mice are sans tails: Instead, they use a built-in
infrared (IR) emitter to communicate with a separate base station,
which in turn connects to your PC. The base station often acts as a bat-
tery charger when you’re not using your PC. Many folks find these mice
liberating because there’s no tail to drag around and because you can
place the mouse farther away from the computer.
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Desktop PCs versus Laptop PCs

4 Optical operation: Optical mice advantages include no mouse ball to

clean, far fewer moving parts, and better control — no wonder that opti-
cal pointing devices are so popular! If you're still using a mouse with a
ball, jettison it and pick up an optical mouse.

Multiple buttons: Of course, any self-respecting PC mouse has two
buttons, but most of the new offerings include a programmable third
button and a scroll wheel, which you use to scroll the contents of a page
just by turning the wheel with your fingertip. (For example, [ have the
middle button programmed as a double-click.)

Trackballs and touchpads: Many tech types swear by these alternatives
to the traditional mouse. To use a trackball, which is kind of like a giant
stationary mouse turned on its back, you move the ball with your
thumb or the tips of your fingers. With a touchpad (like what’s found

on many laptops), you move the tip of your finger across a pressure-
sensitive pad.

Speakers

Today’s multimedia PCs are just as attractive to an audiophile as a tradi-
tional stereo system. If you think that you’re limited to two desktop speak-
ers and a chintzy volume knob, I invite you to contemplate the latest in PC
speaker technology:

4+ Flat-panel speakers: Like LCD screens are to CRT monitors, so are

flat-panel speakers to older PC speakers. Most flat-panel speakers are
less than half of an inch thick yet provide the same power and punch
as their older brethren.

Dolby Surround sound: [ get into more detail about high-fidelity PC
audio in Book VII, Chapter 6. For now, suffice it to say that with the right
sound card and multiple speakers, your PC can equal the clarity and
realism of a home theater system. And consider this: What home the-
ater system will let you play the latest 3-D games?

4 Universal Serial Bus (USB) digital connections: For the ultimate in sound

quality, today’s best digital speakers connect to your system through the
USB port — you can say goodbye to old-fashioned analog forever.

Desktop PCs versus Laptop PCs

“So should [ buy a desktop or a laptop PC?” Naturally, if the portability of a
laptop PC is a requirement for you — if your job or your lifestyle demands
plenty of travel every year — you really have no choice but a laptop com-

puter. Luckily, today’s laptops are virtually as powerful as desktop PCs, so
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you no longer have to feel like a second-class citizen, even when it comes
to features such as high-resolution graphics, larger hard drives, and CD/DVD
recording, which used to be very expensive options in the laptop world.

However, if you're sitting on the fence and portability is a lesser requirement,
I generally recommend a desktop system for the following three reasons:

4+ Laptops aren’t as expandable as desktops. Although you can hang
plenty of peripherals off a modern desktop (using USB and FireWire
ports), desktops are just plain easier to expand and upgrade (especially
the processor and your graphics card, which are practically impossible
to swap on a laptop).

4+ Laptops are much more expensive. My friend, you’ll pay dearly for that
portability. So if you don’t need it, jump to the desktop side of the fence.
It’s as simple as that.

4 Laptops cost much more to repair. If the sound card fails in your desktop,
you can replace it yourself with a new, relatively inexpensive adapter card.
However, if the sound hardware fails in your laptop, it’s time to pull out
your wallet because you can't fix it yourself, and the entire motherboard
inside the unit will probably need to be replaced. (Remember, part of that
portability stems from the fact that laptop manufacturers tend to put all
the graphics and video hardware on the motherboard to save space.)

Luckily, most of this book will still be valuable to laptop owners. Just ignore
the parts about upgrading the components that you can’t reach.

RAM and Processors: The Keys to Performance

When you hear PC owners talking about the speed and performance of their
computers, they're typically talking about one of three different components
(or all of these components together, as a group):

4+ Your system memory, or random access memory (RAM): The more
memory that your PC has and the faster that memory is, the better your
PC will perform — especially Windows, which enjoys memory like a hog
enjoys slops. I tell you more about slops — sorry,  mean memory — in
Book VII, Chapter 2.

4+ The central processing unit (CPU): Most of today’s PCs use either an
Intel Pentium 4 or its cheaper and slower cousin, the Celeron. The other
popular processor is the AMD Athlon XP, along with its cheaper and
slower cousin, the Duron. The speed of your processor is measured in
either megahertz (MHz) or gigahertz (GHz), with 1 GHz equaling 1000
MHz. The faster the speed of your processor, the faster your PC will per-
form. (I go into this big-time in Book VII, Chapter 3.)
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4+ The graphics processing unit (GPU): This is the chipset used on your
video card. The better the chipset, the faster and the more realistic 3-D
graphics that your PC can produce. For the skinny on graphics cards,
visit Book VII, Chapter 6.

® To display what type of processor your PC uses, its speed, and how much
RAM your PC has, right-click My Computer in Windows 98/2000/Me/XP and
then choose Properties from the pop-up menu that appears. You should see
a dialog box appear like the one in Figure 1-7 with these interesting facts.
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Your Friend, Your Operating System

Windows, which is your PC’s operating system, is the program that you run
in order to

4+ Navigate through the files on your hard drive.

4 Run other programs.

4 Listen to music, view pictures, or watch movies.

4+ Copy, move, and delete things, and much more.
Actually, Windows is composed of hundreds of smaller programs, but you’ll
rarely notice anything else running. Instead, Windows presents a cohesive
and relatively easy-to-use interface to the world. (The tech word interface

simply means the design of the screen and the controls that you see when
you're using software.)
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In this book, when I refer to Windows, I'm talking about Windows XP. In my
opinion, XP is the easiest-to-use and most stable version of Windows that
I've ever used, and I heartily recommend that you upgrade to it if your PC
meets the minimum requirements. To see the requirements for both the
Home and Professional versions of Windows XP, visit Microsoft online at
www.microsoft.com/windowsxp/evaluation/default.asp. (BooklIlis
completely dedicated to Windows XP — there’s another reason to upgrade!)

[ should mention, however, that Windows isn’t the only operating system
that runs on a PC. For example, you can run Unix, Linux, BeOS, OS/2 Warp,
or even good old-fashioned DOS. To be honest, your PC’s hardware couldn’t
care less — but it’s a good bet that the programs that you want to run are
designed for Windows, and much of the hardware in your PC either won’t
work or will be harder to configure if you use another operating system.
Therefore, I heartily suggest that you stick with Windows XP: The various
flavors of Windows are the choice of the vast majority of PC owners.
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Chapter 2: Additional Toys
Your PC Will Enjoy

In This Chapter

v+ Comparing printers

v Adding a scanner to your system

v+~ Upgrading your input devices

v Adding a game controller

+ Introducing digital cameras and digital video (DV) camcorders
v Adding new storage to your system

1 Protecting your PC with a surge protector or an uninterruptible power
supply (UPS)

ou’ve bought your PC — congratulations! — or you’ve decided to

finally turn on that totem pole of a desktop computer that you've been
looking at for the last six months. Here’s a friendly warning for you in the
form of a Mark’s Maxim: Serious computing requires serious peripherals.”
In other words, those PC owners who are hoping to get the maximum return
and explore the maximum power of their computers will need additional
stuff (peripherals, as you can read in Book I, Chapter 1) that connect to your
PC to take care of a specific job. Printers are a good example; a PC certainly
won’t produce hard copy by itself.

In Chapter 1 of this mini-book, I discuss hardware and software. This chapter
is designed as both a showcase and an introduction to PC peripherals that
will familiarize you with the most popular additional toys for your computer.
Some of these devices are covered in great detail later on — for example,
scanners have all of Book VI, Chapter 1 to themselves — and others are
covered primarily right here.

One warning: This chapter can be hazardous to your wallet or purse.
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Printers

Printers

The first stop in the world of peripherals is the most common (and most folks
would say the most useful) device of all: the system printer, which allows your
PC to produce hard copies of documents, artwork, and photographs.

Inkjet versus laser printers

In the digital days of yore — in other words, more than five years ago —
making a choice between an inkjet and a laser printer was ridiculously easy.
After all, laser printers were prohibitively expensive, and they couldn’t print
in color. Therefore, every home PC owner picked up an inkjet printer and
got on with his or her life. These days, however, the line between inkjet and
laser printers has blurred, so here’s a list of the advantages of each so that
you can shop with the right type of printer in mind.

Laser printer advantages

Today’s monochrome laser printers start at around $200-$300, which is still
mind-bendingly weird for an old hardware hacker like me who still remem-
bers the days when the absolute cheapest (and likely refurbished) laser
printer that you could find would set you back $1,500-$2,000. Advantages
of the laser printer include

4 Speed: A laser printer can turn out pages more quickly than an inkjet
printer.

4+ Low cost: Over time, toner costs for a laser printer will total far less per
page than refilling/replacing inkjet printer cartridges.

4+ Quiet operation: A laser printer is generally quieter than low-cost inkjet
printers — which is a big deal in a quiet office, where the printer usually
occupies a central location.

4 Best quality text: No inkjet printer — no matter how much you pay
for it — will ever turn out black text and line graphics as crisp as a laser
printer.

Also, if you can afford the $1,000 for a color laser printer, you'll find that it
offers better quality color output than most low-cost inkjet printers. With
these advantages in mind, pick a monochrome laser printer if most of the
pages that you’ll print will be text and if color isn’t a requirement. You'll
be glad that you chose that laser model after you’'ve gone three months
without changing a single toner cartridge!



Figure 2-1:
Investin a
low-cost
monochrome
laser printer
for
document
printing.

Printers 2 5

The monochrome laser printer shown in Figure 2-1 can produce 12 pages
per minute without blinking an eye. (If it had one.)

Inkjet printer advantages

Inkjet printers are still cheaper than laser printers. You can find an accept-
able color inkjet printer for under $100 anywhere on the planet, and they’re
still the color printing solution for the home PC owner. Other advantages

include

4 Versatility: A color inkjet can print on many types of media, including
craft paper and T-shirt transfers.

4+ Smaller size: This saves you space on your desktop.

4+ Larger paper sizes: If you spend more, you can add a large-format inkjet
printer to your system that can print 11 x 17-inch or larger items.

The inkjet printer in Figure 2-2 costs less than $300 yet includes both Ethernet
and Universal Serial Bus (USB) connections. It can print laser-quality black
text at seven pages per minute and photo-quality color images at five pages
per minute. You can even set this model to print on both sides of the paper.
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Figure 2-2:
This inkjet
printer
produces
stunning
photo-

quality
color.

Photo printers

Photo printers are specifically designed to create photographs that rival any
35mm film print. They either use the best quality inkjet technology, or they rely
on dye-sublimation (dye-sub) technology (also called thermal wax printing).

A dye-sub printer transfers heated solid dye from a ribbon to specially coated
paper, producing the same continuous tones that you see in a photograph
produced from a negative. Photo printers can often accept memory cards

from digital cameras directly, so you don’t need a PC to print your digital
photographs.

\\3

Although a number of different sizes of photo printers are on the market,
most are smaller than typical inkjet printers. (They can’t use standard 8.5 x
11-inch paper, and they can’t print black text, which makes an inkjet printer
far more versatile.) Both photo and inkjet printers can produce borderless
images (just like a film print), but a true dye-sublimation photo printer is far
slower than an inkjet, and the special paper and dye ribbon that it requires
make it much more expensive over the long haul.

If you're a serious amateur or professional digital photographer, a photo
printer is worth the expense. For a typical home PC owner, however, a
standard color inkjet printer is the better path to take.



Figure 2-3:
A personal
label printer
isa
convenient
tool for
printing all
types of
labels.

Printers 2 7

Label printers

Before [ move on, I'd like to discuss a popular new class of printers — the
personal label printer, like the DYMO LabelWriter 330 Turbo that I use
(www.dymo.com). These printers might look a little like toys — they’re not
much bigger than the label tape that they use — but I've found that a label
printer is worth twice its weight in gold (see Figure 2-3).

For example, the LabelWriter 330 Turbo can produce all these materials
with aplomb:
4 Address and shipping labels, complete with your logo
ID badges
CD and DVD labels
Bar codes and U.S. mail codes
File folder labels
Floppy disk labels (for those who still use floppy disks, anyway)

R IR R R

VHS tape and cassette labels

When you design your labels, the software that ships with the LabelWriter
330 Turbo gives you control over fonts, time and date stamping, line draw-
ings, and even thumbnail photographs. You can rotate and mirror text or set
up bar coding with ease. Plus, you get the capability to print labels directly
from applications such as Outlook, Word, ACT!, and QuickBooks.
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Just as valuable as the output, however, is the sheer convenience that you
get from one of these printers! A label printer frees you from the hassle of
designing and preparing labels on your inkjet or laser printer, and you don’t
have to hunt for your label sheets every time that you need to print a new
batch. (Anyone who'’s fought tooth and nail to align and print a bar code or
address labels on a standard laser printer knows just what [ mean.)

The LabelWriter 330 Turbo uses a USB connection and sells for about $200
online.

Scanners

Figure 2-4:
This
scanner can
bring all
sorts of
printed
material to
your PC
monitor.

Scanners are interesting beasts — and man, you get a lot of bang for your
buck! In fact, a perfectly serviceable USB scanner (as shown in Figure 2-4) is
waiting for you at your local Maze O’ Wires store for under $100, and it can
do all of the following:

4 Produce digital images from magazine and book pages, photographs,
and just about any other printed material. These images can later be
edited to your heart’s content, sent as an e-mail attachment, or
recorded to CD or DVD.

4+ Read text from a printed document into your word processor. This
trick is called Optical Character Recognition (OCR) and can save you
hours of typing.

<+

Produce images that you can fax with your PC’s fax/modem.

4 Produce images from transparencies or slides (with the right
attachment).

4 Create copies of a document (in concert with your printer).




Figure 2-5:
A digital
penisa
specialized
scanner.

Scanners 2 9

Plus, prices on the better scanners have been dropping for some time now.
For example, the ScanMaker 4900 from Microtek (www.microtek.com) is
priced under $200, yet it scans at a quality that five years ago would have
cost you more than $500. This scanner contains seven one-touch buttons
on its front. You can e-mail, copy, or even create PDFs from the original —
or even run your OCR software with a single punch of a button. Sassy’

Specialized scanners are designed especially for things such as bar codes
and business cards. A unique favorite of mine is a digital, hand-held pen
scanner (see one in Figure 2-5) with which you can recreate what you draw
or write on special sheets of paper in the included notebook and a special
type of self-adhesive notes. I use the Logitech io (www.1ogitech.com). No
more stuffing napkins with scribbles all over them into your jacket pocket
after lunch! You can also use the io to enter appointments and To Do data
into Microsoft Outlook or Lotus Notes and also flag information that should
be automatically entered into an e-mail message when you connect the pen
to your PC. (It uses a USB connection.) If you're like me — constantly
moving back and forth between old-fashioned pen and paper one minute
and a mouse and Adobe Illustrator the next — you'’ll find that the io is
worth every penny of the $200 that you’ll pay for it.

[ go into more detail on scanners in Book VI, Chapter 1. For now, just remem-
ber that they are the very definition of the cat’s pajamas.
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Keyboards, Tablets, and Pointing Things

Gotta have ’em. Using a PC without an input device is . . . well, [ guess it’s
like playing ping-pong without paddles. In this section, I discuss the
upgrades that you can make to your PC’s existing keyboard and mouse.
(Although they’re technically not peripherals, as | mention in Book I,
Chapter 1, some of these hardware devices are too cool not to cover.)

Tickling keys wirelessly

As I discuss in the previous chapter of this mini-book — and as you can read
in Book II, Chapter 1, when I start talking XP — Mr. Bill has remodeled the
hoary PC keyboard in his own fashion, adding extra keys that make it easier
to control Windows. If you're using a PC built in the last few years, you’ll
already have these keys handy. [ mention a few keyboard features to look for
in the previous chapter of this mini-book, such as ergonomic keyboards that
can help reduce the strain of typing on your wrists. But what if you want to
relax in a better chair several feet away from that big-screen monitor?

Enter the wireless keyboard, which is the perfect complement to a wireless
mouse or trackball. The wireless keyboard shown in Figure 2-6 is a combina-
tion of both a wireless keyboard and wireless mouse that use the Bluetooth
short-range wireless network technology I cover in Book VIII, Chapter 3.
This keyboard is festooned with no less than 11 one-button hotkeys and
even includes a set of audio CD player controls for listening to your music.

s 2 SQESEDS © o

Figure 2-6:
This
wireless
keyboard/
mouse
combo is
the nomad’s
dream.
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Putting a tablet to work

If you're a graphic artist, a professional photographer, or someone who
wants to paint or draw freehand, consider a graphics tablet (shown in



Figure 2-7:
A graphics
tablet
makes
drawing a
breeze.
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Figure 2-7), which allows you to draw or make notes with a stylus in the
familiar old-fashioned method. Like an ergonomic keyboard, a tablet can
also help ease the strain on your wrist.

“But what about the fine control I get with paper or canvas?” No problem!
Today’s tablets can recognize thousands of different levels of pressure.
Some can even detect the angle of the stylus, allowing you to tilt your virtual
brush in graphics applications like Photoshop and Painter for special effects
with watercolor, chalk, and pencil filters.

A typical tablet like the Intuos2 from Wacom (www.wacom. com) has no bat-
teries or cords on the stylus, and it even comes with its own mouse. The
tablet uses a USB connection to your PC, and it sells for about $350 on the
Web — that’s the 6 x 8-inch model. (The 9 x 12-inch model is about $100
more.)

Repeat after me: Buy a trackball!

[ can’t work with a traditional mouse any longer — I'm now firmly set in the
trackball camp. A trackball offers a number of benefits:

4+ Compact: Trackballs require far less space on your desktop because
just the trackball moves (instead of the entire device).

4+ Control: Many folks find that using a trackball provides a finer level of
cursor control.
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Figure 2-8:
A trackball
is much
more
efficient
than the
traditional
mouse.

4 C(leanliness: A trackball stays cleaner than a mouse. (Even optical mice
get dirtier than trackballs.)

Figure 2-8 illustrates a trackball mouse that you control with your thumb; other

trackballs use the first finger to control the ball. This particular model uses
either a USB or PS/2 connection to your PC and sells for about $35 online.

Big-Time Game Controllers

Ah, do you remember the old Atari joysticks that ushered in the age of the
video game (and the Atari personal computers after that)? A plastic tube, a
base with a single red button, and a cord . . . what more could you possibly
want, right?

Because modern game players want a lot more than one button, witness the
arrival of the game controller (which I think has a much grander sound than
just a joystick). For example, check out the controller shown in Figure 2-9 —
does that look like an old-fashioned joystick to you? In fact, this model is
more like a combination of a mini-keyboard and a gamepad (reflecting the
current complexity of PC games, which rely as much on the keyboard as

the pointing device that you're using). Your entire hand fits on top of the
controller, much like a trackball, and your fingers use the keys while your
thumb operates the gamepad directional control. (You can also use this
controller along with your regular mouse or trackball.) This model, which
sells for about $30 online, can even be programmed to fit your preferences
for each individual game that you play. Sweet!



Figure 2-9:
It's a bird, it's
aplane...
no, it's the
latestin PC
game
controllers!
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Another popular feature of today’s game controllers is force feedback, where
the controller actually rumbles or provides resistance to your hand that
matches the action onscreen, such as a steering wheel that gets tougher to
turn in curves or a joystick that shakes each time that your WWII fighter is
hit by enemy fire.

Consider the Microsoft Sidewinder Force Feedback steering wheel, which has
the same optical tracking mechanism as today’s optical mice and trackballs.

It even has its own onboard processor, which keeps track of what’s happening
within the game and activates the wheel’s internal motors to provide the
matching feedback. (Naturally, it also has programmable buttons. What a
surprise.) Anyway, you get the steering wheel and a set of pedals to boot

for about $100, making you the hit of your NASCAR crowd!

Video and Digital Cameras

Images and full-motion video have traditionally been based on film (which
retains an image when exposed to light) or magnetic tape. That whole
approach, however, is now strictly '90s . . . and very early '90s to boot.
Today’s digital cameras and digital video camcorders have heavy-duty
advantages over film cameras and tape camcorders:

4+ No processing at Wal-Mart is required. Your digital images can be down-
loaded directly to your PC.

4+ Editing is easy, using programs like Adobe Photoshop and Paint Shop
Pro (for digital images) and Adobe Premiere (for video).

4+ No film rolls to buy. Instead, you simply delete images from your digital
camera after they’re downloaded.
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Figure 2-10:
The image
maker of the
new
millennium:
the digital
camera.

4+ Your images and videos can be saved to a CD or DVD for permanent
storage.

4+ Images can be sent via e-mail or displayed on your Web page.

4+ You can create your own DVD movies from your video clips.

A specialized model of DV camcorder (about the size of a baseball) is
designed especially to sit atop your desktop PC: a Web cam. Folks use them
to send digital video over the Internet, to add a video signal to their Web
pages, or to record simple movies from their chair. Web cams have been in
use as Internet videoconferencing tools for years now; most are under $100;
and they use either a FireWire or USB cable connection to your PC.

Figure 2-10 illustrates a typical digital camera, which looks and operates
much like its film counterpart. Figure 2-11 shows a camcorder, ready to
record straight to digital video, which you can transfer over a FireWire con-
nection to your PC.

For the skinny on digital cameras, see Book VI, Chapter 5. And for a look at
how the video clips that you take with your DV camcorder can be turned
into movies, see Book VI, Chapter 3.
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External Drives

Next, consider how simple it is to add fast storage — or the ability to record
your own CDs and DVDs — to today’s PCs. If you're the least bit nervous
about digging inside your PC’s innards in order to add more hard drive
space, you'll be pleased to know that it’s easy to connect a fast external
hard drive to your system . . . providing that you have the FireWire or USB
2.0 ports available on your PC. (If you're not familiar with these high-speed
connections, fear not: I launch into a complete discussion of both of these in
Book VII, Chapter 5.)

In fact, not every form of external storage even needs a cable. Read on to
see what [ mean.

Portable hard drives and CD/DUD recorders

Forget the huge external hard drives of just five years ago. Those doorstops
have been replaced by slim, trim models (see Figure 2-12) that run faster
and are more reliable and yet are no bigger than a pack of playing cards. At
current prices, you can pick up an external 40GB hard drive for about $350
that is a mere one inch thick and shock resistant yet can connect effort-
lessly to PCs with either FireWire or USB 2.0 ports.
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Figure 2-12:
This
external
40GB drive
means
mobile
storage.
On the CD and DVD recording scene, you’ll find four major types of drives:
4 CD-R/CD-RW drives: Can store around 700MB on a CD
4+ DVD-R/DVD-RW drives: Can store 4.7GB on a DVD
4+ DVD-RAM drives: Can store 9.4GB on a double-sided DVD
4+ DVD+R/DVD+RW drives: Can store 4.7GB on a DVD
The RW in the drive moniker stands for rewriteable, meaning that you can
reuse a CD-RW, DVD-RW, or DVD+RW over and over. All these recorders can
produce audio CDs and standard data CD/DVDs, but only the drives that can
record the DVD-R and DVD+R formats are likely to create a DVD movie that
can be played in your standalone DVD player. Unfortunately, the rewriteable
DVD-RW and DVD+RW standards aren’t compatible with each other, and
they’re not compatible with most standalone DVD players, either; you'll
have to watch your discs on your PC. (Insert sound of palm slapping fore-
head here.)
P The current morass that is the DVD standards battle is too complex to go

into in this chapter. If you’d like the full story about what works with what
and how to record any type of disc under the sun (audio, video, data, and

even a mix), I can heartily recommend my book CD and DVD Recording For
Dummies, by Wiley Publishing, Inc. (It'll keep your library consistent, too.)
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Backup drives used to mean inexpensive, slow-running tape drives —
however, today’s typical 60GB and 80GB drives are simply too humongous
for such tapes to be worth much anymore. Heck, | remember when every-
one backed up to floppy disks, and now even the highest-priced digital
audio tape (DAT) drives are losing ground fast in the backup storage world.

Instead, you now have three choices to pick from when backing up your
system:
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4+ DVD recorders, especially DVD-RAM drives, which can store over 9GB
per double-sided disc.

4 Online backups, using a commercial Internet backup service. (This is
really only a viable solution if you’re using a broadband connection to
the Internet; backing up a big hard drive takes too long over a pokey
56KB modem.)

4+ External FireWire and USB 2.0 backup hard drives like the 200GB
Maxtor Personal Storage 5000DV (www.maxtor.com), which allows you
to start a full, automated backup of your system by pressing the button
on the front of the drive.
\“Q,N\BER
& The Maxtor unit isn’t cheap at $450, but how much are your documents and
files worth? No matter what backup method you use, I strongly urge you to
do your duty as your PC’s guardian and back up your system!

USB flash drives

The final storage toy is a little something different: the USB flash drive,
which is a keychain-sized unit that needs no batteries and has no moving
parts! Instead, it uses the same method that digital cameras use to store
images. Your files are stored on memory cards (either removable cards or
built-in memory inside the unit). Most USB drives now range anywhere from
16MB to 256MB of storage, and after you plug them into your PC’s USB port,
they look just like any external hard drive (or a whomping huge floppy disk),
but they can be unplugged and carried with you in your pocket. These
drives don’t need any extra software — Windows 2000 and XP recognize
them instantly — so they make a great “digital wallet.”

Figure 2-13 illustrates a 128MB flash drive that sells for about $50 online. It
even includes a write-protect switch so that you can safeguard your data
from being accidentally erased.
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Figure 2-13:
Carry
128MB in
your pocket
with a USB
flash drive.

Surge Protectors and UPS Units

You know, one clear sign of a PC power user is at the end of the PC’s power
cord. True power users will use either a surge protector or a UPS to safe-
guard their system. However, I always make sure that [ stress the following
fact when I'm talking about surge protectors and UPS units: Neither will be
able to protect your PC from a direct lightning hit on your home or office
wiring! (That’s just too much current for any commercial surge device to
handle.)

Otherwise, using both a surge protector and a UPS will help guard against
less serious power surges, and both will provide additional AC sockets for
your rapidly growing system. If you can afford to spend $200-$300, the UPS
is the better choice because of the following reasons:

4+ Safety nets: A UPS provides a number of extra minutes of AC power if
your home or office experiences a power failure — generally enough so
that you can close any documents that you're working on (like that
Great American Novel that you've been slaving over for 20 years) and
then shut down your PC normally.

4 Auto shutdowns: More expensive UPS models can actually shut down
your PC automatically in case of a power failure.

4 Current cleaners: Most UPS units filter the AC current to smooth out
brownouts and noise interference from other electronic devices.

4 Audible alerts: Some UPS units sound an alarm whenever a power fail-
ure or significant brownout occurs.
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The number of minutes that your UPS will last during a power failure
depends on the power rating of the battery. Don’t forget, however, that a
honking big cathode ray tube (CRT) monitor will use much more power than
the PC itself, so you should allow for it when deciding on which UPS to buy.

If you're using a dialup or digital subscriber line (DSL) modem connection,
make sure that you get a surge protector or UPS that will also protect your
modem from electrical surges — that juice can travel just as easily across a
phone line as across your power line.
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Chapter 3: Connectors, Ports,
and Sundry Openings

In This Chapter

+ Connecting USB devices

+ Connecting FireWire devices

v+~ Putting the antique serial port to rest

+* Recognizing the PC parallel port

v+ Connecting your monitors

v Locating the jacks and ports on your sound card

1 Connecting your mouse and keyboard

In the beginning (okay, last century), there was the serial port and the
parallel port — who would have needed anything else? If you could
afford a printer back then, it was connected to the parallel port, and your
modem (or perhaps your mouse) was hooked to your serial port. End of
story.

Today’s typical PC sprouts those same two ports. And although you can
still use them with a printer, modem, and even a mouse, you’ll also find a
number of relatively new connectors that greatly expand the range of
peripherals that you can add to your system. In this chapter, | help you
make sense of the various ports and sundry openings that you'll find on the
back of your PC.

Using USB Stuff

The first port on the tour is rapidly becoming the most important standard
PC connector. A Universal Serial Bus (USB) port (see Figure 3-1) allows you to
connect all sorts of peripherals, and it’s even becoming popular for connect-
ing keyboards and mice. Intel is responsible for this most versatile of ports.
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Figure 3-1:
The docking
procedure
fora USB
port.

USB connector USB ports

Y,

A USB connection is the cat’s pajamas because

4+ It’s plug and play. You don’t even need to reboot your PC after you

connect a USB device because Windows automatically recognizes the
connection, and you can start using your USB peripheral immediately.

One port supports dozens of devices. A single USB port can support up
to 127 different devices, either connected in a daisy-chain configuration
or by using a USB hub. I doubt that you have that many connections to
handle. (But if you do, please take a photo of your system with your dig-
ital camera and send the picture to mark@mlcbooks.com because I can
hardly wait to see it.)

It’s relatively fast. The two current standards for USB devices are the
older USB 1.1 standard (which still delivers data transfer speeds that
are many times that of a traditional serial port) and the USB 2.0 stan-
dard (which is the fastest connection currently available for the PC).
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[ discuss USB connections in greater detail in Book VII, Chapter 5; for now, Book |

just remember that any device with a USB port connection is a better choice Chapter 3
over the same device with a serial port or parallel port connection.
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Until recently, the FireWire port (often referred to by its more official name, @ .5' s
IEEE 1394) was the fastest port on any personal computer and has therefore a

become the standard for digital video (DV) camcorders and high-resolution
scanners — both of which produce honking big files that need to be trans-
ferred to your computer as quickly as possible. Believe it or not, Apple
Computer is the proud parent of FireWire.

The original FireWire standard has now been overtaken in raw speed by USB
2.0, but because FireWire has been around far longer, it’s in no danger of dis-
appearing any time soon. In fact, I personally would pick FireWire over USB
2.0 every time because none of my current crop of digital gear will recognize
USB 2.0.

Unlike USB ports — which are included with every PC today — FireWire
ports are generally available as optional equipment, so make certain that
you have a FireWire port before spending the big bucks on that new DV cam-
corder. (Of course, you can always buy an adapter card to add FireWire ports
to your computer.) Like USB, FireWire is also a plug-and-play connection; a
FireWire port can support 63 devices (using a daisy-chaining technique).

Find more information about FireWire in Book VII, Chapter 5, where I intro-
duce the new FireWire 800 standard, which ups the ante in the port speed
race, churning an incredible 800 Mbps (or twice as fast as original FireWire)!

Back off, SCSI!

entire chapters to it in some of my older books.
External SCSI devices aren't plug and play, and
an external SCSI peripheral is much slower
when it comes to transferring data than the
newer USB/FireWire technologies.

Many hardware technicians and techno-
wizards are familiar with Small Computer
System Interface (SCSI) connectors. SCS/ was
the original high-speed, daisy-chaining technol-
ogy that allowed you to add a string of multiple
devices (a SCS/ chain) both inside and outside
your PC’s case. Even today, SCSI internal hard
drives are some of the fastest on the market.

For these reasons, | advise even PC power
users to give SCSI the cold shoulder when con-
sidering an external device unless your PC

However, external SCSI devices are somewhat
scary: A SCSI chain is much harder than USB
2.0 or FireWire to configure. In fact, I've devoted

already has SCSI hardware, and you're experi-
enced with configuring SCSI hardware. Take my
word for it; you'll be glad you did.
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Vour Antique Serial Port

Your Antique Serial Port

Okay, perhaps the serial port isn’t antique, but it is one-half of the original
Dynamic Duo that first appeared with the premiere of the IBM PC.

Today, most peripherals have jumped the serial ship and joined the USB
bunch. However, you can still find the following serial devices from time to
time (usually used, and probably on eBay):

4+ Modems

4+ Game controllers (especially the more complex joysticks)

4+ Digital cameras

4 Personal digital assistant (PDA) docks for Palm and Pocket PC units
Serial devices aren’t plug and play, so you’ll have to reboot your PC before
Windows will recognize a serial device. Also, serial devices — especially

modems — might require additional manual configuration inside Windows,
such as editing files with Notepad and turning off certain port features.

All in all, go USB. Everyone else is, and it’s a good thing.

The Once-Renowned Parallel Port

Ah, [ remember those days . . . the early 1980s, when the parallel port was
truly the Queen of the PC Connections. Printers were hideously expensive
peripherals that only a doctor, lawyer, or Supreme Court Justice could
afford. And if you did have a printer, it was connected to your PC’s parallel
port with all the pomp, grace, and grandeur of the RMS Queen Elizabeth II
(Perhaps I need more Diet Coke.)

Figure 3-2 illustrates the standard PC parallel port as it appears today.
Unlike the serial port, the parallel port is still somewhat useful today; a large
number of parallel port printers are still manufactured, and the parallel port
is also used with other peripherals such as Zip drives and scanners (usually
with older PCs without USB support).

I'm sorry to report, however, that the parallel port’s days are numbered.
The popularity of the USB port as a printer connection has doomed the par-
allel port to obsolescence, and we can wave goodbye to her with a wistful
smile. Again, like the serial port, Mark’s Maxim prevails:

Buy USB. You’ll be happier.™



Figure 3-2:
A grand old
dame of the
PC world,
the 25-pin
parallel port.
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Parallel port
(25 pins, male)
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Many laptops feature an infrared port (commonly called an /rDA port, short
for Infrared Data Association) that can be used to communicate with devices
such as PDAs and other laptops. Windows provides full support for an
infrared connection. However, these ports don’t do diddly-squat if the exter-
nal peripheral that you're trying to communicate with doesn’t have its own
IrDA port — and not many do, so you won’t be able to use this whiz-bang
technology with many devices.

Meet Vour Uideo Port

\\3

At last, a port that’s been around for many years and still rocks! Yes, friends
and neighbors, today’s video cards still use the same 15-pin, D-SUB video
port that originally appeared with the IBM Video Graphics Array (VGA)
specification. However, another new face is on the block: the 29-pin, DVI-/
port, which is used to connect digital flat-panel (liquid crystal display; LCD)
monitors. Figure 3-3 shows a typical video card that offers both ports
onboard.

If you're wondering, virtually every card that has both of these video ports
can actually use two monitors at once (either showing an expanded desktop,
where your mouse moves seamlessly from one monitor to the other, or two
separate and discrete desktops).

In a pinch, a DVI-VGA adapter allows you to use the DVI- port to connect a
standard cathode ray tube (CRT) monitor, so you can use two analog moni-
tors instead.

Book |
Chapter 3

sbuluadg

Aipung pue
‘SH0d 's10)93UU07)



46 Audio Connectors You'll Likely Need

Figure 3-3:
Many cards
offer both a
VGA and a
DVI-1
connector.

Lf

Standard VGA
monitor connector

DVI-I
connector

Audio Connectors Vou'll Likely Need

Today’s speakers connect to your PC’s sound card in one of three ways:

4+ Through standard analog Line-Out/Speaker jacks on the card: These

are the familiar audio jacks that you’ll find on the card itself, just like the
headphone jacks on your MP3 player or boom box. Most PC speakers
use these jacks, shown in Figure 3-4.

Through standard analog RCA jacks on the card: Some cards also
include the RCA jacks that most folks associate with a stereo system or
a VCR. These jacks are more convenient than the Line-Out/Speaker
jacks because you don’t need a miniplug-to-RCA adapter to use your
stereo system with your PC’s audio output.

Through the USB port: Surprise! It’s our new-old-friend making another
appearance. This time, your speakers can use any USB port on your
system for a digital audio connection — analog gets tossed out the door,
and audiophiles can wax enthusiastic about their pristine digital sound.
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Figure 3-4:
The
business
end of a
typical PC
sound card,
with
speaker
jack and
game port.

You'll also find a PC game port on most audio cards, allowing you to connect
a joystick or other game controller. The game port is going the way of the
dodo (thanks once again, as you can guess, to USB game controllers), but
they’re still quite common on today’s sound cards.

Keyboard and Mouse Ports on Parade

The final stop on the port tour is the ubiquitous PS/2 keyboard/joystick
port. Figure 3-5 illustrates the plug that fits in these ports. Each port is
typically color coded and marked with an icon to indicate which piece of
hardware gets connected where.

[ hate to bring it up, but at the risk of sounding like a broken record, many
PC hardware manufacturers are turning to USB keyboards and USB mice.
(See why I stress just how important USB is to the modern PC?) In this case,
however, | see no real advantage to using a USB keyboard or mouse over a
PS/2 keyboard or mouse because the latter really don’t require any configu-
ration, and they’re not constantly being unplugged and reconnected.
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Figure 3-5:
A PS/2
keyboard/
mouse
connector.
Awesome
sight, isn't
it?




Chapter 4: Maintaining
Vour Hardware

In This Chapter

+* Moving your PC the right way

v+ Dusting your PC

+ Keeping cables under control

v+ Cleaning your monitor and scanner
+ Freshening your mouse and keyboard

v+ Practicing printer maintenance

Wth the right credit card balance, anyone can buy a supercharged
$2,500 PC — but maintaining that expensive equipment is another

kettle of fish altogether. Although your PC’s case might appear to be a
closed environment, those fans draw in dust while they’re cooling things
down . .. and what about peripherals such as your printer and scanner,
which are always more exposed to dust, dirt, and contaminants? The only
PC that I've encountered that doesn’t need regular maintenance is the
model that you can buy in The Sims.

In this chapter, I cover the basic cleaning and maintenance necessary to
keep your hardware in top shape — long enough for it to become a seriously
outdated antique! (And that’s coming from the proud owner of two antique
RadioShack computers and three antique Atari computers.)

When Should 1 Move My PC?

Counter to popular myth, even a desktop PC can go mobile whenever it
wants. Of course, you won'’t be stowing it with your other carry-on items on
a plane, but if you've been challenged to a LAN game at someone’s apart-
ment or you're moving to a new home, you'll find that your PC actually
enjoys chaperoned trips. (Rather like a dog, without the tongue out the
window.)



50 Avoiding Dust Bunnies

Here are the guidelines that you should follow when moving your PC:

4 Never move your PC until it’s completely powered down. In this case,
move means any movement whatsoever (even nudging your PC’s case a
few inches across your desktop). Harken to this particularly important
Mark’s Maxim: Never move your desktop PC if it is running.” (Even
laptop computers shouldn’t be jolted or jerked around while they’re
running.) Many PCs have only a handful of moving parts, such as fans,
CD/DVD recorders, and hard drives — but brother, any movement while
the latter two are still spinning carries the possibility that you can
shorten the drive’s operational life. Always give your PC at least ten sec-
onds after it shuts down before you pick it up.

4+ Never set your PC upright in a seat or the floor of your car. We've all
seen the videos of crash test dummies . . . and your beloved digital
friend doesn’t have a car seat in case you come to a sudden stop. You
can actually use seatbelts to secure your PC in a vehicle, but I think it’s
just easier to lay your PC’s case down flat on the floor of your vehicle.
The same also goes for your monitor, which is also dangerous (for itself
and your head) when airborne for short distances.

4+ Use a towel if necessary. If your PC has to ride on top of a surface that
might scratch your case, wrap your PC in a towel or blanket to protect
its finish.

Avoiding Dust Bunnies

Think I'm kidding? Dust bunnies are real — and they seem to reproduce as
fast as their namesake, too. Thanks to your trusty can of techno-nerd com-
pressed air, however, you can banish that dust from your PC and get back
to work or play.

Here’s a checklist of what to do:

4 Open and dust your PC at least once a year. Consider it a birthday pres-
ent for your computer. Unscrew or unlatch your PC’s case and use your
compressed air (available at any office supply store) to blow any accumu-
lated dust from the motherboard, adapter cards, and cables. If allowed to
accumulate, that dust can act as a comfy heat-retaining blanket over your
PC’s circuitry, and overheated components have a significantly shorter
lifespan. (For proof, check out the fans at the back of your PC’s case and
the fan on top of the processor. Heat is the enemy:.)



3

SN

\\3

Watching Your Cables 51

4+ Remove dust that’s settled on the fan blades. Speaking of fans, use

your compressed air to get rid of any additional dust on fan blades and
within air intake holes. In order to properly ventilate and cool your PC,
these openings need to be free of dust bunnies.

Wipe down your PC’s case and your monitor with a clean, dry cloth
every few months. You should never use any household solvents to
clean your PC’s case, but antistatic cleaning solutions and cloths are
made just for cleaning computer hardware, which you can find at your
local computer shop or office supply store.

Are you facing a stain that won’t come off your PC’s case, even when
you use an antistatic cleaning cloth? Then try my secret weapon: Armor
All protectant (which you’ve probably been using on your car’s rubber
and vinyl for years!). Apply a small amount of Armor All directly on the
stain and try again.

Avoid eating around your PC. [ know; it’s difficult not to snack while
you'’re on the Internet, but at least be diligent about cleaning up after-
wards and never park anything liquid anywhere near your computer!

Keep your workspace clean and open. Surrounding your PC with
papers and knickknacks might optimize your desktop space (or at least
help you feel more human around an inhuman boss), but you’ll be con-
tributing to the accumulation of dust inside your computer. And, in the
worst case, you'll actually be blocking the flow of air. [ try to leave at
least six inches of free space around the base of my PC at all times.

If your PC must be located in a dusty environment, consider an air cleaner
and ionizer unit. [ use one in my office, and I find significantly less dust to
clean from my PC every year.

Watching Your Cables

With the popularity of external Universal Serial Bus (USB) and FireWire
peripherals these days, the forest of cables sprouting from the back of your
PC can look like Medusa on a bad hair day. Normally, this isn’t a problem . . .
until you decide to move your PC, or you want to repair or upgrade an inter-
nal component. Talk about the Gordian knot!

Here’s a list of tips for keeping your cables under control:

4+ Use ties to combine and route cables. 'm a big fan of the reusable

Velcro cable tie strips that you can find at your local office supply store.
With these ties, you can easily combine cables that are heading in the
same direction into a more manageable group. You can also fasten these
cable ties to the underside of your desk or behind furniture to keep
network and power cables hidden and out of danger.
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Cleaning Monitors and Scanners

4+ Label your cables! Sure, you can tell the source and destination of
some cables at a glance — for example, network cables are pretty easy
to spot — but what about your USB printer and scanner, which both use
the same type of cable? If you must move your PC or unplug cables reg-
ularly, avoid the ritual of tracking each cable to its source by doing what
techs and computer shops do: Use a label machine to identify the tip of
each cable with the peripheral name.

4+ Tighten those connectors. “Gee, my monitor was working last night.
What gives?” If you didn’t use the knobs on either side of the video
cable connector to tighten things down, small shifts in position over
time could make cables work loose.

4 Check your cables for damage periodically. [ have a cat. Do you have a
cat? How about a dog? If so, don’t be surprised to find a chewed cable
one morning . . . and pray that it isn’t a power cable. (I keep all animals
away from my office for this reason — not to mention the mess that a
shedding dog can leave around your PC.) Of course, cables can also be
damaged by bending or stretching them, so I recommend checking each
cable at least once a year; [ combine this ritual with my PC’s yearly
cleaning.

Cleaning Monitors and Scanners

WING/
gg‘

Most PC owners are aware that they should keep the glass surfaces of their
monitor and scanner clean — but beware, because you can do more harm
than good if you don’t know what you’re doing. Here are the guidelines that I
recommend you follow when working with monitor and scanner glass:

4+ Abrasives are taboo! Even some household glass cleaners — which you
might think could be trusted — can scratch the glass in your monitor or
flatbed scanner when used with a rag or paper towel. With a scanner,
small scratches can mean real trouble because a scratch can easily
show up in your images at higher resolutions. Therefore, | recommend
that you use only a dry, soft photographer’s lens cloth (which won’t
scratch) or lens cloths with alcohol that are made specifically for
monitors and scanners.

4+ Never spray liquids onto a flatbed scanner. If liquid gets under the glass
and into the body of the scanner, you could end up with condensation on
the inside of the scanner when you use it. Again, a dry, photographer’s
lens cloth is a good choice . . . or pre-moistened lens cloths, which don’t
carry enough alcohol to do any harm. (I launch into scanners full-scale in
Book VI, Chapter 1.)
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4+ Monitors should never be opened. Never take the cover off a cathode
ray tube (CRT) monitor, even if it needs cleaning. Why? Well, your PC’s
monitor is one of the two components of your system that carry enough
voltage to seriously hurt you (the other being your PC’s power supply).
If your monitor needs to be serviced or cleaned on the inside, take it to
your local computer shop. (Find more about monitors in the first chapter
of this mini-book.)

4+ Use a cover for your scanner. Scanners are somewhat different from
most external peripherals. They don’t generate any heat while they're
on (unlike an external hard drive), and most of us only use a scanner
once or twice a week. Therefore, your scanner is a perfect candidate for
a cover that will keep it clean . . . and, by no small coincidence, you’ll
find such covers at your local office supply store.

Cleaning Your Mouse and Keyboard

A\

“Natasha, why we must clean Moose and Squirrel?” (Sorry, [ couldn’t help it.)
Mice and keyboards get grimy — fast — because your PC’s keyboard and
pointing device are constantly in use, and they get pawed by human hands.
(Of course, you could always wear surgical gloves, but what about your kids?)

Never fear. Here’s a list of guidelines that will help you keep your pointing
device and keyboard clean and working:

4+ Do the Keyboard Shake! No, it’s not a new dance craze, but it is the
best method of cleaning accumulated gunk from your keyboard, and |
recommend doing this at least once a month. Turn your keyboard
upside down and shake it vigorously back and forth; prepare to be
amazed (or grossed out, especially if the whole family uses your PC).

4 Buy an optical mouse or trackball. (You’ll thank me.) If you're still using
an old-style mouse with a ball — how very '80s — clean it once a month
as well. Unscrew the retaining ring on the bottom, remove the mouse ball,
and use a cotton-tipped swab dipped in tape-cleaning alcohol (which is
90+ proof and will leave no residue) to clean the rollers inside. Also, make
sure that your mousepad is clean and dust-free, and you’ll prolong the life
of your rodent. (Chapter 1 of this mini-book talks trackball.)

An optical mouse or trackball doesn’t need to be cleaned anywhere near
as often (if ever) — that’s why I keep crowing about them.

4+ Find yet another use for your compressed air. Your keyboard can
collect debris that can’t be shaken free. If so, using compressed air will
likely blow it free (unless it’s alive and well dug-in, but I haven’t encoun-
tered anything like that in my travels so far).
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Cleaning and Maintaining Your Printer

Cleaning and Maintaining Your Printer

A\

Time to consider a peripheral that not only needs cleaning but can also
contribute mightily to its own mess. If you've ever had to clean up spilled
laser printer toner, [ think you know what [ mean. Printers have all the nec-
essary features that make them prime targets for regular maintenance:

4+ They'’re open to the outside world.
4+ They're stuffed full of complex moving parts.
4 They’re constantly running out of ink or toner.

4 They act as a magnet for dust.

In this section, I show you how to clean and maintain yon printing instru-
ment. Consider this section as the maintenance highlights from my HP
Printer Handbook, Second Edition, by Wiley Publishing, Inc.

Cleaning laser printers

Your laser printer contains a mortal enemy — foner, that insidious stuff that
seems to have a diabolical mind of its own. Luckily, most cartridges are at
least partially sealed, and only older models of laser printers can produce a
really nasty Three Mile Island-level spill. If any toner escapes, however, you’ll
quickly find that it’s a very fine powder that’s sensitive to static charges and
that immediately heads to every corner of your printer. Those nooks and
crannies can be a real pain to clean. And because toner can permanently
stain clothing and carpet — and it’s harmful to pets and kids — you should
be doubly careful to keep toner inside the cartridge where it belongs.

Therefore, please take the time to completely read the instructions for your
specific laser printer before you install that first toner cartridge. Also avoid
shaking the cartridge unless the manufacturer recommends a particular
motion to help distribute the toner evenly.

If you do spill toner, head to your local office supply store for toner clean-up
cloths. These handy wipes contain a chemical that attracts toner and keeps
it on the cloth. Oh, and don’t use warm or hot water to wash toner off your
hands — toner can literally melt and adhere to your skin!
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Vg‘\\\NG! Never attempt to clean the interior of your laser printer while it’s on!

S Laser technology uses very high temperatures to bond toner to paper, so
you could be subject to serious burns if you're not careful. I always make
sure that a laser printer has been off for at least 30 minutes before I clean or
service it.

Although you should follow the specific instructions for your brand and
model of laser printer while cleaning the interior, here’s a list of the parts
that are generally covered in a good cleaning:

4+ Corona wires: These wires (see Figure 4-1) transfer a static charge to

the paper to attract toner, but if they get dusty, you’ll immediately see
spotting and degraded print quality in your printed documents. Most
manufacturers advise that you use a clean, dry cotton swab to gently
wipe the wires. You should find the wires close to the paper rollers
inside your printer. (Look for labels added by the manufacturer that
point to them and also check your printer’s manual if necessary.)

Figure 4-1:

In this case,
a Coronais

(
NN/l

not a beer.

Figure 4-2:
Cleaning the

Corona wires

Toner guard: These felt pads trap excess toner before it gets on your
documents. You might receive a new toner guard set with each car-
tridge, but in a pinch, you can probably remove the pads from your
printer and rub them on a clean cloth to remove that built-up toner.

Paper feed rollers: Use a cotton swab soaked in alcohol to clean the
buildup from your paper rollers, as shown so artistically in Figure 4-2.

Cotton swab

paper feed
rollers can

I =—b> )

make a big (
difference.
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Figure 4-3:
Checking
the ink
levels on
late-model
inkjet
printers is
a cinch.

4+ Fan vent: Yep, your laser printer has its own fan — remember the
intense heat that I mention a few paragraphs ago? And just like the fan
cleaning that [ recommended for your PC, it’s a good idea to use com-
pressed air to blow any dust from the fan and the ventilation grill.

[ highly recommend using the laser printer cleaning sheets that you can find
at your local office supply store. These papers are treated to remove dust
and excess toner from the printer’s paper path, which you normally wouldn’t
be able to clean. Plus, they're very easy to use: You just run them through
the printer as if they were regular sheets of paper. If your printer resides in

a dusty or smoky room, these sheets are worth their weight in gold.

Changing inkjet cartridges
Here are two methods of determining when you need to change the car-
tridges in your inkjet printer:

4 The automatic route: Most inkjet printers on the market today have
onscreen alerts that appear when the ink level of the cartridge is low.
Or, like you see in Figure 4-3, your printer might actually be able to
display the amount of ink remaining in a cartridge. (A very valuable
trick, indeed, especially for students with term papers looming in the
near future.)

C hp photosmart P1000 series Toolbox

ﬂ Divios Senvices W Etmated bk Lvel & Conthgusason,

Tk Pl sedige Btk S [ amacige
wE

. i
wx

g Pt Nty By Pt Hurster
ho CESTB s ho SIEAS sesen




Cleaning and Maintaining Your Printer 57

4 The “Man, I can barely read this page!” method: If you have an older Book I
inkjet printer, you might not receive any warning at all about the ink Chapter 4
levels in your cartridges — but when they’re empty, pardner, you’ll
know.

After you know that you need to change your cartridges, however, the gen-
eral procedure is the same for virtually every inkjet printer that I've ever
encountered:

alempiey
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1. Open the top of your printer.

This will cause most printer models to politely center the carriage to
provide you with access to the cartridges.

\NG/ 2. After you have access to the cartridges, turn your printer off.

&

W,

Never try to change the cartridges in a printer that’s still powered on!
(Your fingers will thank me.)
3. Lift or turn the latches holding the ink cartridge in place.

Q@\BEH
& Most inkjet printers have at least two cartridges — one for black and

one for color — so make sure that you're working with the right car-
tridge before you remove it.

4. Remove the used cartridge and consider refilling it.
[ discuss the pros and cons of refilling cartridges later in this chapter.
5. Load the new cartridge and fasten the latch to hold it down.

6. Turn your printer back on and close the lid.

Calibrating your printer

This maintenance task is reserved only for inkjet printer owners. (My, aren’t
we lucky?) Calibration refers to the proper alignment of the inkjet cartridge
nozzles to both the paper and each other; without a properly calibrated
printer, your print quality will degrade over time. This is usually the prob-
lem when folks complain that lines appear fuzzy in artwork or when colored
areas in printed images start or stop before they should.

If you hear a professional photographer or graphic artist talk about color
calibration, that’s something completely different; color calibration is the
process of color matching between the colors that appear on your monitor
and the colors produced by your printer. Most of us will never need that
level of precise color, and most inkjet printers now allow you to make
changes to the hue and saturation of your prints by simply dragging a slider
in a printer’s Properties dialog box. But if you need to perform a full color
calibration, check your printer’s manual for more information about using
Windows color profiles.

A\
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Figure 4-4:
Preparing to
calibrate a
printer in
Windows
XP.

Your printer will automatically calibrate itself when you first load a new
cartridge, so | recommend that you calibrate either three months after
installing a new cartridge or when you notice that your print quality is
suffering . . . whichever comes first. (Of course, the time period will vary
according to how often you use your printer and the length of your average
printed document.)

Although each brand (and sometimes each model) of printer has different
onscreen controls for calibrating output, you should be able to access them
from the printer’s Properties dialog box. Follow these steps in Windows XP:

1. Choose Start->Printers and Faxes (or Start->Settings->Printers and
Faxes, depending on how your Start menu is configured).
You see the available printers on your system (see Figure 4-4).

2. Right-click the printer that you want to calibrate and then choose
Properties from the pop-up menu that appears.

A dialog box somewhat similar to Figure 4-5 appears.
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3. If the printer’s calibration function isn’t visible from the General tab,
you might have to search for it on the Advanced tab. You can try
clicking the Printing Preferences button as well — in my case, I have
to do that and also click the Services tab.
If it still fails to appear, check your printer manual for the location of the
calibration controls; some printer manufacturers provide a separate
application that you can run to display your maintenance toolbox.
Figure 4-6 illustrates the calibration dialog box for my HP printer.
4. Run the calibration. (In my case, I click the Calibrate button.
y
The process takes under a minute and uses a single sheet of paper.
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Figure 4-7:
Preparing to
clean my
inkjet
nozzles.

Cleaning inkjet cartridges

Here’s yet another fun task limited to just inkjet owners. I usually clean my
inkjet cartridge nozzles about once every three months or whenever the
output from my printer suddenly starts showing streaks of horizontal white
lines. (As you've probably guessed, the nozzles control the placement and
amount of each droplet of ink.) The good news is that you won’t need a
bucket and a scrub brush for this chore; instead, your printer can take care
of cleaning its own cartridges (with your approval, of course).

A new inkjet cartridge provides your printer with a brand-new set of noz-
zles, so you should restart that three-month period when you change car-
tridges. However, if you refill an inkjet cartridge — which I discuss in the
next section — you should clean the cartridge nozzles immediately after the
refilled cartridge has been reinstalled.

Like the calibration controls that I discuss in the preceding section, the loca-
tion of your printer’s cartridge cleaning controls is very likely buried some-
where within its Properties dialog box, or it’s available when you run the
maintenance program supplied by your printer manufacturer. To display the
Properties dialog box for your printer, follow the procedure that [ cover earlier.

Figure 4-7 illustrates the cleaning controls for my HP inkjet printer. I just
click the Clean button, wait about a minute, and I'm done.

Clean Print Cartridges 57
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Should you refill used inkjet cartridges?

I'll be honest with you: [ don’t refill inkjet cartridges, and I don’t recommend
that you do, either. The only real advantage to refilling cartridges is the
money that you save over buying a new cartridge. As a fellow inkjet owner
myself, [ feel your pain when you’re standing in the checkout line at
Wal-Mart with a $40 cartridge in your hand.
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However, here are the reasons why I buy new cartridges — consider these Book |
the facts that you won’t see when that refill kit TV commercial appears for Chapter 4

the umpteenth time:

4+ You’'ll probably get messy. Even if you're experienced at refilling an ink
cartridge, there’s a good chance that you’ll end up with a toxic spill.
Make sure that you cover your work surface with a plastic sheet and
don’t wear anything formal.

4+ You get substandard ink. One of the reasons why ink refills are cheaper
is that the quality of the ink used in the refill kits is usually never as
good as the ink in a new cartridge. That second-rate ink can cause color
changes or uneven coverage and might also end up taking longer to dry
(resulting in Smear City).

alempiey
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4+ You're reusing the nozzles. | mention cleaning cartridge nozzles in the
previous section. Unfortunately, those nozzles are not meant to be
reused, and refilling a cartridge can result in clogs. You'll have to clean
your cartridges far more often, and the quality of your printer’s output
might drop appreciably over time when you use a refilled cartridge.

Thus my decision and my recommendation — let someone else suffer
below-par print quality by refilling their used cartridges.
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Windows XP

The Sth Wave By Rich Tennant
e 1

“It’s a ten-step word processing program. Tt comes
with a spell—checker, grammar—checker, cliche—
checKer, whine—checKer, passive/aggressive —checker,
politically correct-checker, hissy—£it —checker,
pretentious pontificating—checKer, boring anecdote—
checkerand a Frevdian veference—checker.”
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Chapter 1: Shake Hands
with Windows XP

In This Chapter

v~ Celebrating the advantages of Windows XP

v~ Starting and shutting down Windows XP
v+ Introducing Windows controls

v Using the keyboard

v Searching for help

+ Contacting Microsoft for support

Of all the many Windows flavors that I've seen over the last decade —
everything from mixed berry to plain vanilla — Windows XP Home
and Professional are the best versions that I've ever used. The XP operating
system offers the top appearance, performance, and functionality available
for your PC today . . . as long as you're using an Intel Pentium 4 or Advanced
Micro Devices (AMD) Athlon XP processor. (If you're using a Pentium II or
Pentium IIl machine, I'd consider sticking with Windows 98SE because your
PC doesn’t have the necessary horsepower to provide real performance in
Windows XP.)

Note: There are actually two different editions of Windows XP: Home Edition
and Professional. (You can tell which version you have when you start your
PC because Windows XP displays an identifying welcome screen while it’s
loading.) The Home Edition omits a handful of networking and security fea-
tures found in XP Professional (the most glaring being the lack of the
Backup Wizard), but for a typical home PC owner or small office PC user,
the two end up being just about identical in look, taste, and smell. And
everything that you find in this chapter applies to both versions of XP.
(When disparities occur later in this mini-book, I'll send up a flare.)

In this chapter, I present you with the beginning of your Windows XP
manual — the invaluable, indispensable paper volume that you didn’t get
when you bought XP or bought your PC. (Can you tell that [ used to write
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software user manuals?) This book assumes no prior experience with XP,
so [ start with shutting down your PC and the most important controls and
keys that you’ll use in the following chapters.

Why Windows XP, Anyway?

If you're wondering why I consider Windows XP to be the pick of Microsoft’s
litter — and why you shouldn’t run an older version, such as Windows 2000,
Millennium (Me), or 98SE — allow me to point out its advantages as well as
the occasional downside.

4+ It’s attractive: Microsoft has gone to a lot of work to make XP a graphics
jewel — menus fade in and out, 3-D effects abound, and even your
mouse has a fashionable shadow under it. (This graphics banquet has
its cost: You'll need a Pentium 4 processor, at least 256 MB of random
access memory [RAM], and a graphics card made in the last two years
to enjoy these visual perks without slowing down your PC.)

4+ It’s fast: With a PC built within the last year or so, XP will perform better
than older versions of Windows — and that includes Windows 2000,
which was used as the foundation for XP.

4+ It’s easier to use: No downside here! Older versions of Windows made it
harder to take care of chores such as creating an Internet connection
and adding a printer to your system. The folks in Redmond have been
working overtime to help automate these processes.

4+ It supports the latest standards: Again, this is nothing but good. XP can
handle all the acronyms that you want (but might not yet know): MP3,
MPEG, JPEG, USB, Wi-Fi, DSL, and many more. (All those cryptic
escapees from a bowl of alphabet soup get explained in this book.)
Unlike older versions of Windows — which either don’t support the
latest technology at all or do require additional software to use — XP
has built-in support for today’s neatest toys.

4+ It’s harder to crash: Windows XP is descended from Windows 2000,
which in turn dates back to Windows NT — and all three are more crash
resistant and reliable than the Windows 95/98/Me crowd. XP also
includes better protection for system files; for example, you can set a
restore point that can be used as a backup if your system files are cor-
rupted. Fewer crashes and better reliability mean that you can actually
get up from your PC for lunch without worrying whether it will still be
running when you return.
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How much space does Windows XP need?

On my desk is an original copy of Microsoft
Windows/286 — version 2.1 of Windows, which
dates back to the late '80s and was designed for
80286-powered PCs. | keep it as a conversation
piece. The entire installation took a whopping
seven, low-density floppy disks, and only one
actually holds the operating system! (The other
six disks store applications, fonts, printer dri-
vers, and such.)

Over the years, Windows has inflated like a
Macy's Parade balloon on Thanksgiving Day.
Installing Windows XP Home will cost you at

least 1.5GB in hard drive space; if you choose
XP Professional, you need at least 2GB. (And
you can forget the floppies — Windows is only
available on CD-ROM now.)

Remember, however, that those figures don’t
include the extra hard drive territory that XP will
demand for things such as temporary files and
virtual memory, so it's best to add another
500MB (or even 1GB) to those totals. With
today's hard drives, a spare gigabyte of space
is easy to come by, so there’s no reason to feel
claustrophobic.

Shutting Things Down

A\

After you install Windows XP, starting (or, as techno-types continue to call
it, booting) your PC is as easy as pressing the power switch. Some diagnostic
and troubleshooting options are available during the startup process, but |
cover those in detail in Chapter 5 of this mini-book. For now, just remember
the power switch.

There’s more to consider, however, when you’re ready to shut down
Windows XP. In this section, I discuss the five methods that you can use
to shut down XP partially or completely.

Shutting down completely

The first option is the full deal: turning off your PC completely. Choose
Start =>Turn Off Computer, and XP displays the Turn Off Computer dialog
box that you see in Figure 1-1. Click the Turn Off button, and your PC will
(eventually) turn itself off.

Windows XP tries to be a friend by automatically closing any applications
that you're currently running before it shuts down. However, if a program has
an open document or file that hasn’t been saved, the application is supposed
to prompt you to save your changes first. Note that [ said supposed there:
Some misbehaving or badly written programs won’t prompt you before they

Book I
Chapter 1
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08 Shutting Things Down

Figure 1-1:
What'll
itbe —
shutdown,
restart, or
standby?

\\3

zap themselves out of existence, so don’t use the Turn Off or Restart options
unless you’ve manually saved all open documents (or you trust any applica-
tion that’s open, such as Microsoft Word).

Turn off computer

Stand By

Cancel

Restarting your PC

Restarting your PC comprises shutting down Windows XP and then immedi-
ately turning it back on again. (Restarting is also called rebooting.) To restart
your computer, choose Starte>Turn Off Computer; from the Turn Off
Computer dialog box that appears, click the Restart button. You don’t

need to actually press the power button to turn your PC back on again.
Dame Windows, she can do it all.

You might need to restart when you install new software or upgrade existing
software. (You'll typically see a dialog box that displays with a Restart
button.) I also recommend rebooting if your PC starts acting flaky — like
when error messages keep appearing, programs refuse to close, or strange
graphics appear on your desktop.

Using standby mode

Standby mode immediately puts your PC in a low-power mode: The monitor
goes black, and XP appears to shut down. However, you can return to your
work just as you left it by pressing one of the arrow keys on the keyboard
or moving the mouse. It’s rather like your monitor waking up from a screen-
saver snooze; it saves electricity and makes it easier to return to your work
“already in progress.” To go into standby mode, choose Start=>Turn Off
Computer; from the Turn Off Computer dialog box that appears, click the
Stand By button.
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Shutting Things Down 7 9

Not all PCs support standby mode. Check your PC or motherboard manual
to see whether you can use this feature. If you can use XP’s standby mode,
you can also set your PC’s power switch to activate standby mode rather
than turning off the computer. Or your PC can go into standby mode auto-
matically after a certain amount of inactivity. For more information, see
Chapter 6 in this mini-book.

Manually save your documents before putting your PC in standby mode
because putting your machine into standby mode does not save the files
that you're working with to your hard drive. You'll lose everything if your
PC is hit with a power failure, and you haven’t saved your documents.

Ves, your PC can hibernate

Hibernation is a variation of standby mode that’s popular with laptop
owners. It takes longer for your PC to switch to hibernation mode or to
return from hibernation, but that’s because a snapshot of XP (including all
open applications and files) is saved to your hard drive. Unlike standby
mode, a power failure while your PC is hibernating won’t result in lost files!

Like standby mode, your PC’s motherboard must support XP’s hibernation
mode. First enable hibernation mode: Open the Windows XP Control Panel,
choose Power Options, click the Hibernate tab in the dialog box that appears,
and then mark the Enable Hibernation Support check box. Click OK to save
your changes. When you want to put your machine in hibernation mode,
choose Start>Turn Off Computer; then click the Hibernate button in the
Turn Off Computer dialog box that appears. (You can also set your PC to
automatically hibernate when a certain period of inactivity has passed, and
most laptops can be set to hibernate automatically when you close them.)

Logging off

Your final choice when leaving your PC is to log off. This leaves your PC
running, but others can log on to the PC if they enter a valid username and
password. Like a true shutdown, logging off an XP machine automatically
closes most applications and any open documents.

Windows XP keeps track of each different user’s account data and docu-
ments, so you can be assured that everything that you don’t want seen by
others remains private. Yet, if you want to share a document with other
users on your system, you can make use of shared folders that allow others
to open and edit your files. I go over multiuser operation in Chapters 4 and 6
of this mini-book, so don’t worry . . . all will become clear there.

Book II
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70 Vour Windows XP Controls

To pass the computing torch to someone else, choose Starte>Log Off to dis-
play the Log Off dialog box and then click Log Off again.

Your Windows XP Controls

After you become an expert in starting and shutting down your PC, survey
the landscape of Windows XP. Here | show you what the various graphical
WUDs (short for Wondrous User Devices) represented on your desktop and
how you can use them to exercise your will within.

Icons

The first stop on your journey is the lowly icon . . . often jeered and often
the target of a string of impassioned and unprintable words. Yet, icons are
still the building blocks of today’s graphic user interfaces (GUIs; that’s a
10-cent synonym for operating systems such as Windows, Mac OS X, and
Linux, which all use a mouse). Believe me, icons will be around long after
you and I are no longer worried about PCs.

Icons look like a picture, and that’s no accident because they are simple rep-
resentations of different locations and items on your computer. For exam-
ple, Windows XP displays different types of icons to represent things such
as the following:

4+ Files and folders

4 Programs that you can run

4 Hardware such as hard drives, CD/DVD drives, and printers

4+ Internet connections

4 Other computers on your home or office network
Figure 1-2 shows a gaggle of different types of icons in their natural environ-
ment. I go into much more detail about what you can do with icons in the
next two chapters of this mini-book. For now, just remember their versatility

and that they represent something else on your system besides a thumbnail-
sized picture.

That constantly changing cursor

Within Windows XP, your mouse cursor is more than just a focus for your
clicking finger — although that is its main use. When it’s not pointing the
way (depending on the desktop action that you're performing or the appli-
cation that you’re running), your cursor can also
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4 Show status: Indicate that your PC is busy doing something, such as
loading a file or applying your last command.
4+ Show selection: Specify the text or graphics that you want to select (in
order to do something nefarious, I'm sure).
4 Show location: Indicate a position in a document where you can move.
4+ Show file movement: Show that you're copying or moving files between
locations on your system.
") By the way, you can also click your right mouse button (right-click) when

your mouse cursor is resting atop something to display a pop-up menu that
includes commands that are specific to the item that you’'re hovering over.
(To techno-nerds, the term for this pop-up is a contextual menu. Geez.) For
example, if you right-click a digital photograph that you've saved to your
hard drive, you can choose to preview it, edit it, or print it. Personally, 'm a
big fan of contextual menus because they usually contain everything that
applies to a particular file. Some programs, such as Paint Shop Pro, actually
add their own commands to the contextual menu.

Book II
Chapter 1

dX SMOpUIpg
yum spuey axeys



72 Vour Windows XP Controls

If you encounter a strange cursor shape or animation within a program that
you’re running, you can usually refer to the program’s manual to determine
what the heck your little friend is trying to tell you.

For even more interesting things that you can do with your mouse cursor,
check out Chapter 6 of this mini-book.

The Start menu

Another familiar face that you'll see often in Windows XP is the Start menu,
as shown in Figure 1-3. Someone at Microsoft should get a steak dinner for
this one. The name actually fits the purpose because you can start virtually
every activity and task that your PC can perform from this one menu.
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To use the Start menu, move your mouse cursor to the bottom of your desk-
top until the Start button appears at the lower-left corner. Click the Start
button to display the Start menu, move your cursor to the desired icon or
command, and then click.
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Highlights of the Start menu include

4 The All Programs pop-up menu, where you can choose to run any
program that you've installed on your PC.

4+ The Recent Applications list on the left, which makes it easy to run
a program that you've used . .. well . . . recently.

4+ The My Documents menu, where you can load all sorts of documents
that you've created yourself or saved to your hard drive (such as
photos, videos, and music).

4 The Control Panel, where you configure Windows XP to your
preferences. (Chapter 6 of this mini-book centers on the Control
Panel.)

4 The Search command, which can help you track down specific files,
folders, or locations within your system.

4 The Run command, which allows you to run a program by actually
(gasp!) typing its name.

<+

Access to your system printers and fax/modem.

4 Access to your network locations, such as your Internet connection
and any home or office network that your PC can use.

[ discuss all these controls in later chapters of this mini-book — but you’'ve
got to admit that it’s really sassy to have all of ’em together in one place!
(Note, however, that your Start menu will look different from mine because
I customized mine to fit the way that [ work, and I've also been running my
own set of programs.)

The taskbar

The next stop on the XP Express — no pun intended, but I'll take it, anyway —
is the taskbar, which is that little strip of buttons and miniature icons that
runs along the bottom of the screen. Like the Start menu, the taskbar is
another great control that you can use to accomplish all sorts of things, and

it remains out of sight until you need it. (Depending on the settings that you
choose for your taskbar, it might remain hidden until you move your mouse
cursor to the bottom of the screen, see Figure 1-4.) [ talk more about configur-
ing the taskbar in Chapter 3 of this mini-book.

Book II
Chapter 1

dX Smopuipy
yum spuey axeys



74 Your Windows XP Controls

Figure 1-4:
The taskbar
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Q‘&N\BEH Don’t worry if your taskbar doesn’t look like mine in the figure. The appear-
& ance of the taskbar varies according to the programs that you’re running
and the custom controls that you've added to it. In other words, the taskbar
is another of those controls that quickly becomes personalized to your
needs, depending on the programs that you install and the programs that
are currently running. The taskbar allows you to

4+ Switch quickly between applications that are running.

4 Run the programs that you specify with a single mouse click.

4+ Control background programs that normally run hidden, such as
Norton AntiVirus.

<+

Control hardware such as your printer and modem.

4 Connect and disconnect Universal Serial Bus (USB) and FireWire
peripherals such as a digital camera and an external DVD recorder.
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4 View the time and date.

4 Access the Start menu.

You'll find the full scoop on the taskbar in Chapter 3 of this mini-book.

Menus and toolbars

Here’s one more set of Windows XP common controls, which are found in
just about any program that you run because they’re part of Microsoft’s
grand user interface design standard. (Thus making all Windows programs
easier to understand and use, often without the need to refer to that ridicu-
lous Web-based user manual.) Both of these common controls — menus and
toolbars — are shown in the multipurpose Figure 1-5.
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The miracle of menus

Menus are the drop-down secret to life itself. Each menu contains either a
group of similar commands or a group of commands that fall under the
same category. To use a menu, you can either

4 Go mousing: Click the menu name and then click the command from
the list that appears.

4+ Go digital: Hold down the Alt key, press the underlined letter in the
menu name (a hot key), use your cursor keys to choose a command,
and then press Enter to use it.
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Using Bill’s Funky Keys

For example, to open a file in virtually any Windows application, click the
File menu at the top of the window and then click Open from the drop-down
list that appears. Alternatively, while holding down the Alt key, press F (the
hot key for the File menu) and then press O (the hot key for the Open
menu).

Those tremendous toolbars

A toolbar is a collection of buttons that allows you to use the most common
menu commands in a program with a single click. Typically, toolbars appear
at the top of a program window, but many applications (such as Adobe
Photoshop, for example) either have floating toolbars that exist as separate
windows or have toolbars that can be resized and relocated anywhere in the
application window. Some applications will let you go even further. For
example, the toolbars in Microsoft Word can be customized with buttons

for the menu commands that you use the most.

To illustrate how easy it is to use a toolbar, consider opening a file. If the
application that you’re using has a File Open button on the toolbar, click it.
End of story. (The moral is: Toolbars rule!)

To display the name of a toolbar (which is usually all you need to identify it
or to jog your memory), leave your mouse pointer motionless on top of the
toolbar button for a moment or two. Such motionless conduct is called hov-
ering among techno-types.

Using Bill’s Funky Keys

Not all Windows-specific controls are meant for your mouse. Thanks to the
Power of Bill, today’s PC keyboards come complete with additional keys
that are tied directly to Windows, so you can use your keyboard for naviga-
tion instead of your mouse. As any PC power user will tell you, the mouse
that can move faster and more efficiently than your fingertips hasn’t been
(and likely never will be) invented. Just wait until Bill gets those new letters
that he wants in the alphabet!

Most of the keys on your computer keyboard work like they do on standard
typewriters. For instance, pressing Shift in combination with another alpha-
betic key still creates a capital letter. PC keyboards, however, also sport
nifty special keys for navigation, functions, and (sometimes) Windows-
specific commands. For your reference, Figure 1-6 illustrates a typical
modern 104-key PC keyboard.
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The Windows keys

Ah, the Windows keys — they rests snugly between the Alt and Ctrl keys on
both sides of the spacebar on your keyboard. You can press either of these
keys at any time to display the Start menu. Additionally, a number of other
keys can be used in combination with a Windows key. Just hold a Windows
(Win) key down and try one of the keys listed in Table 1-1.
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Table 1-1 Windows Key Combinations

Sequence Action

Win+D Displays the Windows desktop (even with other programs running)

Win+E Runs Windows Explorer, where you can manage your files

Win+F Opens the Search/Find Files dialog box from which you can locate a
file or folder

Win+R Opens the Run dialog box from which you can run a program by

typing its name

The Shortcut key

Remember how enamored [ am of contextual menus? A quick poke at the
Shortcut key — which is located on the right side of the keyboard between
the Windows and Ctrl keys — will act as a right-click (displays a contextual
menu) when you’ve selected an icon anywhere in Windows. After the pop-up
menu appears, you can use your cursor keys and the Enter key to choose a
command.
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Other PC-specific keys

These old friends have been around since the days of Genghis Khan — or at
least the beginnings of the IBM PC, whichever came first. Anyway, these
keys still come in quite handy in the Windows world.

4+ Enter: PC keyboards have two of these beauties: one above the Shift key
on the right side of the alphabetic keys and the other at the lower-right
of the numeric keypad. Within your word processor, of course, pressing
Enter creates a new paragraph. But elsewhere within Windows, pressing
Enter almost always starts a command or selects an item. (A friend of
mine still calls this the Submit key. He’s great fun at parties.)

4+ Escape (Esc): Press Esc (far upper-left on your keyboard), and you're
jetted off to your favorite vacation spot with a ton of cash to spend and
your favorite movie star. (No, not really — although Bill is rumored to
be working on the new enhanced Escape key.) Actually, you use Esc to
back out of things. Pressing Esc can cancel many commands, close
some windows, and exit dialog boxes.

4+ Num Lock: Press this key (upper-left of the numeric keypad) to toggle
those keys between the numbers (great for spreadsheets and data
entry) and navigational keys (note the cursor arrow symbols on the
2,4, 6, and 8 keys).

4 Control (Ctrl) keys: These two keys (either side of the spacebar) are
used in conjunction with other keys for editing and keyboard com-
mands within many applications. For example, pressing the combina-
tion Ctrl+B within Microsoft Word makes selected text bold.

4+ Function keys: These 12 sentinels across the top of your keyboard are
used for different purposes throughout Windows — and in many cases,
even within specific applications (hence the generic name). They’re usu-
ally abbreviated as FI through Fi12.

Other keys on your keyboard will also have specific uses within every appli-
cation. To become a power user of a certain application, consult that pro-
gram’s Help system for the special keystrokes that it uses. You'll zip through
documents while others plod along!

Using the Windows XP Help System

Speaking of help, I'm happy to say that Windows XP comes with the best
Help system that’s ever shipped with any version of Windows. It even has
online components that you can refer to for the latest information on
features (and the occasional bug). With the Help system, you can



Using the Windows XP Help System 79

4 Locate specific help on nearly any topic.

4+ Follow task tutorials that guide you step by step through all sorts of
procedures (such as printing, troubleshooting, and updating Windows
with the latest patches).

4 Search the Microsoft Windows XP newsgroups (with an Internet
connection).

<+

Scan tips and tricks from Windows experts (with an Internet connection).

4 View the latest headlines on new XP features (with an Internet
connection).

Book Il
Displaying Help Chapter 1

The two methods of displaying Help within Windows itself are

4 Press F1 while on your desktop. Click anywhere on your desktop and
then press the F1 key to load the top-level Windows Help system
window that you see in Figure 1-7. (Check out that spiffy toolbar at the
top of that window!) Nete: If you're currently using a program, pressing
F1 will display the Help system for that program.
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Figure 1-8:
The results
of a typical
search
through the
Help
system.

4 Click Help from the Start menu. This is yet another neat function of the
Start menu.

Searching for specific help

After the XP Help window is displayed, feel free to click any of the links (the
bolded words) to display the corresponding topic. However, you’ll usually
visit the Help system to search for specific help on a Windows feature or
command. To search for a word or phrase within Help, follow these steps:

1. Click within the Search box at the top of the Help window.

2. Type the word or phrase that you want to search for and then press
Enter.

The fewer words that you enter, the better the chance of getting a
match that will address your topic.

The Help system hums happily to itself for a few seconds and then dis-
plays the results page that you see in Figure 1-8. (I searched for the
phrase burning a cd in this example.)

@ Help and Support Center

Browse the search results

Fiol:lnd Saarch NSNS (1 nesuRy)
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Figure 1-9:
Your search
can provide
you with a
step-by-step
Help topic.

Using the Windows XP Help System

3. To display the information in a topic, click the topic name (found in

the Search Results area).

Windows displays the information in a separate pane, as shown in
Figure 1-9, with all occurrences of your word or phrase highlighted so

that they’re easier to spot.

Some steps have links (look for underlined text), which you can click to

open the dialog box or window in question or run the program men-

tioned in the Help text. (This really makes it easy to fix something, espe-

cially when you don’t quite know where that one particular setting is

within the XP behemoth.)

To move backward through Help topics to where you started, click the Back
button on the toolbar at the top left of the Help window.
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Some search results will return technical articles — consider them Tips for
Techno-nerds — that relate to the topic that you've found. Technical articles
can include bug fixes, workarounds, or just explanations of what precisely
is happening when you use a Windows feature. To display the technical arti-
cles for a topic, click the Microsoft Knowledge Base divider bar that appears
in the Search Results pane.

Velling for assistance

If you can’t find what you’re looking for within the Help system, you can
turn to Microsoft for direct support. From the top-level Help menu (refer to
Figure 1-7), click the Get Support link (under the Ask for Assistance heading)
to display the Support window that you see in Figure 1-10. (You can also
click the Support button in the toolbar.)

vg\\x\NG! Unless you have a very knowledgeable friend who has already mastered the
S Remote Assistance feature of Windows XP, I strongly urge you to avoid using
the Ask a Friend for Help option. This involves your friend connecting to
your PC over the Internet and gaining control of XP . . . with all the possible
nastiness that entails. Personally, I recommend that you turn to Microsoft
support instead.

@ Help and Support Center

Welcome to Support

G0 10 a Windows Web sile frum

Figure 1-10:
Go to the
top for
support.
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In the Support window, click the Get Help from Microsoft link — you’ll need
an Internet connection, of course, like any undertaking in the civilized world
these days — and then click the Ask a Microsoft Support Professional link
for help. Note that you’ll have to set up a Passport account, if you haven’t
already, but this is a free service and actually comes in handy when you’re
using instant messaging and surfing the Web. You can choose from no-
charge assistance (where you’ll need to provide a Microsoft Product ID
number) or general assistance (currently $35 per incident). Depending on
the option that you choose, you might get a Web-based e-mail form or a real-
time chat with a support representative.

If you lost your Internet connection or you don’t have an e-mail address, nat-
urally, you can also contact Microsoft for support by telephone. . . . at least
for now. (Insert ominous chord here.) If you opt for phone support, you’ll
get two incident reports and installation support for free (not including the
cost of the toll call), but after that, Microsoft will charge you $35 for each
successive incident.

Book II
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Chapter 2: The Many
Windows of Windows

In This Chapter

» Managing windows

+ Recognizing icons
1~ Selecting one (or many) icons

v+ Using toolbars in Windows XP

Doing things graphically is what Windows XP is all about. The idea of
visual control is at the heart of today’s graphic user interfaces (GUIs),
like Windows and Mac OS X (and Linux, when it’s wearing the right
makeup).

In this chapter, I introduce you to the graphical building blocks of Windows
XP. Plus, I show you the “antique” keyboard combinations that are even
faster than a speeding mouse. (Hey, any power user will tell you that
pressing a sequence of two or three keys is often faster than clicking!)

Managing Windows Means Productivity

3

What’s that on the horizon? Oh boy, it looks like another of those weighty
Mark’s Maxims:

Learn the Zen of the window and become a power user."

In this section, you do just that — and your efficiency and speed in XP will
amaze your friends and family. (And that’s what it’s all really about, right?)

Windows XP has a helpful feature that displays a short pop-up description
of the controls in a window. If this book isn’t handy, you can find out the
function of a button or widget by leaving your mouse pointer sitting motion-
less on top of the control in question. (Interesting trivia fact: This mouse
action is hovering.)
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Opening and closing windows

You rarely need to manually open a new window in XP, which is a trademark
of good design from the Redmond troop. XP will automatically open a
window when you

4+ Run Explorer (as shown in Figure 2-1). Just double-click the My
Computer icon on your desktop.

4+ Run most Windows applications. Some programs, however, run in the
background or don’t automatically create new document windows.

4 Create a new document in a Windows application.

® By default, the left portion of the Explorer window contains common tasks
and locations within XP. Personally, I prefer the older-style navigation tree
that you see in Figure 2-2, which dates back to previous versions of
Windows. To display this view, click the Folders button in the toolbar at the
top of the window . . . more on toolbars later in this chapter.

The Close button

¢ My Computer =2k
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Hard Disk Drives

Systom Tasks
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Figure 2-1:
The most
common XP
window is
the Explorer
window.




Figure 2-2:
You can
navigate
through the
Explorer
window
quickly with
the Folders
view.
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You will, however, need to close windows often to keep your desktop tidy
and to free up system resources for other things. To close a window, move
your mouse pointer over the Close button — the red button with an X at the
top-right corner of the window, as shown in Figure 2-1 — and then click the
left mouse button. Alternatively, you can usually choose File>Close from the
window’s menu.

“But what if I have an open document in a window?” There’s a safety net in
place within any well-behaved Windows application (such as Word or
Photoshop, for example): The program will first ask you for confirmation
before it closes a window containing an unsaved document.

Scrolling window's

Suppose that you're reading page one of a six-page document, and you
decide to jump ahead to page five — unfortunately, page five is nowhere in
view. (In the same vein, you could be using Explorer to navigate a hard drive
with dozens of folders, and the folder that you want is farther down within
that gaggle of folders.) How do you get to the item or the information that
you want to see?

Book II
Chapter 2
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That’s the job of those unsung heroes, your scroll bars (as shown in Figure
2-3). To move through the contents of the window, just click in the area
above or below the scroll button or click the up and down buttons at the top
and bottom of the scroll bar. (Note: If your document is wider than the appli-
cation window, you'll get a horizontal scroll bar as well. It works the same
way, just moving the contents of the window to the left or to the right.)

To really move like the wind within a window (bad pun that [ won’t repeat),
you can even click the scroll button and drag it. When you drag something,
you first click it — in this case, the scroll button — and then hold down the
mouse button while you move the mouse in the desired direction. You’ll find
more uses for dragging later in this chapter.

Up and down buttons

Scroll button
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Figure 2-4:
The window
control
buttons are
old friends
of any
power user.
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Many applications allow you to scroll through the contents of a window
with your keyboard arrow (navigation) keys. And pressing the Page Up and
Page Down keys should move you an entire page at a time through the con-
tents of a window.

Minimizing and restoring windows

Sometimes you want to keep a window open, but you don’t want it on your
desktop. For example, you might be checking a Web site in Internet Explorer,
and you need to copy a picture into a Word document. How do you get the
Internet Explorer window out of your way temporarily without closing it?
This is a job for the Minimize button, as shown in Figure 2-4.

Minimizing a window hides it. Well, more accurately, the window is stored as
a button in your taskbar at the bottom of the screen. To return the window
to its original glory, simply click the button in the taskbar. If you have a large
number of windows open, the taskbar might sprout its own set of scroll but-
tons so that you can actually scroll through the minimized windows within
the taskbar.

Maximize button

Minimize button
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The XP taskbar also uses another trick if you have a large number of windows
open. Separate windows within a single application are grouped together as a
single taskbar button, but a number appears on the button label to indicate
that multiple windows are minimized from that program. You can click and
hold — place the mouse pointer atop the taskbar button and then press and
hold the mouse button — to display a pop-up menu of the different windows,
and then you can select the right window from the menu.

“So does a program continue to run when it’s minimized?” Good question.
Most do, but some applications will pause when minimized (such as games
or video players) and then restart when the window returns to the desktop.

Maximizing and restoring windows

If you've already guessed that maximizing a window is the opposite of mini-
mizing it, pour yourself another soda as a reward! Maximizing a window
expands it to fill the entire screen, giving you plenty of elbow room to work
with. In fact, applications such as Microsoft Word will take advantage of a
maximized window by displaying as much of your document as possible,
using automatic word wrap.

If the window isn’t maximized, click the Maximize button once — it’s the
middle button in the group at the upper right, as shown in Figure 2-4. After
the window expands, the multitalented Maximize button turns into the
Restore button. When you click the Restore button, the window returns to
the original dimensions that it had before you clicked the Maximize button,
and that doggone button morphs back into the Maximize button again.
(“Ethel, make it stop!”)

Moving window's

When you need to move a window from one area of your desktop to another,
Windows XP is there for you. On a typical day, | end up juggling multiple
windows like the world’s worst circus clown. (Alternatively, you can buy a
larger monitor. Yeah, right.)

To move a window to another piece of desktop real estate, click and drag
the window’s title bar — that colored strip at the top of the window that dis-
plays the application or document name — and the entire window will
follow. When the window is in the right place, release the mouse button to
drop it.

To arrange multiple document windows within an application, choose
Windowr>Arrange All, and the document windows line up in an orderly
fashion so that you can choose one.



Figure 2-5:
The active
window is
the belle of
the XP ball.
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Resizing window's

A window can be resized to different dimensions as necessary — sorry, no
triangles, though. Simply move your mouse pointer over the lower-right
corner of the window or to one of the sides of the window until the mouse
cursor changes to an arrow icon. Then click and drag to move that window
in the indicated direction.

Switching window's

Although you can easily open 10 or 15 windows within your XP desktop,
keep in mind that only one window is actually active at once. And the active
window takes precedence, appearing on top of other windows, because it’s
the window that you're currently viewing, editing, or using. Windows that
are currently open on your desktop — and not minimized — are inactive
windows. They’re dimmed (or shaded) to indicate that they’re currently
offline. (Note, however, that you can still copy or move files to an inactive
window, which I demonstrate in the next chapter of this mini-book.) You can
see both the active and several inactive windows in Figure 2-5; in this case,
Internet Explorer owns the lucky active window.
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A Field Guide to Icons

To switch to a different window, you can

4 Click anywhere within the desired inactive window.

4 Move your mouse to the taskbar and click the desired application or
window button.

4 Cycle through the open applications by holding down the Alt key and
repeatedly pressing Tab until the window that you want becomes active.

Note that you can still use a window’s Minimize, Maximize/Restore, and
Close buttons even when it’s inactive. Also, an application might continue to
run while its window is inactive.

A Field Guide to Icons

Here I begin my discussion of icons with a classic Greek comedy. (Those
readers familiar with my books will already know about my propensity for
vignettes.)

XP and The Iliad
(with apologies to Homer)

As the play opens, Hector is tussling with his new installation of XP. He’s
knee deep in an Explorer window that’s filled to the brim with icons.

Hector: “I want to run Microsoft Word! Which of these furshlugginer
little pictures stands for the program, and which of these are my docu-
ments? What do I double-click? Help!”

[Enter proud Odysseus, hero of the Trojan War and experienced XP power
usetr. ]

Odysseus: “Do not panic, good Hector. You see, Microsoft Word has its
own program icon, and each Word document that you create uses the
Word document icon. The same is true for everything from Excel to
Adobe Acrobat.”

Hector: “So how do I learn which is which?”

Odysseus: “Read the manual that you got with the application or open
an Explorer window and look in the folder where you saved a document
from the application. Each software developer creates a unique program
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and document icon combination, but most of them are pretty self
explanatory.”

Hector: “Or I could eschew icons completely by running Word from the
Start menu, and then I can load the document that I want from Word'’s
File menu, right?”

Odysseus: “That’s right, or you can even double-click the document
icon itself within that Explorer window, and it will automatically load
Word with that document.”

Hector: “Hey, bud, that’s in the next chapter. And where’s that Trojan
horse that I lent you?”

Odysseus: “Whoops . . . busted again. I'm out of here!”
Fin

In this section, I help Hector (and you) out by identifying each type of icon
and showing some common examples.

Don’t be afraid to right-click an icon to see its properties. Just put your mouse
pointer over the icon in question and press the right mouse button once,
which displays a pop-up contextual menu. Click Properties, and you can see
what application created a document — or, as XP calls it, opens with — as well
as other nifty stuff that I discuss at several points in later parts of this book.

Hardware icons

Only a select few hardware devices have their own icons in XP, but you'll be
surprised at what does, including rather nebulous things such as network
and Internet connections. These hardware icons tend to hang out on your
desktop or in a top-level Explorer window.

Here’s a representative list of hardware that’s represented by XP as icons,
many of which are shown in Figure 2-6:
4+ Hard drives
4 CD and DVD-ROM drives
4 Printers
4+ Removable storage such as floppy drives, Zip drives, and portable
Universal Serial Bus (USB) flash drives

External devices such as MP3 players and digital cameras

<+
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Figure 2-6:
A well-
ordered
passel of
hardware
icons.
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In general, you can open, activate, or control a hardware device by double-
clicking its icon (depending on what type of hardware device it is). Find
more on this in appropriate spots later in this book.

Program icons

Because you already know about program icons (thanks to Hector and
Odysseus),  won’t go into much detail here. Double-clicking a program icon
runs the application from an Explorer window or your desktop, and a single
click will suffice from the Start menu.

Figure 2-7 illustrates a number of well-known program icons.

File icons

Technically, document icons are actually a subspecies of file icons, which
can represent any type of data file on the planet. Windows XP actually has a
couple of generic icons that it uses to represent files that it doesn’t recog-
nize, so every file on your system — and [ mean every file — can be repre-
sented by some kind of an icon.
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Like a document icon, XP will attempt to open any data file that you double-
click. If XP knows the application that created the file, the program runs
automatically to display the file. On the other hand, if XP doesn’t recognize
the file type, you get a dialog box that looks like Figure 2-8, where you can
choose to
4+ Instruct Windows XP to look for an updated file type list by using the
Web service (which requires an Internet connection).
4 Select the program (from a list) that you want to use to load the file.
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Figure 2-9 parades a selection of common file icons.

[ Mark's Example Folder =30
Fie Eda View Fomston Tosls Help i
0 Bk = ) '? g Sewch Fdldars T -

o i e D n ample Ralider - ﬂ Go

Vibe arvd Fobdes §aike

Feani Tt s - & Ssingin” A ar
08 « Mgt aafedd Dy

-—L“-L‘
gl

Figure 2-9:

File icons e 2\ COundVORD T0C

thatyou =

might meet \ ®

in Windows 5

XP.
Folder icon
Folders use the same icon, as shown in Figure 2-10. And as you already
know, a folder holds (and organizes) other items, which can include both
icons and subfolders.
Shortcut icons
Shortcuts are represented by unique icons. Although they look much like a
regular icon, a thorough examination will reveal a curved arrow at the
bottom of the image. (The phrase Shortcut to might also appear at the
beginning of the icon label.)

“&N\BER Think of a shortcut as a signpost or a link to another item within your XP

& system. For instance, you can set up a shortcut to Norton Disk Doctor that

will run the program just as if you had clicked directly on the program icon
in the Start menu or had double-clicked the program icon in the Explorer
window.



Figure 2-10:
The unsung
hero — the
common

foldericon.
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However, because shortcuts only take up a few bytes of hard drive real
estate, they come in handy when you’re customizing your desktop or organ-
izing a folder. This allows you to set up a program to be run from any folder
(without requiring that you dig down with Explorer). Too, a shortcut can be
easily tossed into the Recycle Bin after you're finished with it because it’s
actually not a part of the original application.

In fact, many games and applications now offer to add a shortcut to your
desktop during installation, and I usually take ’em up on the offer. A desktop
shortcut is very convenient, and the software developer knows that you can
delete it quickly and easily if necessary. You can also move a shortcut to the
taskbar, which I cover later in this mini-book.

Because a shortcut is only a link to a program (or folder, or even a hardware
device), you can create multiple copies for different locations in your
system and still not waste a tremendous amount of hard drive territory. (A
friend of mine always creates a folder on his desktop with shortcuts to all
the documents and files relating to his latest project. That way, he can
immediately work on anything relating to that project and just delete the
folder with the shortcuts after the job is done.)

Never try to simply copy or move an application that you’ve installed in
XP from one folder to another. Not only is the application not likely to
work (because it can’t find any of its support files), but you also won’t be
able to use the Add and Remove Programs feature to uninstall the applica-
tion later! (More on uninstalling software the right way later in the book.)
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Figure 2-11:
Shortcut
icons are a
great way to
organize
your stuff.

Instead, create a shortcut — which I demonstrate in Chapter 4 of this
mini-book — and move that shortcut to the desired location.

Figure 2-11 shows off a number of shortcut icons, along with their original
source icons.
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System icons

The final type of icons represents a system function or a system location
in Windows XP, such as My Computer, the Recycle Bin, or My Documents.
Most of these important icons can’t be moved or relocated — XP wants
them left where they are, thank you very much — but you can use them or
right-click them to display a context-sensitive pop-up menu. For example,
right-clicking the Recycle Bin displays a menu with a number of choices
that directly apply to deleted files.

[ discuss these icons and what they represent in various spots throughout
the book (especially in Chapter 4 of this mini-book).
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Figure 2-12:
One
selected
icon within
a window.

After you become familiar with icons, you might be wondering how you can
manipulate them. I go into more detail in the next two chapters of this mini-
book, but for now, you need to know how to select one or more icons: that
is, how to highlight the icon(s) that you want to use when performing the
next action (such as copying, moving, or deleting the selected icons).

I should note at this point that XP offers different ways to view the contents
of a folder, which I discuss later in this mini-book. For example, you can dis-
play icons in a list format as well. The methods of selecting icons, however,
do not change.

Selecting a single icon

To select a single icon, click it once — you’ll notice that XP has highlighted
it to indicate that it has been selected. Figure 2-12 shows a highlighted single
icon in a window, along with other icons for comparison.

A selected icon
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Figure 2-13:
Drag a box
around
multiple
contiguous
icons to
select them
all.

Selecting multiple contiguous icons by dragging

To select a group of icons that are next to each other, click your mouse in a
part of the window above and to the left of the first icon, and then drag the
mouse down to a spot below and to the right of the last icon that you want
to select. Figure 2-13 illustrates the selection box that Windows XP draws;
any icons within the box are selected and highlighted.

Selecting multiple contiguous icons by clicking
Another method of selecting a group of contiguous icons is to select the first
icon in the group by clicking it, holding down the Shift key, and then clicking
the last icon that you want to select. This method is especially handy when
viewing files in list mode, as you see in Figure 2-14.

Selecting multiple separated icons by clicking

Whoops, Figure 2-15 shows a number of selected icons that aren’t contigu-
ous. How do you select them? In this case, click the first icon that you want
to select, hold down the Ctrl key — don’t stop holding it down — and then
click each additional icon that you want to select. After you select every-
thing that you need, release the Ctrl key.
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Figure 2-14:
Selecticons
in list view
with the
mouse and
keyboard.

Figure 2-15:
Selecticons
thatare in
different
neighbor-
hoods.
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To deselect an icon that you pick by mistake, click it again. Remember:
You must continue holding down the Ctrl key until you've finished selecting

what you want.
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Using the Toolbar

Figure 2-16:
Man, dig
those crazy
toolbars!

The final stop in the graphical Windows world — at least in this chapter —
is the toolbar. Most Windows applications now use toolbars; you can see in
Figure 2-1 that the Explorer window has its own toolbar. Each button typi-
cally replicates one of the application’s popular menu commands and per-
forms the same function as if you had selected the menu command.

If you already know how to click a button in Windows, you know how to use
a toolbar: Just move your mouse pointer on top of the desired button and
click the left button once. Whoosh!

However, not all toolbars are stuck at the top of a window. For example,
check out Figure 2-16, which illustrates a favorite image editing application
of mine: Paint Shop Pro. Note that this application has toolbars across the
top and both sides of the screen, along with — gasp! — floating toolbars
that you can click and drag to wherever you like!
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Where am I going with this? Well, 'm suggesting that you read the manual
for an application thoroughly because often you'll find that you can cus-
tomize that application’s toolbars with just the commands that you want.
Why take up valuable space on that toolbar with a Print button if you don’t
have a printer? [ show you how to customize toolbars in several spots
throughout the book, but for now, just enjoy using toolbars because they
can save you all kinds of time.
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Chapter 3: Windows XP Basics

In This Chapter

v~ Starting an application

v~ Exiting an application

v Moving, copying, and deleting items

»” Creating new folders and renaming items

+ Recovering valuable stuff from the Recycle Bin
1 Using and configuring the Start menu

+* Working with printers

v+ Using and configuring the taskbar

v Terminating a misbehaving program

B oot camp is over — now it’s time to discover some of the more
advanced tasks within Windows XP.

For example, no PC owner can ever hope to become a power user without
becoming good friends with both the Windows XP Start menu and the XP
taskbar. You need to know how to run programs, whether they’ve been
installed and appear on the Start menu, or whether you have to track 'em
down and run them from your hard drive or CD-ROM drive.

Files and folders need to be copied, moved, or removed; deleted files need
to be permanently erased (or recovered, in case of an accident); and new
folders need to be created while you're using your PC. You might need to
change printer settings, shut down a program that’s no longer responding,
or locate another computer on your local network with the shared file that
you have to copy to your hard drive. All these tasks are basic, yet a surpris-
ing number of PC owners are in the dark about these basics — they still
know only one way to exit a program, or they aren’t aware that you can
change the characteristics of a printer by just right-clicking it and choosing
Printer Preferences!

That’s what this chapter is all about — delving into the different methods of
taking care of basic tasks within Windows XP. Here you find how to handle
all these tasks and more!
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[ even show you how to format a floppy disk — because of contractual
obligations.

Running Applications from the Start Menu

Figure 3-1:
The Start
menu and
taskbar —
truly a
Dynamic
Duo.

First things first: XP becomes a lonely place indeed if you can’t run any
applications. To run a program from the Start menu, follow these steps:

1. Move your mouse pointer to the bottom-left of the screen and click
the Start button on the taskbar.

Or, if you have a keyboard with Windows keys, press one of them to dis-
play the Start menu. (Your keyboard probably has two of these critters.
Just look on either side of the Alt keys, which are on either side of the
spacebar. The Windows keys look like the fluttering Windows flag.)

Figure 3-1 illustrates the Start menu and taskbar. Any applications that
you've recently used will probably appear in the Recent Applications
list on the left side of the Start menu.
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To run a recently used application again, click the application name,
and dance around the room because you were able to do things The
Convenient Way.

If the program doesn’t appear on the Recent Applications list, click
All Programs.

Whomp! XP displays all the applications that you’'ve installed on your
PC in a cascading (another term for “rather hard to manage sometimes”)
list. Program groups (think of them as subfolders) are displayed as
menu items with arrows at the end of their names, whereas individual
applications are stuck at the end.

If you've recently installed a number of programs, they might appear
loitering at the end of the All Programs menu. You can arrange every-
thing in alphabetized order again by right-clicking anywhere in the All
Programs menu and then choosing Sort by Name from the pop-up menu
that appears.

Move your mouse pointer carefully to the program group that
contains the application you want to run — it will display yet another
pop-up menu.

Sooner or later, you're going to track down the doggone program that

you want, so be patient. (I've actually seen program groups that have

two or three subfolders!) If the program appears by itself at the end of
the All Programs menu, you can rejoice.

Click the application name to run it.

Many software developers include supplementary programs with the actual
application, like utilities, game editors, and the like. That’s nice of them —
but unfortunately, those additional application icons can get kind of confus-
ing, so make sure that you're clicking the Real Deal to avoid embarrassment
(and the hassle of exiting a program that you didn’t want to run in the first
place).

Running Applications from Your Hard Drive

Often you’ll want to run a program from the forested undergrowth that is
your hard drive. Perhaps you’'ve downloaded a program from the Web, or
you’re running a shareware application that doesn’t install itself in the All
Programs menu. Follow these steps:

1.

Double-click the My Computer icon on your desktop to open the
Explorer window (behold it in Figure 3-2).
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2. Double-click the hard drive that contains the program that you want
to run.

If necessary, continue clicking folders and subfolders until you see the
desired application. This, good reader, is navigating, and I do a lot of
navigating in this book!

3. Double-click the application icon to run it.

Running Applications from a CD-ROM or DUD-ROM

By default, Windows XP loves to be helpful. So usually when you load an
application’s CD-ROM into your drive to install the program, XP automati-
cally runs the installation program for you. However, from time to time, you
might need to venture onto Planet Optical and run a program directly from a
CD-ROM or DVD-ROM. Follow these steps:

1. Press the button on your CD-ROM/DVD-ROM drive to eject the tray;
load the disc (shiny side down) and press the button again to retract
the tray.

If the application’s installation menu appears, just click the Close button
or click Exit/Quit to shoo it away.
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2. Double-click the My Computer icon on your desktop to open the
Explorer window.

3. Double-click the CD-ROM or DVD-ROM drive that contains the desired
application.

If necessary, navigate to the location of the program by double-clicking
any folders and subfolders. (See? I told you that you’ll be navigating XP
all the time!)

4. Double-click the application icon to run it.

Exiting a Program

Figure 3-3:
Word won't
allow you to
exit without
considering
open files.

After you perform whatever magic you need within an application, I recom-
mend exiting the program. Of course, you can leave it running, like a Web
browser, but most of the time, you’ll avoid slowing down your PC’s perform-
ance by closing unnecessary applications. (Even when you’re not directly
using a program, Windows XP spends processor time and memory keeping
it ready for you.)

To shut down a program, use one of the following methods:

4 Click the Close button (the big X) at the top-right corner of the
window.

4 Choose File=Exit.

4 Press Alt+F4. This doesn’t work on all programs, but many still honor
the old Exit keyboard shortcut.

If you haven’t saved any open documents and you try to exit an application,
most Windows programs will prompt you for confirmation so you won'’t lose
your stuff by accident — as shown in Figure 3-3, where I'm trying to exit
Word without saving this chapter. No, Mark, don’t do it!

'\

(Microsoft Word

! E Do wou wank to save the changes to bkizchapd3?

Mo Cancel ‘
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Where the @#&! is the @#&! Alt+F4 key?

If you're scanning your PC’s keyboard in vain for
the Alt+F4 key, you should stop now: There is no
single key named that on any keyboard. Instead,
Alt+F4 stands for a key sequence—it's actually
two keys pressed together. When you see two
keys conjoined by a plus sign, press the first key
and hold it while pressing the second key. For
example, if | tell you to press the sequence
Ctrl+C (which copies a selection), I'm asking
you to hold down the Ctrl key while you press
the C key. After you press the C key, you can
release the Ctrl key.

Most Windows XP sequences use one of three
keys as the first key: Alt, Shift, or Ctrl. You can

press the specified key on either side of the
keyboard, so lefties might press the Shift key
that's under the Enter key. It's all gravy to XP. In
fact, most PC owners are familiar with the Ctrl+C
(copy), Ctrl+X (cut), and Ctrl+V (paste) sequences.

Some rare key sequences involve three keys:
The first two keys are held down while you
press the third one. The most famous three-key
sequence, of course, is the infamous Three
Finger Salute — the legendary Alt+Ctrl+Delete
sequence that would reboot a PC running DOS.
In Windows XP, applying the Three Finger
Salute displays the Windows Task Manager,
which | discuss a bit more later in this chapter.

Putting Your Files in Order

Next, consider how you’ll manage files in Windows XP. You can use the
Explorer window to take care of your chores, as you’ll see in this section.

\\3

You can find file management alternatives to Windows Explorer. One of my
favorites is Total Commander (shown in Figure 3-4), which is a popular $30
shareware favorite for many years now. Total Commander is list based, so
you see and select more than the traditional icon view in Explorer. (I show
you how to switch views in the next chapter of this mini-book.) You can
download a copy to try out from www.ghisler.com.

Copying and moving stuff
To copy selected files and folders from one Explorer window to another —
or to the desktop or to a drive — you can use one of these methods:

4 Click the selected items and drag them from one Explorer window to
the destination Explorer window. Of course, this requires you to open
two Explorer windows, but that’s life in the big XP. Also, note that in
order to copy from one location on a drive to another location on the
same drive, you must hold down Ctrl while you drag. Otherwise,
Windows XP assumes that you want to move the items instead. (If



Figure 3-4:
Total
Commander
is a great
alternative
to Explorer.
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you're copying something from Drive C to a location on Drive D, you
don’t have to hold down the Ctrl key.) You can always tell when you’re
copying something with the mouse because XP adds a small plus sign
(+) to the items while you drag.

4+ Right-click the selected items and drag them to their destination.
IMHO (short for In My Humble Opinion on the Internet), this is always
the better choice than copying with the left mouse button. Why? Well,
you don’t have to hold down Ctrl — Windows XP pops up a menu when
you release the mouse button and asks whether you want to copy or
move the file. Much more civilized, don’t you think?

4 Choose Edit~>Copy from the Explorer menu, click in the destination
Explorer window, and then choose Edit~>Paste. From the keyboard,
you can press Ctrl+C to copy or Ctrl+V to paste.

4 Click Copy This File/Folder from the Explorer Task pane. XP displays
the Copy Items dialog box that you see in Figure 3-5; navigate to the des-
tination and then click the Copy button. If you like, you can create a new
folder first. Remember, click the plus signs (+) to expand drives and
folders or click the minus signs (-) to contract them. From the menu,
choose Edit=>Copy to Folder to display the Copy Items dialog box.
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Copy hems 0] |

Selbect the pluos wheee you wart to copy 'Clas Fundoes - Using Tour (0
Wiitor", Then click the Copy bufttom.

4+ Right-click the selected items and drag them to their destination.
Again, my favorite — release the mouse button and choose Move from

4 Choose Edit~Move from the Explorer menu, click in the destination
Explorer window, and then choose Edit->Paste. From the keyboard,

4 Click Move This File/Folder from the Explorer Task pane. The Move
Items dialog box looks just like the Copy Items dialog box that I mention

If you attempt to copy or move files that already exist in the target folder
or drive, Windows XP will prompt you for confirmation before overwriting

If you need to reverse direction when navigating — for example, if you click

Figure 3-5:
Preparing to
copy a file
via the
Explorer
window
Task pane To vhiow atvy iubfelder, il & plus. igh abovs
method. (et o s | Cancal
To move selected items, use one of these methods:
the pop-up menu that appears.
you can press Ctrl+X to cut or Ctrl+V to paste.
earlier, and it works the same way.
anything.
A\

one subfolder too many and now you need to return to the previous folder —
don’t forget about the Back button on the Explorer toolbar, which functions
just like the Back button in Internet Explorer. (The Back button resides in the
upper-left corner of the Explorer window.)
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Creating a new folder

Creating new folders is the cornerstone to good organization in Windows XP.
Dumping everything in your My Documents folder is a bad idea because it
will rapidly resemble a sold-out rock concert (complete with additional files
struggling to get in).

To create a new folder within the current location in Windows Explorer, use
one of the following methods:

4 Choose FileroNewr>Folder. Explorer adds the new folder icon and also
opens a text box underneath it in which you can type the folder name.

4+ Right-click any open spot in the Explorer window and then choose
Newr>Folder from the pop-up menu that appears. Note that I said open
spot — if you happen to right-click an icon or control, you’ll get a com-
pletely different pop-up menu, so pick an unoccupied parcel of territory.

4 Click Make a New Folder from the Explorer Task pane.

Deleting stuff with mouse and keyboard

Kinda sounds like “Deleting Stuff with Moose and Squirrel,” don’t you think?
(Boy, howdy, sometimes I turn into a real laugh riot. Usually when I've had
very little sleep.) Anyway, if you need to delete unnecessary files or folders
from your system, Windows Explorer can handle that as well.

Use your mouse to select the items that you want to trash and then choose
Filer>Delete. Alternatively, you can right-click the selected items and then
choose Delete from the pop-up menu that appears. If you're into dragging
things, you can drag an item from the desktop or an Explorer window and
drop it on top of the Recycle Bin.

From the keyboard, just select the unwanted items and press Delete. It
doesn’t get any easier than this, folks.

Deleted stuff gets whisked away to the Recycle Bin — but that stuff may not be
permanently deleted quite yet. (More on your Recycle Bin later in the chapter.)

Displaying properties
You might want to display an item’s Properties dialog box for an item for a
number of reasons:

Book II
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Figure 3-6:
Displaying
the
Properties
dialog box
for a hard
drive.

4+ Ifit’s a shortcut, you might want to find the location of the original file.

4+ Ifit’s a folder, you can see how much total space the folder uses and

how many files it contains.

4+ If you're displaying a drive’s properties, you can see how much free
space the drive has left, or you can scan it for errors and then defrag-
ment it. (More on scanning and defragmenting in Chapter 5 of this

mini-book.)

Here’s the point: Every item on your XP desktop and in an Explorer window
has a Properties panel, and the contents change depending on what the
item is. Throughout the rest of the book, I show you how to use the
Properties settings for all sorts of items.

To display the properties for an item, right-click it and then choose
Properties from the pop-up menu that appears. For example, Figure 3-6 illus-

trates the properties for my drive C.
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Renaming items

You have four ways to rename an item in an Explorer window. Here’s the
first half of the process (telling XP what it is that you want to rename).
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4 Click the item once, pause a second or two, and then click again.
Unfortunately, this takes a bit of experience to do reliably.

<+

Click the item to select it and then press F2.

4+ Right-click the item and then choose Rename from the pop-up menu
that appears.

4 Click the item to select it and then click Rename This Item from the
Task pane.

Regardless of which method you use, XP opens a text entry box with the

current name. To delete the current name completely, just type the new

name. To use a portion of the original name, click in the text box and use Book II
your cursor keys and the Delete key to remove the unwanted characters. Chapter 3

Emptying the Recycle Bin

“Mom, where do we empty the recycled files?” Techno-nerds still chuckle
about “recycled” ones and zeroes, but the XP Recycle Bin is a popular spot
on your desktop, and you’ll eventually have to empty it. (You can tell
whether it’s holding deleted items because a discarded document
suddenly pops up in the bin.)

saiseg
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To delete the contents of the Recycle Bin, right-click it and then choose
Empty Recycle Bin from the pop-up menu that appears.

Windows will eventually delete older items from the Recycle Bin
automatically — or when you use the Disk Cleanup Wizard. However,
you'll free up space every time that you empty the Recycle Bin, and some-
times that extra space can come in very handy on a drive that’s filled to
the brim.

By default, Windows will prompt you for confirmation before deleting your
trash. If you feel that such clucking is overdoing things and you want to
banish this file deletion confirmation, right-click the Recycle Bin and choose
Properties to display the settings that you see in Figure 3-7. (If you're won-
dering how my Recycle Bin got its name, [ use Symantec’s Norton Utilities,
which includes the Norton Protected Recycle Bin — and it allows you to
name your Recycle Bin whatever you like.) Click the Global tab and then
clear the Display Delete Confirmation Dialog check box to disable it.

\\3
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Recovering Items from the Recycle Bin

Here’s a feeling that we’ve all shared from time to time: You suddenly realize
that you just dropped your Great American Novel into the XP Recycle Bin by
mistake. (Hint: If you back up your files on a regular basis, you won’t panic
nearly as much as the poor PC owner who has never backed up.)

However, there’s still a chance that you can recover from your mistake and
recover that orphaned Word document from the Recycle Bin! (The quicker
that you try a rescue after you realize the error, the better; read on to dis-
cover why.) Follow these steps:

1. Double-click the Recycle Bin to display its contents.
2. Select the item(s) that you want to restore.

3. Click Restore the Selected Items from the Recycle Bin window Task
pane. Alternatively, you can right-click a single item and then choose
Restore from the pop-up menu that appears.

The Recycle Bin is great, but it’s not a perfect solution because Windows XP
might use the space taken up on your hard drive by a deleted item to store
new data, which will make restoration impossible. That’s why [ recommend
that you restore a deleted item as soon as possible — 1 try to do it immedi-
ately after I catch my mistake.
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Putting the Start Menu through Its Paces

Figure 3-8:
Yep, the
Start button
has its own
Properties
dialog box.

Ready to disassemble the Start menu? That’s what this section is all about:
helping you gain control of the ungainly (yet extremely useful) Start menu
and customizing it for your specific needs. (I won’t be discussing the My
Documents folder here because I cover that in the next chapter of this
mini-book.)

Tossing the Recent Applications list

You can read how to use the Recent Applications list at the beginning of this
chapter, but if security is an issue, you might want to disable it. After all,
does your boss really need to know that you recently played Tetris,
Dungeon Siege, and DOOM III? I think not.

To disable the list, follow these steps:
1. Right-click the Start button and then choose Properties from the pop-

up menu that appears.

This displays the Task Bar and Start Menu Properties dialog box that
you see in Figure 3-8.

2. Click the Customize button to display the dialog box that you see in
Figure 3-9.
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3. Click in the Number of Programs on Start Menu box and type a zero.
P While you’re here, you can specify large or small icons for the Start
menu and also toggle the display of Internet and e-mail items on the
Start menu. (If you do decide to enable the Internet and/or E-mail check
boxes, you can click their respective drop-down list boxes to choose the
applications that will run when you click the menu items.)
4. Click OK and then click OK again.
Using the Run item
You can run any application from the Run item on the Start menu. Just click
Run, and you’ll see the dialog box shown in Figure 3-10.
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Click in the Open text box and type the actual filename of the application
that you want to run; or, you can click the Browse button to navigate to the
application. If you've recently used the Run dialog box to start the same
application, click the arrow at the right side of the Open drop-down list box
and choose that application from the list.
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Figure 3-11:
My Printers
and Faxes
window.
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When the filename appears in the Open box, click OK to run it.

When you’re using the Run dialog box, remember that the name of the pro-
gram you want to run might not be the same as the actual application file-
name — and you must enter that actual application filename! For example,
you can run Microsoft Word from the Run dialog box, but entering word or
word.exe will result in an error. In fact, the filename that you need to enter
is winword.exe.

Accessing printers and faxes

To add a printer or install fax support, choose the Printers and Faxes item
from the Start menu. Your Printers and Faxes window will likely contain dif-
ferent printers than mine does in Figure 3-11, but the items in the window’s
Task pane will be the same. (Read more about installing fax support in the
next chapter of this mini-book.)

This is also the place for changing the settings provided by your printer man-
ufacturer’s XP driver. For example, you can likely change the print quality, and
perhaps you can clean your inkjet’s print nozzles or check on your ink levels.
Right-click the desired printer icon and then choose Printing Preferences to
see what you can change. What you see depends on your printer manufac-
turer. In Figure 3-12, which illustrates the Printing Preferences dialog box for
my HP PhotoSmart inkjet printer, is an example of what you might see.
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To choose your default printer throughout XP, right-click the desired printer
and then choose Set as Default Printer. Windows XP adds a check mark
symbol to the printer’s icon to indicate that it is the default printer.

Note that XP also displays several advanced printer settings on a printer’s
Properties dialog box, including printer sharing (which I cover in Book VIII)
and color management for color printers.

Windows applications are likely to use one of three different methods to
print:

4 Choose Filew>Print.
4 Click the Print icon on the program’s toolbar.
4 Press Ctrl+P.

To display (and control) pending printing jobs, click a printer to select it
and then click the See What'’s Printing item (assuming that you’re printing
something) of the Printers and Faxes window Task pane. This displays the
dialog box that you see in Figure 3-13, which lists details about the pending
printer jobs. You can pause all your print jobs on the selected printer by
choosing Printer=>Pause Printing; to restart the printer, click the Pause
Printing menu item again. (If your printer is on a network, you need
Administrator rights to pause all print jobs.)



Figure 3-13:
View, pause,
and cancel
print jobs
here.
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To pause a single print job, click the desired job in the list and then choose
Document=>Pause. To resume printing, click the desired job in the list and
then choose Documentr>Restart.

Working with your network

Click My Network Places (on your desktop) to open shared folders on other
networks (including File Transfer Protocol [FTP] servers on the Internet).
From here, you can

<+

<+

Open a network place for moving, copying, or opening documents.
Just double-click the network icon to open it.

Add a new network place. Click this item in the window’s Task pane to
run the Add a Network Place Wizard, which will walk you through the
short process of creating a new icon in the My Network Places window.

View network connections. This item displays all the available network
connections recognized by Windows XP (as shown in Figure 3-14); note
that all these connections might not be active at this moment. (For
example, | have two FireWire IEEE 1394 ports on my main Windows XP
machine, but I'm not using either of them on a FireWire network. XP
doesn’t care — it displays them anyway.) You can also display the prop-
erties of a network connection from this window by right-clicking the
connection icon.

Set up a network. XP actually makes setting up a network as easy as
possible. I explain the entire procedure in Book VIII, Chapter 2.

View workgroup computers. Click this Task pane item to see the other
computers assigned to the same workgroup as you on your local
network.

I refer to many of these network Task pane items throughout later chapters
of the book, so remember how you got here.
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Figure 3-14:
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Configuring the Start menu

I'm not quite ready to leave the Start menu yet — at least, not until I discuss
the Advanced panel of the Customize Start Menu dialog box. (Remember
from earlier in the chapter?) Right-click the Start button, choose Properties,
choose Customize, and then — finally! — click the Advanced tab to display
the settings that you see in Figure 3-15.

From here, you can modify a number of features of the Start menu:

4+ Open submenus: If you'd rather click a submenu in the All Programs list
instead of watching them pop up and down like crazed frogs, disable
this check box.

4+ Highlight Newly Installed Programs: This feature displays programs
that you’ve just installed with a highlighted band in the All Programs
list. If you have a huge number of installed programs, enable this check
box, and you’ll be able to locate that new application much more easily.
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4 Start Menu Items: This scrolling list allows you to specify what you
want shown on the Start menu and whether certain items should be
shown as a link (which opens a separate window) or as a menu.

4 Recent Documents: Remember the Recent Applications list? The Recent
Documents list works the same way, only it contains recently opened
documents rather than recently used programs. Again, if you're worried
about your security (or your reputation) and you don’t want others to
know what you’re doing, you can disable the list entirely.
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Handling the Taskbar

Yep, it’s yet another XP control. This time, I'm talking about the taskbar,
which is that loyal strip of screen real estate that appears at the bottom of
the screen — or at the side, or the top. (More on this in a second.) In this
section, I tell you more about the often-neglected taskbar.

Switching programs

The primary use of the taskbar — and one that’s been around since
Windows 95 — is to allow you to easily switch between the windows of the
programs that you're running. You can switch between programs by clicking
your mouse pointer on the taskbar button for the program that you want

to use.
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Figure 3-16:
Your
taskbar,
your friend.

A\\S

Shhh ... there’s also another method of switching programs that doesn’t
use the taskbar — and since we’re on the topic, I'll tell you about it here.
You can press Alt+Tab to move between the programs that you're running.
To step through the programs, hold down Alt while you press Tab repeat-
edly, and you’ll advance through your programs like Tiny Tim tiptoeing
through the tulips.

Controlling the notification area

Next on the Taskbar Hit Parade is the notification area — that’s the far right
end of the taskbar, as shown in Figure 3-16. Most of these icons represent a
program that’s running. In the figure, for example, you can see the tiny
Norton AntiVirus computer icon and my PowerStrip icon (which looks like a
tiny monitor), which indicate that these programs are running. However,
you can also see the Volume icon (which you can click to set your PC’s
volume or mute sound altogether) as well as my laser printer icon.

Quick Launch icons Program buttons
1 l 1 1 1
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Dimple handles Notification icons

So what did you glean here? (“Bueller? Bueller? Anyone?”) Not everything in
the notification area is a program,; rather, the icons that appear there indi-
cate (or notify you about) things that are available and things that are cur-
rently happening on your PC. You can, however, right-click most notification
icons to display pop-up menus. Typically, the menu allows you to control
whatever program or feature the notification icon represents (including the
ability to close or exit, if the icon represents a program that’s running).

If you see an arrow pointing to the left at the end of your notification icons,
XP is hiding the icons that you haven’t used recently to make more room for
program buttons. To see these hidden icons, click the arrow.

Don’t need the clock in the notification area? Then right-click in any open
space on the taskbar, choose Properties, and clear the Show the Clock
check box (as shown in Figure 3-17) to disable it.



Figure 3-17:
Displaying
the Taskbar
properties.
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Adding Quick Launch icons

Handling the Taskbar

125

At the left end of the Taskbar — next to the Start button — you'’ll find the
Quick Launch icons, which are probably the least-appreciated icons within
Windows XP. You can right-click and drag any program icon, file icon, or
folder icon down to the Quick Launch area, release the mouse button, and
then choose Create Shortcut. From that point on, clicking the icon in the
taskbar runs the application, opens the document, or opens the folder.

Naturally, your space on the Quick Launch portion of the Taskbar is limited,
so [ recommend that you add only the programs, folders, and items that you
use the most. | even added the Add/Remove Programs Control Panel icon to
my Quick Launch buttons. It’s easy to right-click and drag any Control Panel
icon to the taskbar when you configure the Control Panel as a menu, as [

show you in Chapter 6 of this mini-book.

“Hey, I can’t put anything on the Quick Launch area!” That’s probably

because the taskbar is currently locked, which prevents anyone (including
you) from inadvertently dragging a Quick Launch icon off to the desktop or

from making any changes to the dimensions or location of the taskbar.

Right-click anywhere on the taskbar itself (and not on an icon or control),
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Figure 3-18:
Whoa! For
those who
gravitate to
the right. . .

choose Lock the Taskbar to unlock things, and then try again. After you're
done arranging the taskbar as you like it, it’s a good idea to lock it again.

If you don’t need the Quick Launch area of the Taskbar, you can reclaim that
space from the Taskbar and Start Menu Properties dialog box. Right-click
any open part of the taskbar, choose Properties, and then clear the Show
Quick Launch check box to disable it.

Configuring the taskbar

Would you rather have your taskbar on the left or right side of the XP desk-
top? How about at the top of the desktop? No problem. First, make sure that
the taskbar is unlocked; then click in the center of the bar and drag it to any
other side of the screen. (Check out Figure 3-18.)
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While the taskbar is unlocked, you can also

4+ Expand it by clicking the edge closest to the desktop (where the thin
strip appears) and dragging it up.

4+ Resize the Quick Launch and notification areas by clicking the
dimpled handles on the taskbar and dragging them.

4+ Swapping the default locations of the Quick Launch and program but-
tons by dragging the dimpled area to the left of the Quick Launch area
to the right of the second dimpled line.

Now that you see how easy it is to alter the taskbar, you’ll understand the Book Il
necessity of locking it! Don’t forget to batten down the hatches after you Chapter 3
have things just as you want them. When the taskbar is locked, the dimpled
handles disappear, and the strip along the desktop edge of the taskbar dis-
appears as well.
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Terminating a Program with Prejudice

Sometimes a program just decides to misbehave. At least things are better
in Windows XP than they were in Windows 98 or Me, where one locked pro-
gram was likely to lock the entire machine. In XP, you should be able to
force a nonresponsive program to quit without losing any open files or
having to restart your PC — although I always save my files in the other
applications, just in case!

To force a locked program to terminate, follow these steps:
1. Press Alt+Ctrl+Delete to display the Task Manager and then click
the Applications tab, as shown in Figure 3-19.
2. Click the name of the application that’s causing the problems.
It will usually be marked Not Responding in the Status column.
3. Click the End Task button to initiate the terminate sequence.

Note: It might take several seconds for the terminated program to disap-
pear, or you might need to repeat this step two or three times to force
termination.

XP displays a dialog box saying that the program will not shut down
properly.
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4. Click the End Now button.

The program will disappear from the Applications list.

5. Click the Close button to close the Task Manager.

By the way, you can also restart and shut down Windows XP from the Task
Manager. Click the Shut Down menu to see these choices. To see who'’s
logged in to your machine — either locally or remotely — click the Users
tab, where you can also disconnect or log off any undesirables.

Formatting a Floppy Disk

I'd rather you not. Honestly. Let me tell you my story.

Several years ago, I lost an irreplaceable document that was very near and
dear to my heart. The floppy that it was stored on gave up the ghost, and I
was left a broken man (for at least half a day). It was then that I embarked
upon a sacred mission to banish the floppy disk from my PC . . . and from
the PCs of all those who would heed my call:

4+ Those who have also lost valuable data to the vagaries of the Plastic
Pretender, where data can be readable one second and unreadable the

next

4+ Or those who have realized that practically nothing fits within 1.44MB of

space any longer
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4+ Or those who have encountered the recalcitrant floppy that will read
perfectly well on one PC and stubbornly refuse to be read on another

4 Or those who need compatibility between PCs and Macs

4 Or those who are sick and tired of that grinding sound and the slow
transfer rate of that prehistoric magnetic media

For an entire decade, I have carried on this fight in every book that I've writ-
ten. Here’s your chance to join me. Just repeat the following chant:

“Begone, floppy! Leave my sight! I banish you forever to the Land of Old
Technology. As it is written, so shall it be done.”

Instead, I offer you the USB Flash Drive, which works perfectly on any PC
with a Universal Serial Bus (USB) port. And if the PC is running at least
Windows 98SE, you shouldn’t need any installation software or drivers.
Most of these drives are so small that they fit on your keychain, and they
even work with Macintosh and Linux computers. They're sturdy, with no
moving parts to wear out. And because a USB Flash drive is Plug and Play,
you can connect and disconnect it without having to reboot your PC.

USB drives are fast, too, with transfer rates up to 12 Mbps. The new USB 2.0
Flash drives will really rock, offering transfer rates of up to 480 Mbps! My
USB 1.0 Flash drive has 32MB of storage space and cost $30, but you can get
a drive with up to 512MB of storage for a mere $250. All hail the new King of
Personal Storage!

To sum up, a classic Mark’s Maxim:
With a Flash drive, you’ll never lose a document to a floppy again.”

Aw, geez, my editors say [ have to tell you how to format a floppy. Something
about a contract that I purportedly signed. Okay, it’s your data’s funeral, not
mine. Floppy disks (like Zip disks and hard drives) must be formatted before
they can (unreliably) store any data; this prepares the magnetic surface of
the disk to hold stuff.

Load the floppy that you want to format. Just locate the goofy drive bay that
looks like it could eat a graham cracker and push the disk into it until you
hear a satisfying click that sounds like you stepped on a June bug. Double-
click My Computer (on your desktop) to display the drives on your system.
Right-click the floppy drive (probably named A for Abysmal) and then
choose Format to display the dialog box that you see in Figure 3-20. If you
need to create a floppy that will boot a PC into DOS, mark the Create an
MS-DOS Startup Disk check box to enable it. Click Start . . . and good luck.
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Chapter 4: Customizing
Windows XP

In This Chapter

v Customizing your desktop background

v+ Fine-tuning the toolbars

v+ Using Explorer bars

v+ Understanding the My Documents folder

+» Working with Favorites

v+ Understanding multiuser computing

+ Sending and receiving faxes in Windows XP
v+ Playing MP3 files in Media Player

v+ Viewing and downloading digital photographs
+* Recording your own data CDs in XP

If you’ve followed along so far in this mini-book, you’ve been a slave to
the Microsoft defaults. That might be status quo for novice XP users,

but if you want to mold Windows XP into your operating system (and thus
become a PC power user), you must master the customization features
within XP. Just say “No!” to Icons view, or the Explorer window Task pane,
or that too-familiar desktop background — add your favorite sound effects
from The Rocky Horror Picture Show to your XP experience. (I boot up every
morning to the lilting sounds of “The Time Warp,” much to the consterna-
tion of our family cats. Drop me a line at mark@mlcbooks.com, and I'll send
you my custom sound scheme from the film.)

This chapter ties what you need to transform your PC from a personal com-
puter into a personal tool — which, I might add, should be the end goal of
every hardware manufacturer and software developer, including the
Microsoft crowd. In these pages, | do my part: You discover how to optimize
your toolbars for productivity, share your computer with others in a multi-
user environment, visit your favorite Web sites directly from the Explorer
window, and send and receive faxes with your PC’s fax modem. I also intro-
duce you to Windows Media Player, which you can use to enjoy all sorts of
digital multimedia. And stick around for brief look at viewing/downloading
digital photographs. I even show you how to burn a CD-R with data files from
your hard drive . . . without buying an expensive CD recording application!
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So, good reader, prepare yourself — turn that cookie-cutter machine with its
vanilla Windows XP into your personal custom-made muscle PC, and take it
up a notch!

Personalizing Your Desktop

Don’t get me wrong — I like the soothing blue sky and calm green hills of the
typical Windows desktop. After a few weeks, though, you’ll say to yourself,
“Self, you spent two grand on this system. Why not jazz it up a little bit?” In
this section, I show you how to take care of spicing up the look and sound of
Windows XP.

Changing the background

First up on the makeover tour is the most popular trick — changing your
desktop background to something more palatable. Windows XP prefers
JPEG and bitmap images for your background.

Follow these steps to select a new background:
1. Right-click anywhere on the open space of your current desktop and

then choose Properties from the menu that appears.

In other words, don’t click an icon or Windows XP control, like the Start
menu.

2. Click the Desktop tab to display the settings that you see in Figure 4-1.
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3. To choose a desktop image from your Windows folder, click it in the
Background list.

To rebel completely against background images, click None.
Alternatively, you can load your own image by clicking the Browse
button and navigating to the location of the image; then just double-
click the image file to load it.

4. You can choose to stretch an image that doesn’t quite fit across your
entire desktop by selecting Stretch from the Position drop-down list
box. If the image is too small to stretch, pick Center to put it in the
middle of the desktop; or if the image is a repeating pattern,
choose Tile. Book Il

5. To set the desktop to a solid color — or to change the color of the Chapter 4
desktop that surrounds a centered image — click the Color drop-

down list box and then click the desired color. so

- S

Any changes you make are reflected in the Preview window. After the pre- é— g

view looks good, click Apply to try out the background; if you like what you 5 E

see, click OK. If the result would make Andy Warhol cringe, try again. o 2

Using themes

A Windows XP theme is a package deal: Selecting a theme gives you a back-
ground, a color scheme, an icon set, and sound effects. Themes are avail-
able from Microsoft, or you can download themes (of varying quality) from
sites all over the Web. To choose a theme, follow these steps:

1. Right-click anywhere on the open space of your desktop and then
choose Properties from the pop-up menu that appears to display the
Themes settings of the Display Properties dialog box (see Figure 4-2).

2. Click the Theme drop-down list box and click a theme to view it in
the Sample window.

3. To create a theme of your own based on the current desktop settings,
click the Save As button.

Yup, you get the standard Save As dialog box, in which you name your
custom theme.

4. When you're satisfied with the theme, click the Apply button to check
it out on your desktop; or click OK to close the Display Properties
dialog box.
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Windows XP offers a number of events that can be heralded by system

1. Choose Start=>Control Panel=>Sounds and Audio Devices and then
click the Sounds tab to display the settings that you see in Figure 4-3.

Speaker icons indicate that a sound
has been assigned to an event.
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. To choose an existing sound scheme, click the Sound Scheme drop-

down list and then click the scheme that you want.

. To assign sounds individually to events, click the desired event

within the Program Events list box and then click the Sounds drop-
down list box to display all the sounds that have been installed
within XP.

To hear a sound, click the right-arrow Play button. (When you assign
a sound to an event, XP marks that event with a tiny speaker icon.)

. You can also use WAV format sound files from another folder on your

hard drive; click the Browse button, navigate to that folder, and then
double-click the file to load it.

If you create your own custom sound scheme, don’t forget to click Save
As to save it under a unique name so that you can load it in a flash in
the future.

. When you’re ready to rock, click OK to close the Sounds and Audio

Devices Properties dialog box.

Switching Views and Sorting ltems

Next, allow me to discuss the different views within Windows XP Explorer —
and how you can switch between ’em in a flash.

To switch between views in the Explorer window, open the Views menu from
the toolbar (in Figure 4-4, see how the menu drops down). Your choices are

4 Thumbnails: This view displays images and video clips as thumbnails

(tiny pictures), but be warned: It can take XP a significant amount of
time to process a folder containing a lot of images, especially on an
older machine with less than 256MB of RAM. In this view, folders con-
tain pictures that are displayed as tiny thumbnails of the images that
they contain . . . sassy indeed!

Tiles: Choose this view to make items appear as icons on well-spaced
tiles at regular intervals, thus making it easy to click an item without
running something else by accident.

Icons: This view is a traditional favorite, where each item appears as an
icon. However, spacing is much tighter than the Tiles view, so longer
filenames are often abbreviated (and you must be more careful when
clicking).

List: Another long-standing favorite, List view features each item
arranged in list format — one entry per line.

Book II
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Figure 4-4:
Choose your
view in the
Explorer
window.

4 Details: If you like the List view but wish you had more information on
each item, choose the Details view. Again, the Details view takes a little
more time to display, so expect a delay before you see the statistics —
the larger the folder, the longer it takes.

To sort the items in the Explorer view to your particular fancy, choose
Vieww>Arrange Icons By and then choose the sorting criteria that you want
to use. (I find that Name, Type, and Total Size are the most useful.)

Note that you can also elect to group items together — choose
View=>Arrange Icons By=>Show in Groups.

To keep your icons from straying all over creation, choose View=>Arrange
Icons By=>Auto Arrange. With the Auto Arrange feature turned on, Windows
XP arranges everything in orderly rows for you. (Note that this option is
only available in Thumbnails, Tiles, and Icons views.)
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Figure 4-5:
Why settle
for the
default
toolbar?
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Adjusting toolbars

Toolbars used to be static controls but not any more. With Windows XP, you
can add and remove buttons to create The Perfect Explorer Toolbar! Follow

these steps:
1. Right-click the toolbar in the Explorer window and then choose
Customize from the menu that appears.

This displays the Customize Toolbar dialog box that you see in
Figure 4-5.

You can also choose Viewr>Toolbarsw>Customize if you're averse to
right-clicking.
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2. From the list on the left, click the button that you want to add and
then click the Add button to include it on the toolbar; to remove an

existing toolbar button, click the button name in the list on the right

and then click the Remove button.

3. To fit more icons on the toolbar, click the Icon Options drop-down list

and then choose Small Icons.

4. To choose the placement of button labels — or to remove them
altogether — click the Text Options drop-down list box.

5. Need to modify the placement of a toolbar icon? Click it in the

Current Toolbar Buttons list and then click either the Move Up or the

Move Down button to redistribute it just so.

6. Click Close to save your changes.
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P To toggle the display of individual toolbars within the Explorer window,
right-click the Explorer bar and then click the toolbar that you want to hide
or display.

Using the Explorer bar
The default Explorer window displays the Task pane, which is a multipur-
pose “control thing” on the left side of the Explorer window (the hoopla is
a-happenin’ in Figure 4-6). It provides you with a number of commands that
apply to whatever you're viewing. For example, you can make a new folder
or share the current folder on your network. You can also display the details
on the currently selected item.
However, that’s not the only set of controls vying for the left side of the screen:
Enter the Explorer bar. Besides looking rather suave, it can help you with
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Figure 4-7:
Locating
things is
easy from
the Search
Explorer
bar.
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4 Searching for all sorts of things: Choose Views>Explorer Bar=>Search

(or press Ctrl+E) to display the Search Explorer bar, as shown in Figure
4-7. (Actually, it feels more like a wizard than a plain toolbar.) Click the
item, person, computer, or piece of information that you want to search
for, and the Search Explorer Bar leads you through a series of questions
to help you fine-tune your search.

4+ Jumping to Favorites: Choose Viewr>Explorer Bar=>Favorites (or press

Ctrl+I), and you’ll see your Favorites collection listed in the Explorer
bar. A single click of any Favorite jumps directly to it. (More on
Favorites later in this chapter.) You can also click the Favorites menu
(within the Explorer window) and click a Favorite from there.

4+ Watching and listening to multimedia: Choose View=>Explorer

Barm>Media to see and hear the latest multimedia files from
WindowsMedia.com (see the left side of Figure 4-8) or to listen to
Internet radio. (Note that at least a 56 Kbps dialup connection is recom-
mended for listening to Internet radio stations.) Media Player controls
are included at the bottom of the Media Explorer bar, so you can take
care of mundane chores like adjusting volume, switching tracks, or stop-
ping and starting playback.
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Figure 4-8:
Invite
Hollywood
and
Nashville to
your
Explorer
window.
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4 Returning to where you’ve been: Choose View=>Explorer Bar=>History
to display the Web sites and documents that you've used recently — to
return to a Web site or load a recent document, just click the name.

As you might imagine, the History Explorer bar can get rather crowded
after a long day at the keyboard. To help sort the chaos, click the View
button at the upper-left of the History Explorer bar, and you can sort by
date or site visited or by the total number of times that you've visited
each site or document.

And don’t forget the Folders view!

Probably the most familiar of the Explorer bars is the Folders Explorer bar,
as shown in Figure 4-9. It’s the old standby “tree” display (from Windows 3.1
and 95/98) of the folders on your system. You don’t even have to use the
View menu to display the Folders Explorer bar, either. It’s remained so popu-
lar (and so convenient and fast and useful) that the XP Explorer window
contains a Folders button on the toolbar.



Figure 4-9:
The mighty
Folders view
is as
everlasting
asa
redwood.

What's This Stuff in the My Documents Folder? ’5 ]
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From within the Folders Explorer bar, click a drive or folder to expand it and
display its contents. You can also click a plus sign (+) to expand an item or
click a minus sign (-) next to an item to collapse it again. The Explorer
window is updated automatically with the contents of the drive or folder
that you're viewing.

This Stuff in the My Documents Folder?

Windows XP gives each user a separate My Documents folder, which you
can reach in a number of different ways:

4 From the Windows XP desktop

4 From the Start menu

4 From the Other Places section of the Explorer Task pane

4 From the My Documents button in Save (As) and Open dialog boxes
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Figure 4-10:
Your XP pad:
the My
Documents
folder.

If you're in a hurry, you can get to your My Documents folder from any-
where in a flash: Press the Win+D key sequence (using either of the
Windows keys on your keyboard) to display your desktop, press the Home
key (which highlights the upper-left icon, which in this case is the My
Documents icon on the desktop), and then press Enter (to open it).

As you can see in Figure 4-10, the My Documents folder is a regular reposi-
tory of everything that’s yours, including stuff like

4 Your images, video clips, and music
4 Your games
4 Your downloaded files

4 Your personal Web sites that you've created

You'll also find many subfolders created by different applications in the My
Documents folder, as well as things like theme files, background images, and
Office XP documents. That’s because the Redmond Gang wants you to use
the My Documents folder as your center of operations, and most software
developers respect the Microsoft standard. Thus, most programs will default
to installing themselves there and saving their documents there as well (or to
one of the standard subfolders within My Documents, like My Pictures).
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If you're using Microsoft Backup, you should definitely use the My
Documents folder because that’s what Backup uses for source files as a
default.

You can create as many subfolders in the My Documents folder as you like,
and it’s a logical place to keep your stuff (at least on your C drive, where
Windows XP is usually installed).

Remember, there’s actually a separate My Documents folder for each user
that you've created in Windows XP, so the stuff that you see in your My
Documents folder won’t be the same as what Brother Elroy sees in his My
Documents folder. What Windows XP displays is keyed to the active user
account.

Share the Documents

A\

By the way, the contents of the My Documents folder are also hidden from
other users, so you can’t put a document there and expect other users of
your PC to be able to reach it. Instead, use the Shared Documents folder,
which you can reach from the Windows Explorer Task pane. When you copy
a file or folder to the Shared Documents folder, anyone using another
account on your PC can open and copy the file.

By default, the Shared Documents folder is not shared amongst the other
PCs on your network — it’s only used with files shared locally among users
of the same PC.

Using Favorites

Yep, you also have access to your favorite Web sites from within the
Explorer window. Earlier in this chapter, I talk about the Favorites Explorer
bar, and you might already know about how to use Favorites within Internet
Explorer (which I explain in Book IIl, Chapter 4). But how does one add
Favorites without using Internet Explorer? That’s what this section is all
about.

Ever wonder why the XP Explorer window and the Internet Explorer window
look so similar — or why it takes so little time to jump to a favorite Web site
inside the Explorer window? Well, bunkie, it’s because Microsoft made a
decision some time back to merge its Windows operating system with its
Web browser. After missing the early Internet boat, His Gateness decided to
embrace the Internet with open arms, so now the traditional Explorer
window is actually generated with the same code that runs Internet
Explorer.
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Adding a favorite
You can add a Favorite from the Explorer window in two ways. First, how-

ever, bring up the Favorites Explorer bar by choosing View=>Explorer
Barw>Favorites (or press Ctrl+I).

4+ From the Favorites Explorer bar: Click the Add button, and Windows
XP displays the dialog box that you see in Figure 4-11. Type a new name
(if you like) and click the Create In button to select the Favorites folder
where you want to store the entry. Then click OK to save the Favorite.
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Figure 4-11:
My favorite
way to add
a Favorite.

4 From the Favorites menu: Choose Favoritest>Add to Favorite to display
the same dialog box. Type a new name (if you like) and click the Create
In button to select the Favorites folder where you want to store the
entry. Then click OK to save the Favorite.

Organizing favorites

To organize your Favorites, either click the Organize button on the Favorites
Explorer bar or choose Favoritest>Organize Favorites. XP displays the
dialog box that you see in Figure 4-12.

4 To add a new Favorite folder: Click the Create Folder button to add a
new folder (which appears in all Favorites locations near you).

4 To move a Favorite into a folder: Click the desired Favorite, click the
Move to Folder button, click the destination folder, and then click OK.
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4 To rename a Favorite: Click the desired Favorite, click the Rename
button, type the new name, and then press Enter.

When you’re done organizing your Favorites, click Close to return to the
Explorer window.
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Creating a Shortcut
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In Chapter 2 of this mini-book, I introduce you to shortcuts — now it’s time
to create them. Here are two methods of creating a shortcut:

4+ Right-click an icon: From the pop-up menu that appears, choose Create
Shortcut, and XP does just that — a new shortcut appears in the same
folder as the original icon. You can then copy or move the shortcut to
another location on your system.

4+ Drag an icon: Right-click the icon and drag it to the location where you
want to place the shortcut. When you release the mouse button, choose
Create Shortcuts Here from the pop-up menu that appears.

Ever wonder where the shortcut’s original file is located? To find out, right-
click the shortcut, choose Properties from the resulting pop-up menu, and

then click the Shortcut tab to display the Target field (see Figure 4-13). The
target path points to the original file.
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Figure 4-13:
Clearing a
pathtoa
shortcut's
target (so
to speak).

Impowsible Creatures Properties x|

Genmal| Shofcs | Compuantslily

’

Targel hpee  Aggllcabion

LE s

argnt DG ame\ic\IC. ener

Stam TF

o by Nigr
Bun [ TP T - P
DGt
el | angait [ Change con, Adviniesd
l i t [ Conems |

Multiuser Operation

3

Earlier in this chapter, I mention the Shared Documents folder: where the
local users on your PC can share files and folders. That’s an example of
multiuser operation. Unlike a network environment — where multiple com-
puters are connected — a multiuser PC need not be part of a network.
Instead, different people use the same PC; each person has their own user
account; and Windows XP keeps track of everyone’s Control Panel prefer-
ences, Explorer views, desktop backgrounds, Favorites files, and all the
other sundry things that I show you how to customize XP in this mini-book.

In this section, I discuss how multiple folks can share a single workhorse PC.
Windows XP offers three different user account levels:

4 Administrator: In this level, the user has full access to the Control
Panel, can manage other user accounts, and can install programs and
hardware. If you’re the only person who will be using your PC, Windows
XP sets you up with an Administrator account — as it should.

4+ Limited: In this level, the user can only change the account password,
can’t install hardware or software, and has full control over only those
files that he or she creates. If you're setting up accounts for others and
you're less than impressed with their computing skill, by all means give
them Limited accounts!

4 Guest: More on the Guest account in a tad in the upcoming section, “Be
my guest.”
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Logging in

Your first chore when you sit down to a multiuser PC is to log in. This step
identifies you to XP and allows the operating system to load and apply all

your custom settings. You can log in to Windows XP in a number of ways:

4+ Boot your PC with multiple users active: If you start Windows XP with
more than one user account, you'll either get the Welcome screen or the
Logon screen (more on the difference between the two in a moment).

4 Logoff from the Start menu: Click the Start menu, click Log Off, and XP
displays either the Welcome screen or the Logon screen. If you're using
Fast User Switching (which I explain in a second), you'll see the dialog
box in Figure 4-14; otherwise, you’ll simply be prompted for confirma-
tion before the logoff actually takes place.

Log Off Windows

Figure 4-14:
Which will it
be — logoff
or switch?

4+ Switch users: If you've enabled Fast User Switching, you can allow
another person to log on without actually closing any of your programs.
Just make doggone sure that the other user knows not to turn off the PC
completely! (XP helps prevent any tragedies by displaying the number
of programs that the original user is running on the Welcome or Logon
screen.) After the switched user completes his session, he should
simply log off so that your programs remain running. Click the Start
menu, click Log Off, and then click Switch Users.

So what’s the difference between the Welcome screen and the Logon
screen? A big one: the password prompt! You see, if you've configured XP to
use the Welcome screen, a user logs on by simply clicking her username on
the screen, and whoosh! She’s logged in. On the other hand, if you’'ve dis-
abled the Welcome screen, a user has to

4 Type the correct username — and it had better be spelled correctly.

4 Type the correct password — ditto.
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Figure 4-15:
You can
create,
modify, and
delete user
accounts
from the
Control
Panel.

The logon method that you use depends on your security needs. If you live
with a trusted roommate or spouse and you can be reasonably sure of who’s
sitting at the keyboard, by all means bypass the unnecessary security and
use the Welcome screen. (It’ll save you countless fruitless logon attempts
because you missed a letter of your password.)

To choose between the Welcome screen and the Logon screen — or to
enable Fast User Switching — you need to visit the Control Panel and open
the User Accounts Wizard (see Figure 4-15). | demonstrate how to use the
Control Panel and how to reach the User Accounts Wizard in Chapter 6 of
this mini-book.

Be my guest

Before I cast off from Multiuser Land, I should elaborate on the third type of
user account: the Guest account is perfect for someone who needs to use
your PC right this moment but isn’t going to need an account in the future.
The Guest account

4 Doesn’t require a password.

4+ Can’t be duplicated or deleted — there is only one Guest account.

4 Can be turned on or off. Again, this is done from the User Accounts
Wizard accessed from the Control Panel.
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So what exactly can a Guest do? Basically, the Guest account has the same
abilities as a Limited user account: The Guest can use your PC, but Windows
XP prevents that person from abusing your PC.

Fax Me, Please

Yep, | know that many readers are exclaiming, “Hey! [ didn’t know that
Windows XP could act as a fax machine! That is positively trick” And indeed
it is — all you need is a fax modem, a telephone line, and the instructions in
this chapter.

Book Il

There are actually four separate programs that you use to handle faxing in XP: Chapter 4
4 The Fax Configuration Wizard

4 The Send Fax Wizard § g

=, -

4+ The Fax Cover Page Editor E 3

& N

4 The Fax Console 53

Unfortunately, Microsoft — for some unknown reason — doesn’t install
these fax programs during a default installation of Windows XP. (Sound of
hand slapping forehead twice.) Here’s the drill. Stick your XP installation
disc in your CD-ROM drive. Click Start, click Printers and Faxes, and then
click Set Up Faxing in the window’s toolbar. XP whirrs busily to itself and
copies a number of files from your XP installation disc. You're returned to
the Printers and Faxes window, and you can now configure Windows XP to
send and receive faxes. Sigh.

Setting up faxing under Windows XP

Sigh Part 2. After you get the fax programs installed, you need to configure
the fax support within Windows XP before you tell folks that you're ready to
accept calls from their fax machine. Follow these steps to set up your fax
service:

1. Choose Start=>All Programs>Accessories=>Communications=>Fax->Fax
Console.

(Whew. Way to bury this thing, Redmond.) After all that work, XP
obligingly displays the first screen of the Fax Configuration Wizard.

2. Click Next to continue.

The wizard displays the rather frightening screen that you see in
Figure 4-16.
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Figure 4-16:
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. Yep, by law, you've got to type at least your full name, fax number,

and company name — but put the rest in, too, because it’ll come in
handy. Then click Next to continue.

. In the screen that appears, select the device that will be used to send

faxes from the drop-down list box. Also specify here whether

¢ You want the fax modem to pick up automatically (after a certain
number of rings).

¢ You should manually answer incoming fax calls.

Then click Next to continue.

. Time to enter your TSID, or Transmitting Subscriber Identification.

You can use up to 20 characters, so you have enough space to identify
you or your business. This is the string sent when you call another fax
machine to send a fax; it identifies your name or company in the recipi-
ent’s fax transmission report. Click Next to continue.

. Type another 20 characters for your CSID, or Called Subscriber

Identification.

Most folks use the same string as the one entered for the TSID. This string
appears on the fax machine that’s calling you. Click Next to continue.

. You must specify where received faxes are to be routed:

¢ Print it on the printer that you select in the drop-down list box.
e Save a copy in the folder that you specify.
e Choose both options.

All incoming faxes are also stored in the Fax Console Inbox. Click Next
to continue.
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Figure 4-17:
Your first
glimpse of
the Fax
Console.

151

Fax Me, Please

8. All done! Click Finish.

XP opens the Fax Console (as shown in Figure 4-17).

Sending and receiving faxes

If you've followed along the previous two sections, you are now XP-fax-
sending-empowered. To send a fax, follow these steps:

1. In its native application, open (or create) the document that you want
to fax.
For example, fax a Word document from within Word.

2. Press Ctrl+P to display the Print dialog box.

3. Click the Printer drop-down list box and then choose the fax device.

Click the Preferences button to switch between Normal (200 x 200 DPI)
and Draft (200 x 100 DPI) quality. Draft is quicker, but it’s, well, draft
quality.

Click Print.

5. After the Send Fax Wizard launches, click Next to continue.
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6. Type the name of the recipient and the person’s fax number. Or, if
he’s in your Address Book, click the Address Book button and choose
the contact from there.

(Optional) If you like, you can enter multiple recipients and click Add to
include them in the list.

When you’re done, click Next.
7. (Optional) Adding a cover page is optional but highly recommended.
a. Choose a cover page template from the drop-down list.
b. Type a subject line. (If you like, you can also add notes.)
c. Click Next to continue.

8. Choose the transmission priority and a scheduled time to send the fax
(any time from immediately until 24 hours from now) and then click
Next to continue.

9. Verify the settings on the final wizard screen.
¢ [f they check out okay, click Finish.
e To back up and fix something that’s wrong, click Back and, um, fix it.
If you configure XP for automatic reception of incoming faxes after a speci-
fied number of rings, you really don’t have to do anything to receive faxes
other than keep your PC running and stay off that telephone line. (See Step 4
in the previous section for the lowdown on how you want the fax call

answered.) However, if you specify manual answering for incoming faxes,
you have to follow these steps for each incoming fax:

1. Choose Start=>All Programs>Accessories=>Communications=>Fax->Fax
Console to run the program.
2. When you hear the phone ring, choose Filer>Receive a Fax Now.

3. Verify that the incoming fax has been properly detected by watching
the Fax Monitor; the Fax Console also displays a Reception Complete
dialog when the fax has been received.

Doing the Multimedia Thing

The final stop on this customization trip concerns multimedia. Windows XP
can be dead boring without liberal doses of digital audio, digital photographs,
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and DVD movies! In this section, I show you how to enjoy all sorts of digital
entertainment as well as how you can record your own CDs from within
Windows XP.

Playing your MP3 files

MP3 files are the modern solution to crystal-clear, high-quality music that’s

4+ Standardized and compatible: MP3 files are supported within every
computer operating system these days, along with countless personal
music devices, hand-held personal digital assistants (PDAs), and palm
PCs.

4+ Easy to create, copy, and share: Okay, perhaps foo easily created,
copied, and shared . . . but I'm just reporting on what you can do, not
involving myself in the ongoing copyright debate over MP3 distribution.
(And, like the bumper sticker on the back of my Jeep reads, “MP3 is not
a Crime.”)

4+ Easy to record on CD-Rs: Same copyright argument, same excuse on my
part — but it is currently legal to make “compilation discs” of MP3
songs as long as you own the original audio CDs.

To play MP3 files within Windows XP, you can double-click an MP3 file
within the Explorer window. Unless you’ve installed an alternate MP3 player,
XP cranks up Windows Media Player, as shown in Figure 4-18, and begins
playing the music immediately.

If you're wondering what the heck all the dancing lights mean, they’re what
Microsoft calls a visualization — essentially, a fun “optical oscilloscope” that
constantly changes. To switch to the next visualization, click the small,
right-arrow button at the bottom left of the visualization window. To turn
visualizations off completely, just choose View=>Visualizations>No
Visualizations.

The familiar controls at the bottom of the Media Player window are shown
in Figure 4-18 as well. You can click and drag the progress slider to change
your current point in the song or to mute or pause the playback.

For a complete discussion of MP3 files — including how you can “rip” your
own digital music from existing audio CDs — see Book VI, Chapter 2.
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Figure 4-18:
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Viewing and downloading digital photographs

If you've got a digital camera, Windows XP has three features that you’ll
want to try:

4 Thumbnails view: I discuss the Thumbnails view within the Explorer
window at the beginning of this chapter. As I mention there, it’s slower
than List or Icons view, but if you're sifting through a folder full of digital
images and you want to move, copy, or delete some, Thumbnails view is
the row to hoe. Figure 4-19 illustrates a folder from my digital photo-
graph collection as seen in Thumbnails view.

4+ Preview: If you haven't installed an image editor like Photoshop or
Paint Shop Pro, you can still view a picture on your hard drive by
double-clicking it. Windows XP runs the Viewer program, as shown in
Figure 4-20. (Viewer also displays received faxes.) The toolbar at the
bottom of the Viewer window lets you zoom in or out, rotate the image,
annotate it, print it, or copy it to another location.
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4 The Camera and Scanner Wizard: This wizard kicks in automatically
when you connect your Universal Serial Bus (USB) digital camera to
your PC, allowing you to view images and choose which will be down-
loaded to your PC.

You'll find much more information on digital cameras and these features in
Book VI, Chapter 5.

Recording your own CDs

Most CD and DVD recorders are accompanied by their own recording
programs — like Easy CD & DVD Creator 6 (see Figure 4-21), by Roxio
(www.roxio.com).

\J , .

) For complete coverage of today’s popular CD and DVD recording software,
pick up a copy of my book CD and DVD Recording For Dummies, by the good
folks at Wiley Publishing, Inc.
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However, you can record a data disc within Windows XP without a separate
commercial CD-recording application. Grab a blank CD-R and follow these
steps:

1.

Load the blank disc into your CD recorder.

Windows XP displays a dialog box asking what the heck you want to do
with the disc.

Click Open Writable CD Folder Using Windows Explorer from the list
and then click OK.

If you're not planning on installing a CD-recording application any time
soon, mark the Always Do the Selected Action check box to enable it
before you click OK.

Double-click My Computer (on your desktop) to open the Explorer
window and then select the files that you want to record to the CD
folder window by choosing the File=>Send To=>CD Drive menu com-
mand. Or, just right-click the file(s) that you want to copy and then
choose Send To~>CD Drive from the pop-up menu that appears.

While you copy the files, they’re actually magically transported to a spe-
cial folder on your hard drive. Note: Nothing has actually been recorded
yet, as XP continues to remind you!

When you’re ready to burn the disc, double-click My Computer and
then double-click the CD recorder icon to display the files in the stor-
age folder.

Note that each ghostly file or folder icon carries a funky down-arrow,
which indicates that it’s been stored and is now awaiting the Great
Writing.

Make sure that you’re copying less than a total of 650MB for a stan-
dard CD-R! For some furshlugginer reason, Windows XP doesn’t check
to make sure that you have enough room on the disc before the record-
ing begins. Therefore, take a moment and select all the files that you're
going to burn; then right-click them and choose Properties from the
resulting pop-up menu to see how much space that they’ll need.

When you’re ready to record and you’ve verified that there’s less
than 650MB of data to be burned, click Write These Files to CD in the
Task pane.

Type a volume label for the disc (up to 16 characters long) and then
click Next.

Sit back and relax — this can take some time (anywhere from 5 to 20
minutes, depending on the speed of your drive).
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Want to avoid looking like an idiot when talking
with a PC power user? Then listen up. The
round, shiny object that you load into your
CD-ROM or DVD-ROM drive is a disc, ending
with a ¢ — and net a disk, ending with a k. The
latter word more accurately describes your

The disk cognoscenti

hard disk or a Zip disk. (Think Latin, think Greek,
think discus, think discography — it’s just plain
round.) Anyone who pretends to be a PC power
user and talks oh-so-knowingly about a
CD-ROM disk or DVD disk is a dweeb. Shun
them like you would dandruff.

Watching a DUD movie

I've got to be completely honest with you — I don’t like the Windows XP
Media Player as a DVD player. That’s because it doesn’t have many of the
features of a commercial software DVD player like PowerDVD or Sonic’s
CinePlayer (see Figure 4-22). However, it’s free . . . and it doesn’t crash (two
of the characteristics of truly fine software).

Figure 4-22:
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To watch a DVD movie disc within Windows XP, run Media Player by choos-
ing Start=>All Programs~Windows Media Player. Click Play; click DVD, VCD,
or CD Audio; and then select the movie from the pop-up window. You can
switch between the window display and a full-screen display by pressing
Alt+Enter. To capture a still image from the film, press Ctrl+1.

Plus, you get the same familiar set of control buttons that appear at the
bottom of the Media Player window. They work for everything from MP3
files to digital video clips to DVDs. Oh, joy . . . rapture.
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Chapter 5: Maintaining
the XP Beast

In This Chapter

v+ Scanning your hard drives for errors

v Defragmenting to speed up your PC

v+~ Backing up your files in XP

v Using System Restore

v Using boot and recovery options in XP

v~ Taking Windows Update for a ride

M aintenance. It’s important, and you've got to do it — so why not make
it exciting? Instead of dull preventive care, think of the pit crew
around an Indy car, and . . . well, on second thought, that might be a stretch.
Anyway, you've gotta do it.

You might not find this chapter overly exciting, but if you follow on a regular
basis the procedures that you find here, I guarantee that you’ll be happy
with the performance and stability of your PC running Windows XP. And
who knows? Maybe that Indy pit crew job will materialize someday. (Even

if it doesn’t, you’ll have the smoothest-running PC on the block, and that
counts for a lot.)

Device Manager: The Hardware Tool

The first stop on your maintenance tour is the Windows XP Device Manager,
which I recommend that you check at least once a month. Device Manager is
essentially a status window that displays the operating status of each of the
hardware devices in your PC as well as the peripherals connected to it. With
one glance, you can see any hardware device that Windows has marked as a
troublemaker, and locating trouble is the first step in solving it.

Now, don’t panic at the idea of rooting around in your hardware. In fact, the
idea of a hardware conflict is easy to understand. Just about every hardware
device in your PC needs a unique pathway to be able to communicate with
the CPU and other devices. For instance, your modem must be able to send
and receive data to and from the Internet without getting spurious stuff
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that’s actually meant for your printer. (Imagine the fun that you’d have if
your hard drive and your CD or DVD-ROM drive kept exchanging data by
accident . . . harrumph.)

To keep things straight, Windows XP assigns two values that identify
devices: a direct memory address (DMA) and an interrupt request (IRQ).
Because each device in your PC needs a unique data path — think of your
e-mail or your home address — devices need unique settings for DMA and
IRQ as well. If a value is shared between two devices, Windows XP might
lock up because the operating system has no idea whom it’s talking to and
where the data is coming from.

Luckily, Windows XP does a great job allocating these hardware resources,
especially if you're using Universal Serial Bus (USB) and FireWire peripher-
als. However, sharing problems do still crop up from time to time with older
hardware that might not have an up-to-date driver. (A driver is a program
that tells Windows XP how to communicate and use a specific hardware
device.) Not only can Device Manager display what devices are causing trou-
ble, but it can also help you update the drivers for that device.

Follow these steps to use Device Manager in Windows XP:

1. Right-click the My Computer icon on your desktop and choose
Properties from the pop-up menu that appears to display the System
Properties dialog box; then click the Hardware tab.

2. Click the Device Manager button to open the Device Manager window
that you see in Figure 5-1.

If a device in the Device Manager window is marked with a yellow exclama-
tion point or a red check mark, it might be in conflict with another device,
which, in turn, might also be marked by a yellow exclamation point.

3. To check for possible conflicts with a particular piece of hardware,
right-click the marked device and then choose Properties from the pop-
up menu that appears to display its settings (as shown in Figure 5-2).

If nothing is flagged, skip to Step 5 — Windows XP has given your hard-
ware the all-clear! You might also find helpful information in the Device
Status display.

e If a Driver tab appears in the device’s Properties dialog box, you can
try updating your system with the latest driver for the device. (Go to
Step 4.) This often fixes things right away.

e If no Driver tab exists, scurry on to Step 5.
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4.

5.

Click the Driver tab and then click the Update Driver button to run
the Hardware Update Wizard.

The wizard will lead you through the process of checking for a new
driver online or from a floppy disk or CD-ROM supplied by the
manufacturer.

Don’t forget to check the manufacturer’s Web site for drivers as well.

Click OK to return to the Device Manager dialog box and then choose
File>Exit to close the Device Manager window.

If you made changes, Windows XP will prompt you for confirmation
before rebooting your PC.

If updating the driver doesn’t do the trick, display Device Manager again and
click the Troubleshoot button on the General tab to run the Troubleshooter.
(That’s Microsoft’s fancy name for the Help system, which will lead you
through possible solutions to the problem.)

Checking Your Hard Drives in Windows XP

Here are two very common misconceptions concerning hard drives I think
that I should clear up right here:

4 Hard drives do malfunction. Oh, yes. Even if you’ve never had a hard

drive crash, you've likely heard about them. Even so, today’s hard
drives are generally so reliable and so long lasting that folks often
forget. Hard drive errors can be physical (caused by a malfunction in the
drive’s hardware) or logical (where the error is in the format or the data
stored on the drive). If your PC is caught by a power failure and file cor-
ruption occurs, you're the victim of a logical file error.

Errors might not be immediately noticeable. Most logical errors won'’t
cause your PC to crash, and they might not affect files that you’re cur-
rently using, so they often go unnoticed. (They share this trait with
computer viruses, which use stealth to hide themselves.) Over time,
logical errors can cause real damage to your files and documents, so
catching them quickly is vital.

For these reasons, scanning your PC’s hard drives often (both internal and
external) for potential problems is important. Microsoft makes this easy in
Windows XP by providing an error-checking feature that you can reach from
a hard drive’s Properties panel (for you crotchety Windows old-timers, think
ScanDisk). Follow these steps to scan a hard drive for errors:



Figure 5-3:
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1. Double-click the My Computer icon on your desktop to display the
hard drives on your system.

2. Right-click the hard drive that you want to scan, choose Properties
from the pop-up menu that appears, and then click the Tools tab to
display the buttons that you see in Figure 5-3.
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3. Click the Check Now button to display the Check dialog box, which
has the settings shown in Figure 5-4.
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Always enable the Automatically Fix File System Errors check box.

4. To check the drive’s hardware for physical errors, select the Scan for
and Attempt Recovery of Bad Sectors check box and then click Start.
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Figure 5-5:
Norton Disk
Doctor can
also scan
your drives
for errors.

Note: This can take a very long time (as in two or three hours) on larger
drives (60GB or larger). I recommend that you use this feature once
every three or six months because today’s drives rarely exhibit bad
sectors until the entire drive crashes.

When the scanning program finishes, you’ll see one of two windows:

The scan completed without you needing to reboot.
Just click OK to close the scan and return to the desktop.
The scan completed, and you do need to reboot.

If the scanning program determines that you need to reboot
Windows XP to finish the error checking, click OK to close the scan.
You'll need to reboot manually (the scan is actually scheduled to run
the next time that you boot XP). Shut down any other programs that
might be running, choose Start=>Turn Off Computer, and then click
Turn Off.

Shut down any open applications that you’re running and then
reboot your PC.

Windows XP automatically completes the check-up during the boot
process.

I prefer (and highly recommend) using New Technology File System (NTFS),
which is the hard drive format first introduced with Windows NT. A hard
drive formatted as an NTFS volume is much more reliable than the old
FAT16/FAT32 formatting used in Windows 95, 98, and Me — and it’s much
harder for logical errors to crop up under NTFS.

Commercial utilities are also on the market that can check your hard drive
for errors; the most popular and best-known is Symantec’s Norton Utilities
(www.symantec.com), which includes Norton Disk Doctor (shown in Figure
5-5). [ usually recommend the Norton line of programs, but in this case, Disk
Doctor really doesn’t do much more than XP’s built-in, error-checking feature.
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Defragmenting Just Plain Rocks
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Another program that you can reach from any hard drive’s Properties dialog
box is the Disk Defragmenter. [ admit that it’s a strange name, but returning
file fragments to their proper place can significantly increase your hard
drive’s performance. (Techno-nerds call this running a defrag. Trés nerd.)

So what the heck are fragmented files? Here’s the straight skinny: Each time
that you delete or move files from one spot on your PC to the other, you
open up sections of your hard drive so that new files can be stored there.
When you're ready to save a file, however, it might not fit into any one of
the open areas on your hard drive, so Windows XP saves the file in pieces,
or segments, across several open sections.

As an example, suppose that you're downloading a 300MB game demo,

but your hard drive doesn’t have 300MB of contiguous open space handy.
Windows XP decides to save 50MB in one spot, 120MB in another, and the
rest in a third open space. When you decide to install the demo and run

the file, Windows XP automatically pulls the right data from these different
spots on your hard drive and assembles the pieces back into the original
file. (I bet you didn’t know all that was happening when that little green light
blinks on and off, but then, XP can be a mysterious beast.)

Of course, this assembly process takes more time if the file has been broken
in more pieces. And when your drive is really fragmented with little seg-
ments of thousands of files that Windows XP has to keep track of, your hard
drive performance really starts to suffer. Fragmentation slows everything
down, and Windows XP has to work harder every time that you open or
save a file.

The XP Disk Defragmenter restores the files on your drive to smooth, unbro-
ken data storage territory. (Think the Bonanza spread, but with ones and
zeroes instead of cattle.) Figure 5-6 illustrates your drive before you run Disk
Defragmenter, and Figure 5-7 shows your drive afterwards. The program
reads fragmented files, combines those nomadic segments, and then saves
the defragmented file back to the disk. Outstanding!

[ recommend defragmenting your hard drives when you’re not using your
PC because the process takes much less time to finish. Most PC owners
defragment at nights or on weekends. Shutting down programs that are
running in the background also helps. Just display the taskbar; in the notifi-
cation area at the right, right-click each icon for programs that you don’t
need, and then click Exit or Close to shut them down.
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Figure 5-8:
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To run Disk Defragmenter, follow these steps:

1. Double-click the My Computer icon on your desktop.

2. Right-click the hard drive that you want to defragment, choose
Properties from the pop-up menu that appears, and then click the
Tools tab (refer to Figure 5-3).

3. Click the Defragment Now button to open Disk Defragmenter, which
you see in Figure 5-8.

4. In the list at the top of the window, click the drive that you want to
defragment and then click the Analyze button.

This shows you a display of just how badly defragmented your drive
really is. (The more red that you see in the Estimated Disk Usage before
Defragmentation bar, the worse the fragmentation.)
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Disk Defragmenter displays a dialog box with its recommendation (view
the analysis, run the defrag, or simply close the application).

5. If warranted, click the Defragment button to start cleaning up that
hard drive.

\§
P Disk Defragmenter requires that the drive have at least 15 percent of its
total space free, so you'll have to delete files and programs that you don’t
need if your drive is full.

Be Smart: Back Up Your Stuff

In this third part of your hard drive triple-header, I talk about how you can
back up your hard drive to safeguard your data against future calamity. 'm
not going to lecture you here — oh, what the heck, yes I will — DO IT. All
smart PC owners take the trouble to save their stuff. Back up on a regular
basis, and someday (it might be years from now) you’ll send me an e-mail
message at mark@mlcbooks . com with the subject “Thanks, Mark, My Backup
Saved My Tail!” Then we can both celebrate that you did the smart thing.

P By default, the XP Backup or Restore Wizard is included only with Windows
XP Professional, but with a little harmless hacking, you can install it from
the XP Home installation disc. Double-click the My Computer icon from your
desktop, right-click your CD-ROM drive icon, and then click Explore. Locate
the \valueadd\msft\ntbackup folder and then double-click the
NTBACKUP.MSI icon, which will install Backup for you.

How often is often enough when it comes to backing up your data? That
depends completely on how often your data changes. The idea is to back up
often enough so that you always have a recent copy of your important files
close by. If you wait too long to freshen your backup, you'll find that you'll
spend far too much time restoring the changes that you made between back-
ups. For example, a small business or home office with a large, constantly
changing database might back up anywhere from every night to every three
days. (If you decide that you have to back up every night, you might want to
consider a commercial backup solution that can be automated.) On the other
hand, a typical home PC might require a backup only once a month.

P If you’d rather not use the XP Backup or Restore Wizard, either buy a com-
mercial backup application or consider copying your most important files to
a CD-RW or a Zip disk on a regular basis — including the contents of your
My Documents folder. You'll still have to reinstall Windows XP and your
major applications if you have a crash or your computer is stolen, but at
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least the irreplaceable stuff is safe. Do not use a floppy disk for this impor-
tant job because floppy disks are unreliable and might not be readable on
another PC. (I hate floppies, really I do. Have you noticed?)

Unfortunately, the Backup or Restore Wizard doesn’t support CD or DVD
backups, but most commercial backup applications, such as Retrospect
from Dantz (www.dantz.com), do allow disc backup. If you use Retrospect
or another commercial backup program, [ recommend that you use rewrite-
able DVDs as your backup media — alternatively, you can always use CD-
RWs, but you’ll need several more discs.

Although you can’t use CDs or DVDs to back up with the XP wizard, you can
back up to

4 A tape drive supported by Windows XP.

4 Zip disks. (I recommend the latest high-capacity 750MB Zip disks to
make things easier.)

4+ A network folder. (This uses space on your network’s file server or
another PC’s hard drive.)

4+ A USB 2.0 or FireWire external hard drive that’s especially made for
backups. (Nothing works as fast as another hard drive!)

4+ Floppy disks. (Oh . .. yes, you can use floppies. But please don't. It’ll
take a lifetime to back up anything , and those floppies will last as long
as a snowman in Miami.)

To back up your files with the XP Backup or Restore Wizard, follow these
steps:

1. Double-click the My Computer icon on your desktop to display the
hard drives on your system.

2. Right-click the hard drive that contains the files that you want to back
up, choose Properties from the pop-up menu that appears, and then
click the Tools tab.

3. Click the Backup Now button to run the Backup or Restore Wizard
and then click Next to continue.

4. Select the Click Back Up Files and Settings radio button and then click
Next to continue.

The wizard displays the options that you see in Figure 5-9. Decisions,
decisions.
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e If you’re the only one using the PC and you want a fast backup of
the most important things on your system, select the My
Documents and Settings radio button.
A\\S

used the default My Documents folder to keep all your personal files
and documents. (Because | have, | save media and time by choosing
the My Documents and Settings option.)

e If others also have separate accounts on your system, you can
back up their stuff as well by selecting the Everyone’s Documents
and Settings radio button.

* You can also select individual files and folders by selecting the Let
Me Choose What to Back Up radio button.

If you put your documents and files in folders that you create yourself
(as opposed to using the default My Documents folder), you should use
the Let Me Choose What to Back Up option.

You'll notice that you can also go the whole route and back up the entire
drive — but only if you're using XP Professional — by selecting the All
Information on This Computer. This option uses Automated System
Recovery (ASR), which I describe later in this chapter, and ASR is not
included in XP Home. Remember, Microsoft thinks that XP Home users
won'’t have installed the Backup or Restore Wizard. Sorry about that.

5. Click Next to continue.

If you select the Let Me Choose What to Back Up radio button in Step 4,
you’ll see the Items to Back Up page of the Backup or Restore Wizard
that you see in Figure 5-10.
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6. To choose a destination drive, click the Choose a Place To Save Your
Backup drop-down list box; to choose a specific folder, click the

Browse button.

7. Type a descriptive name in the Type a Name for This Backup text box

and then click Next.

I recommend that you use today’s date as part of the name as well as

the name of the source drive.

The wizard displays a summary screen like the one that you see in

Figure 5-12.

8. If you approve of the settings, click Finish, and the backup process

begins.

To restore from a backup that you’ve made, load the backup media, follow
Steps 1 through 3 above, and then mark the Restore Files and Settings radio
button. The wizard will display the backups that you’ve made and allow you
to select the files and folders that you want to restore (using the same file
selection boxes that I describe in Step 5). Click Finish and breathe a sigh of
relief.

Completing the Backup or
Restore Wizard
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Safeqguarding Vour System with System Restore

Remember when you were a kid, and you held your fingers crossed behind
your back when you made a promise? A “take-back” was a big deal back
then. And even though you're all grown now, XP gives you the chance to

say, “I take it back!” if an installation goes awry.
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This great feature is System Restore, which allows you to set restore points
(think of them as snapshots of your important system files) that you can
return to whenever XP experiences problems. Most folks turn to System
Restore if the installation of new hardware or software causes instability in
XP; I've also used it when a system file has accidentally been erased or
altered. Note that System Restore can recover only your XP system files, so if
you accidentally trash Aunt Harriet’s prized family brownie recipe, you're
still out of luck. (Symantec’s Norton Utilities includes Norton Protection for
your Recycle Bin, which can help you recover Aunt Harriet’s treasure from
accidental deletion.)

XP automatically saves restore points on a regular basis (at least once every
day), but you can follow these steps to manually create a restore point as a
safety net — for example, if you're about to install a new device.

After you apply a restore point, XP must reboot. Therefore, I recommend
closing down any applications that you have running with open documents
before you run the System Restore wizard.

Follow these steps to create a new restore point:

1. Choose Start=>All Programs->Accessories=>System Tools=>System
Restore to run the System Restore wizard (see Figure 5-13).

Tabegn, select the task that you want Lo perform

=) Ao ey Cisdular 1D oty Uee

Ravoribod lits

) Cogabe 5 reove poirk

ey changes that Syt Eestore malos to yourn congutes
e compintaily reverubie

5 (callied
Bilare
you ¥
th ad

Tio cortinuss, sollect an optios, and then chick Mext l!u » k.‘_. i

Book II
Chapter 5

Jseag dx
ay) buluejurepy



176

Figure 5-14:
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2. Select the Create a Restore Point radio button and then click Next.

3. In the following wizard window, type a descriptive name in the
Restore Point Description box — something like XP before adding
new video card — and then click the Create button.

XP displays a confirmation message indicating that the restore point
has been successfully saved.

4. Click Close to return to your desktop.

If you need to use a restore point to recover from a calamity, follow these
steps:

1. Choose Start=>All Programs=>Accessories>System Tools=>System
Restore to run the System Restore wizard.

2. Select the Restore My Computer to an Earlier Time radio button and
then click Next.

The wizard displays the calendar view that you see in Figure 5-14.
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3. Click a date (when you created the restore point) to display the points
that you can use for that date in the list box on the right, click the
desired point to highlight it, and then click Next to continue.

XP displays a confirmation message with information about the point
that you chose.

4. Click Next to apply the restore point.

Have At Thee, Foul Virus!

One of the first book chapters that I ever wrote concerned viruses — that Book Il
was way back in 1992.  recommended a number of antivirus applications Chapter 5
(only one has survived to this day: McAfee VirusScan) and a number of
guidelines to help readers avoid viral infection. Unfortunately, many folks
ignored viruses back then and paid the price later.

Viruses are much harder to ignore these days. The number of viruses circu-
lating today has jumped dramatically, and you read about viral attacks con-
stantly in your newspaper and your favorite news Web sites. What’s more
incredible, Microsoft doesn’t include any antivirus protection in Windows
XP! Luckily, antivirus software has not only stayed current with “infection
technology.” In fact, the good guys are now out in front, and I'm happy to
report that in 2003, it’s child’s play to surround Windows XP with a protec-
tive antiviral wall.
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How easy? Just install either Norton AntiVirus 2003 ($50; www . symantec.
com), shown in Figure 5-15, or McAfee VirusScan 7 ($60; www.mcafee.com),
and sit back and watch the viruses beat themselves to deletion trying to get
to your system. Unlike the antivirus software of 1992, when you had to scan
for viruses from the DOS command line once a day, everything now works in
real time. Although you can (and should) still scan your entire system manu-
ally once every 6 months or so, your antivirus program will monitor every
document that you open and every program that you run in the interim. It’s
actually fun to open your e-mail and see viral-laden spam identified and
killed before you even open the message.

These packages will cover the entry points used by viruses to reach your
PC, including

4+ Your e-mail

4 Programs that you download or receive on disk or CD from others

4+ Office documents that might contain dangerous macros
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Figure 5-15:
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However, here is one important task that you must never take for granted,
and it’s definitely a Mark’s Maxim:

Keep your antivirus data files up to date, or you're toast.”

This step is so important that today’s antivirus programs can automatically
update their data files without your help! (As long as your PC can connect to
the Internet, anyway.) Why? Well, without the latest data files, your
antivirus software is out of date, and the latest viruses can attack your
system undetected.

Windows XP Boot and Recovery Options

Ninety-nine percent of the time when you boot Windows XP, you'll be talking
on the phone, or pouring another Diet Coke, or perhaps looking through
your (paper) junk mail. That’s because XP requires no help when it’s run-
ning normally. You just press your PC’s power button and wait.

However, if your PC isn’t working correctly, you might need one of the
options available during XP’s boot process. In this section, [ take you on a
tour of what you can do in Windows XP before your attractive desktop
appears.
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Using Safe mode

Think of Safe mode as generic Windows XP. If a hardware device conflict is
locking up your PC, or if a driver that you recently installed or updated is
causing Windows to crash, you can use Safe mode to run XP in a stripped-
down mode.

In Safe mode, external devices can’t be used, and much of the functionality
available with your internal hardware will also be disabled. For example,
you’ll immediately notice that your fancy video card is using the lowest res-
olution possible at 640 x 480 . . . but at least you can move or delete files and
use Windows Explorer.

To use Safe mode, reboot your PC and press the F8 key when you see the
scrolling-line display (before the Windows banner screen appears, so you
only have a second or two). Then choose Safe Mode from the Advanced
Options menu and press Enter.

You’ll also notice two other specialized forms of Safe mode:

4+ Safe mode with networking (where XP loads network drivers and serv-
ices so that you can log on to your network). If you need to copy files
from a network server or copy your latest documents to a network
drive for safekeeping (just in case), this is the Safe mode to use.

4 Safe mode with command prompt (where Windows XP loads in Safe
mode but reverts to that cryptic DOS-like command prompt). This
option should be used only at the request of a tech support person.

Using the Last Good Configuration

Here’s another boot option that’s a favorite with anyone who’s facing severe
problems with Windows. XP automatically stores the last-known, working
system configuration — including drivers that were loaded successfully and
system settings that worked — and offers that as a choice on the Advanced
Options menu. By choosing this option, you effectively reset your XP config-
uration to how it was before your problem cropped up. It doesn’t work
every time — for example, it won’t restore missing system files — but it’s a
much better choice than reinstalling Windows, using ASR (see the following
section), or the hassle of restoring from your backup (see the earlier section
“Safeguarding Your System with System Restore™).

To use this feature, reboot your PC and press the F8 key when you see the
scrolling-line display. From the Advanced Options menu, choose Last Known
Good Configuration and then press Enter.
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Using ASR

Automated System Recovery (ASR) is a feature of the Backup or Restore
Wizard that I cover earlier in the chapter. With ASR, you XP Professional
users can restore your Windows XP configuration in case you have a mas-
sive meltdown, and your Windows system files have been damaged so
badly that using a restore point won’t work. Note that I'm just talking to
XP Professional owners now because ASR isn’t included in XP Home.

To create an ASR image, follow the backup procedure that [ provide in the
earlier section “Be Smart: Back Up Your Stuff.” In Step 4, select the All
Information on This Computer radio button. This launches the ASR portion
of the wizard, which will lead you through the rest of the process. (It’s actu-
ally just like the regular backup process except that the wizard prompts you
to load a floppy disk to store partition information; you’ll need this floppy
disk in a second.)

However — listen up here — an ASR recovery does not restore your docu-
ments and other data! The ASR security blanket only includes your system
files and XP system configuration, which Windows XP will use to recover
itself. You have to back up your personal files, data, and documents with the
process that [ describe earlier.

When the dreaded moment arrives, and Windows is dead in the water —
hopefully never — you can restore using ASR by following these steps:

1. Load your XP Professional installation disc into your CD or DVD
drive.
2. Close any open applications and reboot your PC.

You might have to press a specific key to boot your PC with the XP
Professional installation disc.

3. Look for the prompt that tells you to press F2 to use ASR and then
pounce on that key like a fierce jungle cat.

4. Load the floppy disk created by the Backup or Restore Wizard.
5. Load the backup file that you created during the ASR process and
follow the instructions that appear.

In effect, Windows XP actually reinstalls itself by using the configuration
data and system files from your ASR backup . . . pretty neat, I think. (I just
hope that [ never have to use it.)
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Using Windows Update

Figure 5-16:
Set
Windows
Update for
automatic
operation.

Windows Update is a gas. It automatically searches for XP patches and
upgrades from Microsoft and then applies them while you relax. This is a
good thing because any piece of software as complex and powerful as
Windows XP is going to need frequent patching (especially since every
hacker on the planet wants a piece of His Billness). The two methods of
using Update are that you can either leave it completely to XP or that you
can run Windows Update manually.

The fully automatic way

XP can take care of virtually all the update process in the background, so
you’re not bothered with it. To configure Update to run automatically, you
must be logged in as an Administrator user. Follow these steps:

1. Right-click the My Computer icon on your desktop; from the pop-up
menu that appears, choose System Properties.

2. From the System Properties dialog box that appears, click the
Automatic Updates tab, which displays the settings that you see in
Figure 5-16.
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3. Select the Keep My Computer Up to Date check box to enable it.

4. For completely automatic updates at a scheduled time, select the
Automatically Download the Updates, and Install Them on the
Schedule I Specify radio button.

5. Click the first drop-down list box to select the day for updating and
then click the second drop-down list box to choose the time.

6. To have XP notify you when updates have been downloaded, select
the Download the Updates Automatically and Notify Me When They
Are Ready to Be Installed radio button.

XP displays a message in the taskbar’s notification window, allowing you
to see what you're installing beforehand. (Some folks care; others
simply want the latest updates.)

7. Click OK to return to your desktop.

The (somewhat) manual way

You can also run Windows Update at any time. Perhaps you've heard of an
important patch that Microsoft has just released, or you just want to
impress your spouse. For whatever reason, follow these steps:

1. Open Internet Explorer (just click its icon on your desktop).

Yep, that’s one of the easiest ways to get to Windows Update — at least,
[ find it the easiest. (Plus, the manual version of Windows Update actu-
ally runs inside Internet Explorer, so it makes sense.)

For the lowdown on Internet Explorer, skip ahead to Book IIl, Chapter 4.

2. Choose Tools>Windows Update to display the page that you see in
Figure 5-17.

3. Click Scan for Updates.

After a bit of thrashing and churning, Internet Explorer updates the
panel on the left of the screen with any updates it finds, and the number
of updates in each category is displayed.

4. Click the desired category to view its updates

A short description of each update is given, and you can click the Read
More link to display more information.
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5. To add an update item to the download list, click the Add button next
to the item’s description.

Note: Items in the Critical Updates and Service Packs category are
automatically added for you, but some items must be downloaded and
installed separately from other items. Update will take care of this for you.

6. After you mark all the update items that you want to apply, click
Review and Install Updates.

This displays the summary page that you see in Figure 5-18, where all
the updates to be downloaded and applied are listed for you.

7. Click the Install Now button to begin the update process, following
any onscreen instructions.

Note that if XP must reboot to install a critical update or Service Pack, you’ll
have to rerun Windows Update to install any other update items.
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Figure 5-18:
Make one
last check
of the
proposed
updates
before

you go.
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Chapter 6: Taking Control
of the Control Panel

In This Chapter

v+ Configuring the Control Panel the right way
v+ Setting your PC’s date and time

v Tweaking your display settings

v Adding scheduled tasks

v~ Fine-tuning power options

v Adjusting your keyboard

+ Changing mouse settings

v Fine-tuning power options

v Setting Internet options

+* Removing programs the right way
1 Configuring user accounts

v Setting your phone and modem options

p icture this: You're the engineer on the bridge of the starship Enterprise —
the first one, the real Enterprise — and Captain James T. Kirk suddenly
bellows, “I need more power!” in your direction. Where do you turn? What
panel has the right randomly blinking lights and the right fake switches?

In the Windows XP galaxy, my friend, you (and Scotty) need go no farther
than the XP Control Panel (where all the switches are real). Just about all
the check boxes, drop-down list boxes, and buttons that determine how
Windows XP acts are available from this one menu item. And in this
chapter, [ show you how to poke a tiny flashlight into the most commonly
used Control Panel dialog boxes to fix your starship’s shields. (Whoops.

[ mean, customize Windows XP for your needs.)

Sorry — like most other first-generation techno-nerds, I really enjoy my
Star Trek.
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But First, Put the Control Panel on the Start Menu!

Figure 6-1:
Configure
the Control
Panel as a
Start menu
pop-up.

To open the Windows XP Control Panel the right way, it should be configured
as a pop-up menu on the Start menu. The default Windows XP category view
is about as convenient as a car wash in a monsoon: You can use it, but why?
A true PC power user will jettison the default Control Panel in a heartbeat.

Follow these steps to configure the Control Panel as a Start menu pop-up:
1. Right-click the Start button and then choose Properties from the

menu that appears.

2. In the Properties dialog box that appears, click the Customize button
and then click the Advanced tab to display the settings that you see in
Figure 6-1.

Customize Start Menu W)
Gansal Advanced
1] Ohginn, subimanisn wiliin | Bl o B willh S oL
W | TRy ep—

3. In the Start Menu Items list, find the Control Panel section and then
select the Display as a Menu radio button.

4. Click OK to exit the Advanced settings and then click OK again to
save the change to the Start menu.

Voila! Now click Start, move your mouse pointer over the Control Panel
menu item, and revel in all that pop-up goodness, as shown in Figure 6-2!
Now you can access any of the Control Panel dialog boxes that I cover in the
rest of this chapter with just two mouse clicks.



Figure 6-2:
That, sir and
madam, is a
power user
Control
Panel.

But First, Put the Control Panel on the Start Menu!
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You'll note that each Control Panel dialog box sports two spiffy buttons:
Apply and OK. These actually do the same thing — any changes that you've

made get saved — but here are two important differences:

4+ OK: When you click OK, the dialog box closes, and you can make no
more changes to that dialog box. Because many Control Panel dialog
boxes have multiple panels (each of which might have a setting that you
want to change), it makes sense to click Apply if you need to hang

around.

4+ Apply: When you click Apply, Windows XP makes the setting change
immediately. Usually, a setting change won’t do anything obvious right
off the bat, but if you're working in the Display Control Panel dialog box,
you’ll usually be able to see what changed (like your background or
your screen resolution). If you don’t like the effect that you've just
wrought, you can easily choose another setting without the hassle of
opening the dialog box again.

Book II
Chapter 6
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Configuring the Date and Time

Figure 6-3:
Oh dear, is
that the
time?

The first stop on the Control Panel tour is the Date and Time Properties
dialog box. Check out its first tab, Date & Time, as shown in Figure 6-3.
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Settings on this tab include

4 The month and year boxes: Click the month drop-down list box to
choose the current month. Then use the up- and down-arrow buttons to
set the year, or you can just click directly in the year box and type the
year.

4+ The calendar display: To select the current day, click it in the calendar
display.

4 The Time clock: You can either click the hours:minutes:seconds display
and then click the up- and down-arrows to set the time, or you can —
I love this — click and drag the hands of the clock. (Gotta love that
Microsoft, eh? An analog anachronism in a digital world.)

The Time Zone tab

Click the Time Zone tab to set your current time zone via the drop-down list
box. You can also set Windows XP to automatically adjust for daylight
savings time.

The Internet Time tab

The last tab of this Properties dialog box is my favorite: Click Internet Time
to display the settings that you see in Figure 6-4. If you've got an Internet



Figure 6-4:
Yet another
use for “that
Internet
thing.”

Changing Display Settings 189

connection that you use every day — either a dialup or an always-on digital
subscriber line (DSL)/cable modem connection — you can set XP to auto-
matically set its own clock by using an Internet time server! Forget setting
the clock manually.

Date and Time Properties A% |
Date & T Time Zome | Sthornat Tase
[FHRatcmatically gyrchwonion with an Bstarmat tme sorwr
Savie | L DR Qe - Wckat Mg

Select the Automatically Synchronize with an Internet Time Server check
box to enable it and then click the Server drop-down list to select a time
server. | personally prefer the time.nist.gov server because the idea of
handing over my PC’s time to the Redmond Empire is somewhat unsettling.
(Sure, Mark — like they don’t already control your waking hours through
Windows XP?)

Changing Display Settings

Most PC owners have seen the Display settings shown in Figure 6-5. You can
also get to them by right-clicking any open space on your XP desktop and
then choosing Properties from the pop-up menu that appears.

The Themes tab

On the Themes tab, you can click the Theme drop-down list and choose a
Microsoft desktop theme. Or, you can save your own theme with your cur-
rent desktop background, color scheme, icons, and sounds by clicking the
Save As button and then typing a new name in the File name box. Then click
Save to seal the deal.

Book II
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Figure 6-5:
Display
properties
are avail-
able on

a desktop
near you.
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The Desktop tab

Click the Desktop tab to choose a background from the list there. If you want
to load your own picture, click the Browse button and then navigate to the
location of the image. (XP automatically updates the Preview image in the
middle of the dialog box.) Although an image with a lower resolution can be
stretched to fit across your entire desktop from the Position drop-down list
box, don’t be surprised if it loses quality. Instead, pick Center to put it in the
middle of the desktop — or if the image is a repeating pattern, choose Tile.

To use a plain-color background, choose None in the Background list, click
the Color drop-down list, and then pick your favorite shade.

Click Customize Desktop on the Desktop tab to specify which icons you
want to appear on your desktop or to choose different icons.

The Screen Saver tab
Click the Screen Saver tab to configure these settings:

4 The screen saver: Click this drop-down list to choose a Microsoft
screen saver or a screen saver that you've installed yourself.
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WING/
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Beware some screen savers

It's very easy to write a “bad” screen saver —  system that's not from Microsoft. Your antivirus
by that, | mean a screen saver that can slow program should be running, and you should
down or even hang your PC. (Because of their  watch your PC’s performance carefully after the
popularity, screen savers are also prime targets  screen saver has been running to make sure
for spreading viruses.) Therefore, take care thatit hasn't caused any problems.

when adding a new screen saver to your

Book I
Chapter 6

4 Settings: If the screen saver has any configuration options (like toggling
sound effects on or off, or increasing the number of flying small appli-
ances on the screen at once), you can set them by clicking the Settings
button.

4 Preview: Click this button to see how the selected screen saver will
look. To return to the Display dialog box, move your mouse.

|aued [ouo) ay)
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Click the up- and down-arrows to choose the delay period before the screen
saver will kick in. You can optionally require your user password to be
entered before the screen saver will return you to Windows XP.

Click the Power button to display the Power Options tab, which I describe
later in this chapter.

The Appearance tab

This tab is home to these settings:

4 The windows and buttons style: Click this drop-down list box to switch
between the flashy, oh-so-modern Windows XP appearance and the ho-
hum, mundane classic Windows appearance.

4+ Color scheme: You can select a color scheme that applies throughout
Windows XP from this drop-down list box.

4+ Font size: If you're having trouble reading smaller text on your desktop —
like icon labels, for example, or menu titles — click this drop-down list
box and then choose Large or Extra-Large fonts.
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To select or disable the animated transition effects for menus — or to
switch between large and regular icons — click the Effects button.

A\
If you're running Windows XP on an older Pentium Il PC (or you're using a
video card that’s two or three years old), | recommend disabling the
Transition Effects and the Show Window Contents While Dragging check
boxes of the Effects dialog box.
A\
Click the Advanced button to set the color and text formatting attributes for
desktop screen elements such as title bars, menus, and scrollbars.
The Settings tab
From the Settings tab (as shown in Figure 6-6), you have the following smor-
gasbord to choose from:
4 Screen Resolution: Click this slider and drag it to set a new screen
resolution.
4+ Color Quality: Whenever possible, leave this value set to 24-bit or 32-bit
color. However, if you have an older video card, you might not be able
to display higher resolutions at these color-quality levels.
Display Properies A% |
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Click the Troubleshoot button to display the Windows XP Video
Troubleshooter. Clicking the Advanced button displays a number of video
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Scheduling Tasks

card and monitor-specific settings; generally, unless you're told by a techni-
cal support person to change these, leave these alone.

Scheduling Tasks

If you need Windows XP to automatically run a program at a certain time
every day (or at a regular period), you can schedule that task from the
Control Panel. For example, you might like to run a network-monitoring pro-
gram on your office PC each night after you're gone. (Or, in my case, I like to
run the great freeware utility Ad-Aware 6 from LavaSoft (www.lavasoft.
com), which helps remove “ad-ware” surreptitiously installed by many share-
ware applications and online Web stores; I've set it up as a regular, daily
scheduled task. Some ad-ware programs monitor the Web sites that you visit
or send information back to the developer about your system . . . actions
that I label as JPI, or Just Plain Intolerable.

Figure 6-7:
Selecta
program to
schedule.

Follow these steps to add a scheduled task:

1. From the Control Panel menu, choose Scheduled Tasks=>Add
Scheduled Task.

Windows XP runs the Scheduled Task Wizard, which displays its wel-
come screen.

2. Click Next to continue.

The wizard displays a list of suggested applications (see Figure 6-7).

[ Scheduled Task Wizard
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3. If the program that you want to run is in the list, click it. If the pro-
gram isn’t in the list, click the Browse button, navigate to the location
of the application, and double-click it. Then click Next to continue.
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Figure 6-8:
Daily
settings for
a scheduled
task.

4. The next wizard screen prompts you to type a descriptive title for

your new task and choose the schedule period (schedule choices
include One Time Only, When My Computer Starts, and When I Log
On). Then click Next to continue.

The contents of the next wizard screen depend on the schedule period
that you pick. For example, Figure 6-8 shows the settings for the daily
schedule.

e

5. Select the settings that you need and then click Next to continue.

The next wizard screen prompts you for your XP account information.
Why? Well, because by default, the task is scheduled to be run in your
name.

. Click in the Enter the Password box, type your XP user account pass-

word, press Tab, and type it again to confirm it. Then click Next to
continue.

If you change your XP user account password, you should also update
your password on your tasks. Otherwise, a task with an improper pass-
word might prevent you from logging on later! To update the password
for a specific task, choose Start=>Control Panel=>Scheduled Tasks,
right-click each task in the pop-up menu that appears, and then click
Properties to display the Properties dialog box for the selected task.
Click the Set Password button on the Task pane, type the new password
in the Password box, and then type it again in the Confirm Password
box. Click OK to save your password change.

By the way, you can also temporarily disable a scheduled task from the
same Task Properties dialog box. Just clear the Enabled (Scheduled
Task Runs at Specified Time) check box. When you want the task to run
again, return to this pane and enable the check box.



Figure 6-9:
Begone,
ad-ware —
my sched-
uled task
will take
you out!

Adjusting the Power Options

195

7. The final wizard screen (as shown in Figure 6-9) summarizes the task

schedule that you’ve created.

Click Finish to close the wizard.
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Adjusting the Power Options

Open the Control Panel menu and choose Power Options to display the

Figure 6-10:
Selecta
power
scheme
here.

dialog box that you see in Figure 6-10.

Pawer Optioms Properties e
Povae Schemes | Advanced | Hibemate | UPS
Y L Salec B powwin R vl B Mol agpegeale WRng: ki

e compuber Mols il changing e 1omings Deloes will madily
L L

Homo/{fxe (e -

Tusn off monior fnan 30 s -
Tuian o hand b Mot ~
Sy slirviRey Hevin bl |

CE [ oo ]

Book II
Chapter 6

|aued [ouo) ay)
10 Jopuo) Bunjey



’96 Adjusting the Power Options

\\3

The Power Schemes tab

The Power Schemes tab allows you to choose a default power scheme,
which controls the steps that it takes to conserve power. Power conserva-
tion is a handy trick for laptop PC owners but still important for desktop PC
owners as well. The settings include

4+ Power Schemes: Click this drop-down list to specify a power scheme
(either one of the default schemes or one that you've saved by using the
Save As button).

4 Turn Off Monitor: Here, select the amount of inactivity that Windows
XP will wait through before switching your monitor to standby mode
(where the screen goes blank, and the power light usually flashes or
turns a different color). The monitor is automatically turned back on
when you move your mouse or press a key.

Today’s liquid crystal display (LCD) monitors use less power than tradi-
tional cathode ray tube (CRT) models, but you'll save a surprising amount
of money when any monitor is switched to standby. In fact, your monitor
probably uses more electricity than your PC! Therefore, I always set this
value to the smallest amount of time that I can (without the feature becom-
ing a hassle or inconvenience, where I'm constantly having to awaken my
screen). For me, this is typically the After 30 Mins setting.

4 Turn Off Hard Disks: Click this drop-down list to determine how long of
a period of inactivity Windows XP will wait through before powering
down your hard drive. [ know that sounds dangerous, but it’s actually a
harmless feature that will save you energy because your hard drives will
no longer be kept spinning unnecessarily. Like your monitor in standby
mode, a mouse movement or a key press will return your hard drives to
active duty.

4+ System Standby: Most PCs made in the last two or three years support
standby mode, in which the entire PC (instead of just your monitor and
hard drives) switches to low-power mode. Click this drop-down list box
to select the period of inactivity required to activate standby mode.
Again, mouse activity or the press of a key on your keyboard should
return your PC to life, with all programs and files intact. However, some
older PCs might require you to press a button on the PC’s case to return
to full power.

After you choose your power scheme settings, you can click the Save As
button to save the scheme under a new name.
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The Advanced tab

If you need to tweak the operation of your PC’s power button or configure
the task bar icon, click the Advanced tab. The settings on this tab include

4+ Always Show Icon on the Taskbar: If you're using a laptop PC, the
power taskbar icon shows you an approximate estimate of your remain-
ing battery power (as a tiny battery, no less, which slowly drains of
color). When your laptop is plugged into an AC outlet, the icon also
displays when your battery is charging. (Of course, desktop PC owners
can disable this check box and regain room in the taskbar.)

4+ Prompt for Password: This is a similar security feature to the screen
saver password check box. You can require XP to prompt for your user
password before you're allowed to return from standby mode.

4 When I Press the Power Button: PCs made in the last two or three
years allow you to actually specify what action Windows XP should take
when you press the power button on your computer: You can opt to
shut down the PC, do nothing (think the wandering fingers of a three
year old), prompt for the action to take, or switch immediately to
standby mode.

The Hibernate tab

As 1 explain earlier, your PC can hibernate instead of entering standby mode.
The difference is one of security for your data. In hibernation mode, the con-
tents of your PCs memory are saved to your hard drive; thus, if a power failure
occurs, you won'’t lose any work. “Waking up” from standby mode is quicker
than hibernating because the data doesn’t have to be reloaded from disk, but
you run the risk of losing your files.

Select the Enable Hibernation check box to use hibernation mode. Note that
some PCs won'’t be able to use hibernation because their motherboards lack
this feature — in such cases, the Enable Hibernation check box is grayed out.

The UPS tab

If your PC’s uninterruptible power supply (UPS) unit supports Windows XP’s
status mode, this tab will display both an estimate of how long the UPS will
run in case of a power failure and the condition of the battery. (You’ll find
more about UPS units in Book I, Chapter 2.)

Most UPS manufacturers come with an install CD that configures the manu-
facturer and model settings on this dialog box, but if you must set things
manually, click Select and then choose your UPS and the serial (or COM)
port that it’s using.
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Tweaking the Keyboard

Figure 6-11:
Customize
your
keyboard
settings
here.

Choose the Control Panel menu and choose Keyboard to display the
Keyboard Properties dialog box, as shown in Figure 6-11.
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The Speed tab

You can use the settings on this tab to customize your keyboard to fit your
preferences:

4+ Repeat Delay: Drag this slider to specify how long Windows XP will wait
before repeating a character when you hold down a key. (If you're a
slower typist and your keys keep repeating, set this slider closer to
Long.)

4 Repeat Rate: Drag this slider to set the rate at which characters are
repeated when you hold down a key.

To test the repeat delay and repeat rate, click in the test box and hold down
a key.
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Adjusting Thy Mouse

If you have multiple keyboards (or an input device configured as keyboard,
like some specialized game controllers), you can display the properties of
that device (including information about any driver software that it
requires) or troubleshoot it from this tab.

If you're having problems with your keyboard, click the Troubleshoot
button to display the Windows XP Keyboard Troubleshooter, which is a
wizard that leads you through the keyboard troubleshooting process.

Adjusting Thy Mouse

The settings that you see when you choose Control Panel=>Mouse will vary
according to the manufacturer of your mouse. For example, my Logitech
trackball displays a completely different Mouse Properties dialog box (see
mine in Figure 6-12) than does a Microsoft mouse because Logitech supplies

Figure 6-12:
My Logitech
trackball
has these
Control
Panel
settings.

its own mouse driver.
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No matter which pointing device you own, however, you're likely to find the
following settings. They might be named slightly differently, but they should

be there, nonetheless.
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4 Middle button function: You can specify what action is produced when
you click the middle button on a three-button pointing device.
Possibilities might include a double-click; cutting or copying; maximiz-
ing or minimizing the active window; or even running a program that
you specify. (Personally, | have mine set as a double-click because it pre-
vents accidental double-clicking with the left button, which sometimes
happens when you only wanted to click the left button once.)

4+ Pointers: You can usually choose either a Windows XP pointer scheme
or assign your own pointer symbols.

4 Mouse trails: This feature adds a number of trailing pointers when you
move your mouse. This is a very helpful trick when you’re using a
laptop because the mouse pointer is often hard to find on a laptop
screen. Visually impaired PC owners might also find this helpful.

4 Acceleration: If you enable acceleration, your mouse pointer moves
faster the farther you move it. This is a good idea for those running
their desktops at a whopping 1600 x 1200 resolution, where the mouse
can seem to take forever to get anywhere!

Configuring Internet Properties

Figure 6-13:
My
heavens,
what a
dialog box!

Next on the Control Panel hit parade is the always-fascinating world of
Internet Properties (Figure 6-13 bears all). Sit back for the ride, folks, 'cuz
this is gonna be a big 'un. (And that’s partly because many of the settings
that should be tucked away in Internet Explorer are instead dumped here.)
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The General tab

This tab allows you to set

<+

<+

Your Home Page: In the interests of brevity, you'll find a complete dis-
cussion of this setting in Book IlI, Chapter 4.

Temporary Internet Files: Internet Explorer (IE) uses these cache files
to speed up the display of pages that you've already seen, but after a
while, they can become true hard drive hogs. You can elect to delete all
the temporary files in one fell swoop by clicking the Delete Files button,
or you can simply click the Settings button and drag the file folder disk
space slider to 3 or 4MB. (That will prevent too much waste, and you
won’t have to use the Delete Files button any longer.)

You might be wondering what cookies are doing in this dialog box. The
name actually has nothing to do with baked goods in this context.
Instead, Web cookies are small files that are saved to your hard drive by
your Web browser to allow Web sites to automatically determine who
you are. (Ever wonder how Amazon.com always knows that it’s you who
is visiting? That’s because of a cookie.) Most cookies are innocuous
(and some sites even require them), but they can be used to store infor-
mation about you, the sites that you visit, and the type of Web browser
that you use. So, if you like, you can click the Delete Cookies button and
wipe ’em out. Also, many Internet security programs — such as
Symantec’s Norton Personal Firewall (www.symantec.com) — will take
care of cookies as well by either blocking them or by prompting you to
determine whether you want to accept them.

Your History: Again, a lot of this stuff applies only to IE. I discuss the
History file in detail in Book IlI, Chapter 4.

Colors: Click this button to specify the colors that you want to use for
links (both visited and new), the default text color on Web pages, and
the default background color on Web pages.

Fonts: A click here specifies which fonts are used when a Web page
doesn’t include its own font definition.

Languages: Internet Explorer can display multiple languages. Click here
to select which languages you need or to add extra language packs that
you’'ve downloaded.

Accessibility: To force IE to use your font style, font color, and font size —
no matter what the page is designed to do — click this button. (These
features help folks with limited eyesight who have customized their
browser font settings.)
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Figure 6-14:
Setyour
browser
security
level.

The Security tab

You'll see the settings shown in Figure 6-14 on the Security tab:

4+ The Web content zone: Betcha didn’t know that you could specify dif-

ferent security sites for the Internet as a whole, your local company
intranet, and the Web sites that you trust (and those that you’'d like to
restrict), did you? Click the desired icon to set the security level for that
zone. To add sites to the zone that you've selected, click the sites
button.

4 The security level: Drag the slider here to specify a security level, and

Windows XP displays the actions that it will take based upon the secu-
rity level that you choose. You can build your own custom security level
by clicking the Custom Level button, or you can return this zone to
what Microsoft feels is appropriate by clicking the Default Level button.
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The Privacy tab

The Privacy tab is another “slider” tab, as you see in Figure 6-15. However,
the settings that you find here affect only the Internet zone:

4+ The privacy level: Drag the slider to choose an overall privacy setting for

the Web sites that you visit. Note: This also controls the cookies that I
mention a bit earlier in this section. Each privacy level is described next
to the slider. To import an existing IE privacy preferences file — some-
thing that your company might ask you to do — click the Import button.
Click the Advanced button to override the cookie handling at the privacy
level that you've chosen; you can specify your own cookie handling here.
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4+ Web site privacy: Heck, if you're really interested in security, you can
even click the Edit button to specify the cookie handling for individual
Web sites! This might be just the ticket if a site that you like to visit
requires you to use its cookies, but you eschew cookies otherwise.
(Man, that is one ridiculous sentence. Who named these things,
anyway? Pee Wee Herman?)
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The Content tab
Here’s a tab that will interest every parent who’s concerned about kids surf-
ing the Web (hang ten on Figure 6-16). The Content tab settings here include
4 The Content Advisor: You can enable the Content Advisor to protect your
kids, but be aware that it’s nowhere near perfect. Although to be honest,
no Web content filter really is, including the expensive commercial pro-
grams. Why? Well, some sites rate themselves incorrectly. And other sites
include valuable medical and artistic information that might inadvertently
trigger alarms — for example, if you're searching for information on the
human body for a science project. Anyway, to choose a level of content
safety, just click the Enable button and drag the “offensive” slider.
P My recommendation is that you enable this feature only if you feel that

it’s absolutely necessary — and that you don’t rely on it as a foolproof
solution. (Instead, many parents simply limit Internet access to one
computer and keep a close eye on what’s being seen. This isn’t a
foolproof idea, either, but in my opinion, it’s better than relying on
imperfect software.)
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Figure 6-16:
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4+ Certificates: These controls allow you to verify your identity to a Web

site; many companies use certificates to ensure the privacy of their
intranet data. Certificates can get pretty complex, which is why most
normal human beings don’t bother with ’em.

AutoComplete: With AutoComplete enabled, IE automatically fills out
online forms, Web addresses, and user name/password combinations
that you've previously entered on a site. Click the AutoComplete button
to specify which types of data you want filled out. You can also clear
your AutoComplete history or clear the passwords in the history.

My Profile: Click this button to select an Address Book entry that IE
should use as your Personal Profile. This is typically used only when
sending an e-mail message from a link on a site or when a site requests
your personal information. (Naturally, [ get edgy about this one, so be
careful what you enter in your profile.)
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The Connections tab

The settings on this tab can be used to set up a dialup Internet connection,
a Virtual Private Networking (VPN) connection, or a special proxy server
configuration; you can also modify your local area network (LAN) Internet
connection. Again, this ground is covered in other chapters, so I won’t
repeat myself here. To wit:

4 Setting up a dialup connection is covered in Book II, Chapter 3.

4 Setting up a VPN connection is covered in Book VIII, Chapter 4.
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4 Setting up a LAN connection to the Internet is covered in Book VIII,
Chapter 2.

To set up a proxy configuration, you’ll need several pieces of information
from your network system administrator or your Internet service provider’s
(ISP) technical support department. And you should only set up and use a
proxy server at their specific request because configuring or using one
incorrectly can seriously mess around with your dialup and VPN connec-
tions. Therefore, leave any proxy settings alone unless you're told to change
’em. (I do the same thing, so don’t feel bad.)

The Programs tab

Figure 6-17 illustrates the Programs tab; from here, you can choose which
programs handle your Internet functions, including

4 The program that runs when you edit a Web page

4 The default e-mail application within Windows XP

4 The default program that Windows XP uses when you read and post
Usenet newsgroup messages

<+

The program used for your Internet voice communications

<+

The Internet calendar application used within Internet Explorer

4 The default contact list or Address Book used while you’re on the

Internet
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Note that a program that you install might overwrite these settings.

You can also choose to reset Internet Explorer to its default home and
search pages from this tab.

® If you use both IE and another browser (like Netscape), you’'ve probably
been nagged about whether Internet Explorer should be rightfully returned
to its spot as the default browser. To get rid of this irritating dialog box,
mark the Internet Explorer Should Check to See Whether It Is the Default
Browser check box.

The Advanced tab

The final tab on the Internet Properties dialog box is chock-full of dozens of
individual features that you can enable and disable. These settings affect
both Internet Explorer and many other Internet applications, so they’re
often mentioned in program manuals (and in hushed tones around late-night
campfires). The options are divided into seven rather nebulous categories;
some are a little more self-explanatory than others — like those in the
Browsing and Multimedia categories — but most are pretty cryptic.

Because it would take an entire chapter just to explain each setting — and
you won't use 90 percent of them unless you're asked to by your ISP, net-
work administrator, or clergy — I'll recommend that you right-click any field
and then click the What’s This? pop-up to display the individual help text for
that option.

Click OK to save your settings.

Adding or Removing Programs

Every Windows XP user should be familiar with the Control Panel dialog box
in Figure 6-18 because the Add or Remove Programs dialog box is the one
truly safe method of uninstalling applications from your system.
(Alternatively, some programs add an uninstall menu item in their All
Programs folder; this is fine, too, because it’s basically just a different way of
starting the same procedure.)

QNG/ Let me reiterate: Never uninstall an application by simply deleting the
& program and its folder! This can raise all sorts of havoc within XP — your
XP Registry file will eventually end up looking like Bourbon Street after a
particularly long night of Mardi Gras revelry. (And that’s A Bad Thing.) In
the worst-case scenario, deleting a program folder willy-nilly can even lead
to lockups and affect other programs that you didn’t even know were dis-
tant cousins to the original application.
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Follow these steps to remove a program safely:
1. Click Control Panel from the Start menu and then choose Add or
Remove Programs.
After a few seconds, the Add or Remove Programs dialog box appear.
You'll see a list of the programs that you’ve installed within Windows XP.
2. Click the applic